
 

 
 
 
 
 
 
 
 
 
 

 يف ةیمقرلا طئارخلا مسر
 تاساردلاو تادادعتلا

 ةیئاصقتسلاا
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  

 
 

 
 
 



 

 

 
 2020 (SPC) يداھلا طیحملا عمتجمو )UNFPA( ناكسلل ةدحتملا مملأا قودنص © ىدل ةظوفحم قوقحلا عیمج

 طیحملا عمتجمو )UNFPA( ناكسلل ةدحتملا مملأا قودنص حرصی .ةظوفحم ،لاكشلأا نم لكش يأب ،ةمجرتلا وأ يحبرلا خسنلا/ةیراجتلا قوقحلا عیمج
 عمتجمو ناكسلل ةدحتملا مملأا قودنص ىلإ ةراشلإا ةطیرش ،ةیثحبلا وأ ةیمیلعتلا وأ ةیملعلا ضارغلأل اھتمجرت وأ داوملا هذھل يئزجلا خسنلاب )SPC( يداھلا
 ضارغلأ ءاوس ،لاكشلأا نم لكش يأب ،لماكلاب اھتمجرت وأ/و ةقیثولا خسنب نذلإا بلط بجی .حیحصلا وحنلا ىلع ردصملا ةقیثوو يداھلا طیحملا
 نود لصفنم لٍكشب اھرشن وأ يداھلا طیحملا عمتجم وأ ناكسلل ةدحتملا مملأا قودنصب ةصاخلا روصلا رییغت زوجی لا ً.ةباتك ،ةیحبر ریغ وأ ةیحبر/ةیراجت
 .قبسم نذإ ىلع لوصحلا

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ةیزیلجنلإا يلصلأا : صنلا    تانایبلا 

 يداھلا طیحملا عمتجمل ةسرھفملا

 انیرباس ،ناروج

 تیارب لیفو اور لا ود سیولو ناروج انیرباس / QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر

 .ایسونایقوأ - ةیجھنملا - دادعتلا .1
 .ایسونایقوأ - دادعتلا  .2
 .ایسونایقوأ - ةیفارغجلا تامولعملا مظن - دادعتلا  .3
 .ایسونایقوأ - ةیفارغجلا تامولعملا مظن  .4
 .ایسونایقوأ - طئارخلا - ةیفارغجلا تامولعملا مظن  .5
 أ.ایسونایقوأ - طئارخلل يمقرلا مسرلا  .6
 يداھلا طیحملا عمتجم .6 ناكسلل ةدحتملا مملأا قودنص .5 ناونعلا .4 لیف ،تیارب .3 سیول ،اور لا يد .2 انیرباس ،ناروج .1

 352.7502850995 AACR2 

ISBN: 978-982-00-1291-2 



 

 

 
 
 
 
 
 
 

 

 يف ةیمقرلا طئارخلا مسر
 تاساردلاو تادادعتلا
 ةیئاصقتسلاا
 )ناكسلل ةدحتملا مملأا قودنص( ناروج انیرباس
 )يداھلا طیحملا عمتجم( تیارب لیفو اور لا ود سیول 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 

 

 ةیمنتلاو ناكسلا عرف ،ينفلا مسقلا
 

 ءاصحلإا مسق
 ةیمنتلل



 ریدقتو ركش |QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر

 

4 

 

 ریدقتو ركش
 
 يذلاو "QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف طئارخلا مسر" بیتكل لماش لیدعت لاإ وھ ام بیتكلا اذھ نإ

 لمع شروو ةیدرفلا تابیردتلا ءارجإ نم تاونس ةدع ىدم ىلع يداھلا طیحملا عمتجمل عباتلا ةیمنتلل ءاصحلإا مسق ةطساوب دعأ

QGIS ناكسلل ةدحتملا مملأا قودنص برعی .ةینعملا لودلا لخاد )UNFPA( يذلا زاتمملا لمعلا نم ةدافتسلاا نم ھنكمتل ھنانتما نع 

 .رشنلاو راكتبلااو ةیفارغجلا تامولعملا مظن ریدم ،تیارب لیف ةدایق تحت ،ةیفارغجلا تامولعملا مظن يئاصخأ ،ور لا يد سیول ھب ماق

 ،ملاعلا ءاحنأ عیمج يف ةینطولا ءاصحلإا بتاكم لمشیل يداھلا طیحملا ةقطنم يف ھب علطضملا لمعلا قاطن يف عسوتلا ةمیقل اكًاردإو

 ناكسلا تانایبل ةیجولوكیلإا مظنلاو تادادعتلا ثیدحت يف ةمھاسملاب ھحومط راطإ يف )UNFPA( ناكسلل ةدحتملا مملأا قودنص ماق

 ءاحنأ عیمج نم ةدیدج تانایبو تاعوضوم جاردإ مت دقو .ةیملاعلا تابلطتملاو مءلاتی امب اھحیقنتو يداھلا طیحملا عمتجم ةقیثو ةعجارمب

 )UNFPA( ناكسلل ةدحتملا مملأا قودنص يف ةیمنتلاو ناكسلا وراشتسم مّدق ثیح .مادختسلال بیتكلا ةئیھت ةیلمع راطإ يف ملاعلا

 نم ةیفارغومیدلا تانایبلاو ةیفارغجلا ةیعجرملا ةیتحتلا ةینبلا( ينقتلا GRID3 يئاصخأو دادعتلاب نیینعملا نیینقتلا نییراشتسلاا رابكو

ً ةدایق ناروج انیرباس ةدایق تحت ةعجارملل مھتاربخ قطانملا عیمج نم )UNFPA( ناكسلل ةدحتملا مملأا قودنصل نیعباتلا )ةیمنتلا لجأ

 ،نارازك تنارول ،دیردنأ انیلیج :ةسوملم ةقیقح بیتكلا اذھ لعجل ملاعلا ءاجرأ عیمج يف انئلامزل ركشلا لیزجب مدقتن نأ دون .ةلماك

 ،كنارفول فوتسیرك ،يبوك سایتام ،وسیلك رییب ،ارتسجنوج دراودإ ،زنوج نیروم ،ابماج اویبات ،يزیرح يفطل ،وریشیإ نیلكنارف

 ،زیدیراب اردناس ،ایناسوأ لاویار ،ویبوأ زنیلوك ،ویاوكوأ كیردیرف ،كروت كام سلاوكین ،يثیبم نوتجنیلیو ،نینیلام خیش فظغلا دمحم

 .)يدجبلأا بیترتلاب( ماكاو ناج ،ایت اتیدیسریم ،نانلات دراودإ ،ونس لیشار ،انایارانایتاس رودنوك ،سولیناك رازلااس ولباب

 .ةمّیقلا امھتاماھسإ ىلع رلجیاتش يسنانو اریریھ ادافاك انیلوراكل ركشلا صلاخ

 وافلا-ةدحتملا مملأل ةعباتلا ةعارزلاو ةیذغلأا ةمظنم ،ءاصحلإا يف يلودلا يراشتسلاا ،دراجروب ينوتنلأ ركشلا لیزجب ھجوتن امك

)FAO( يئاھنلا بیتكلا اھنمضت يتلا داوملا لك ةعجارمل يداھلا طیحملا عمتجم ،ةیفارغجلا تامولعملا مظن يف بردتم ،رباف ناثانو 

 .لماكلاب اھتبرجتو

 مھمعدل ةدحتملا ةكلمملا يف ةیلودلا ةیمنتلا ةرازوو ستیج ادنیلیمو لیب ةسسؤمل صاخ لٍكشب ھنانتما نع برعی نأ ریرحتلا قیرف دویو

 .هرشنو بیتكلا ریوطت لجأ نم )GRID3 عورشم للاخ نم( يخسلا يلاملا
 
 

 يف طئارخلا مسر بیتك
 تاساردلاو تادادعتلا
 جمانرب مادختساب ةیئاصقتسلاا

QGIS 
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 ىلولأا فرحلأاو تاراصتخلاا ةمئاق
 
 

CAPI - بوساحلا ةدعاسمب ةیصخشلا تلاباقملا ءارجإ 
CRS - يعجرملا تایثادحلإا ماظن 
CSV - لصاوفب ةلوصفم میق 

DB - تانایب ةدعاق 
DEM - يمقرلا عافترلاا جذومن 

EA - دادعتلا ةقطنم 
EPSG - ةیبورولأا طفنلا تاءاصقتسا ةعومجم 

FAO - ةدحتملا مملأل ةعباتلا ةعارزلاو ةیذغلأا ةمظنم 
GEMET - تاغللا ةددعتم ةئیبلل ةماعلا ةیبورولأا ةعوسوملا 

GIS - ةیفارغجلا تامولعملا مظن 
GPS - يملاعلا عقاوملا دیدحت ماظن 

GRID3 - ةیمنتلا لجأ نم ةیفارغومیدلا تانایبلاو ةیفارغجلا ةیعجرملا ةیتحتلا ةینبلا 

 HH - نكاسملا 
ISO - سییاقملا دیحوتل ةیلودلا ةمظنملا 

 KML - زیمرت ةغل Keyhole 

 LTR - لیوطلا ىدملا ىلع ریرحتلا 
NASA - ءاضفلاو ةیوجلا ةحلاملل ةینطولا ةرادلإا 

 OSM - ةحوتفملا عراشلا ةطیرخ 

 OTF - "روفلا ىلع" 

 PDF - ةلومحملا قئاثولا قیسنت 

 SPC - يداھلا طیحملا عمتجم 

 SRTM - رادارلاب ةیفارغوبوطلا طئارخلا مسرل ةیكوكملا ةثعبلا 

 SVG - عسوتلل ةلباقلا تاھجتملا تاموسر 

 TMS - تاعبرمل ةمسقملا طئارخلا ةمدخ 

 UNFPA - ناكسلل ةدحتملا مملأا قودنص 

 URL - دحوملا دراوملا عقاوم ددحم 

 USB - ماعلا يلسلستلا لقانلا 

 WASH - ةماعلا ةفاظنلاو يحصلا فرصلاو هایملا 

 WGS – يملاعلا يسیدویجلا ماظنلا 
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 ةمدقمو ةماع ةذبن 1
 

 بیتكلا نع ةماع تامولعم .1.1

 ةئبعتو اھلمكأب ةلودلل طئارخ مسر بلطتی وھف .ملسِلا تاقوأ يف ةماخضو اًدیقعت ،لودلا اھب علطضت يتلا ،تاقیبطتلا رثكأ نم ربتعی نكاسملاو ناكسلا دادعت نإ

 لیلحتو ةینورتكللإا وأ ةیقرولا تانایبلا نم ةلئاھ تایمك عیمجتو رسلأا عیمج تاوصأ دشحو ةماع ةوعد ةلمح میظنتو مھبیردتو دادعتلا يبودنم نم ریبك ددع

 دادعأ نع تانایب هرودب رفوی يذلاو نادلبلا ىدحإ يف ناكسلا عومجم ءاصحإ وھ نكاسملاو ناكسلا دادعت نإف ،فیرعتلا ثیح نم امأ .اھرشنو تانایبلا

 ىنغ لا تانایب يھف .ةیسیئرلا ةیداصتقلااو ةیعامتجلاا صئاصخلا نم اھریغو مھتشیعم فورظو رمعلاو سنجلا بسح مھتائفو يناكملا مھعیزوتو صاخشلأا

 ةیھافرلا جماربو ةیتحتلا ةینبلا عیزوتو )SDGs( ةمادتسملا ةیمنتلا فادھأ قیقحت يف زرحملا مدقتلا عبتتو ةینطولا نودو ةینطولا ةیمنتلا طیطختل اھنع

 .قوسلا لیلحتو تاباختنلاا طیطختو ةیعامتجلاا

 رتویبمكلا ةزھجأو تنرتنلإا مادختسا نیب ام لولحلا هذھ عونتتو .اھرشنو اھلیلحتو دادعتلا تانایب عمجل ةیجولونكتلا لولحلا نم ةعونتم ةعومجم ترھظ دقو اذھ

 نم نكاسملاو دادعتلا قطانم طئارخ مسر تاینقت تروطت .حسملاو فرعتلا مظنو )GIS( ةیفارغجلا تامولعملا مظنو ةیحوللا وأ ةلاقنلا بساوحلاو ةلومحملا

 عمج روطت امك .ةیمقرلا طئارخلاو ةیعانصلا رامقلأا ربع يملاعلا ةحلاملا ماظنو ةیفارغجلا تامولعملا مظنب نیعتست ةیلماكت لئاسو ىلإ ةیقرو مئاوق درجم

 تانایب ةجلاعم تروطتو .ةیمقرلا تانایبتسلاا ربع ةیقرولا ریغ عمجلا بیلاسأو ریوصتلا عم حسملا تاینقت مادختسا ىلإ تانایبلل يودیلا لاخدلإا نم تانایبلا

 لولحلا نأب امًلع .لیلحتلاو رشنلل بیولا ىلع ةمئاقلا ةیلعافتلا تاودلأاو ةینورتكللإا رشنلا تاصنمو روصتلا جماربو ةمدقتملا لیلحتلا تاینقت لمشتل دادعتلا

 ىلع بجی امك .دادعتلا ةیلمع يف قرغتسملا تقولاو فیلاكتلا ریفوت ثیح نم ةیلاعفلاو ةدوجلا نیسحتل ةریبك اصًرف رفوت دادعتلل ةئشانلاو ةدیدجلا ةیجولونكتلا

 لولحلا هذھ نم ةدافتسلاا لجأ نم كلذو لاجملا اذھب ةلصلا تاذ لولحلا دامتعلا بسانملا تقولا يف ةیجیتارتسا تاءارجإ ذاختا ةینطولا ءاصحلإا بتاكم

 .ةیمقرلا
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 رفوت رملأا يضتقی امك .ةركبم ةیوق تارامثتسا قلاطإ ةیلودلا ةیئاصحلإا ةمظنملاو ةینطولا ءاصحلإا بتاكم نم بلطتی ةئشانلا ةدیدجلا تاینقتلا دامتعا نإ

 .اھجمدو ةركتبملا تاینقتلا هذھل حجانلا مادختسلاا لجأ نم رییغتلا ينبتل دادعتسلااو ةنورملا

 نواعتلا زیزعتب لودلا ةبلاطمل ةباجتسا ةباثمب يتأی "QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر" بیتكلا اذھ نإ

 ةیمنتلاو ناكسلل يلودلا رمتؤملا يف اھیلع قفتملا ئدابملل اًقفو كلذو ةیمنتلل نییساسأ نیطرشك ةینطولا ةدایقلاو ةیكلملاب فارتعلااو ةینطولا تاردقلا ءانبل يلودلا

 ھنیح يف ةقوثوملاو ةدوجلا ةیلاع تانایبلا رفاوت ةدایزل تاردقلا ءانب معد زیزعت ىلع 2030 لامعأ لودج دامتعا للاخ نم انقفتا دقف .2030 لامعأ لودجو

 تاقایسلاب ةلصلا تاذ صئاصخلا نم اھریغو يفارغجلا عقوملاو ةقاعلإاو ةرجھلا ةلاحو ءامتنلااو قرعلاو رمعلاو سنجلاو لخدلا بسح ةفنصملاو ریبك لكشب

 .2030 ماع لولحب كلذو ةینطولا

 يف بیتكلا اذھ دادعإ مت دقو .)SPC( يداھلا طیحملا عمتجمو )UNFPA( ناكسلل ةدحتملا مملأا قودنص نیب امیف يلودلا نواعتلل ةرمثك بیتكلا اذھ يتأی

 اھلیلحتو اھلحمو اھناوأ يفو ةدوجلا ةیلاعو ةلصفم ةیفارغجلا عجارملا تاذ حسملاو دادعتلا تانایب رادصإ ىلع ةینطولا ءاصحلإا بتاكم تاردق زیزعتل ةلواحم

 امب ةیمقرلا طئارخلا مسر لحارم لك بیتكلا اذھ يطغیو .ماعلا حلاصلا لجأ نم اھمییقتو اھدصرو اھذیفنتو ةمادتسملا ةیمنتلا نع نلاعلإل اھمادختساو اھرشنو

 يبودنمو نیفرشملاب ةصاخلا طئارخلا جاتنإو ةیرادلإا دودحلا عضوو )GNSS( ةیعانصلا رامقلأا ربع ةیملاعلا ةحلاملا مظن يف نكاسملا طیطخت ؛كلذ يف

 تادادعتلا يف ةیمقرلا طئارخلا مسرل ةمدختسملا ةیراجتلا جماربلل لئادب ةیئاصحلإا بتاكملل رفوی امك ،روصلا ةجلاعمو يساسلأا يناكملا لیلحتلاو دادعتلا

 .ةیئاصقتسلاا تاساردلاو

 QGIS جمانرب لوح ةمدقم  1.2

ٍ يأ وأ صٍیخرت ىلع لوصحلا يضتقی لا جمانربلا اذھ مادختساب ءدبلا نأ ينعی هرودب اذھو .ردصملا حوتفمو يناجم ةیفارغج تامولعم ماظن وھ QGIS نإ

 .ءارشلا تایلمع نم
 ؟بیتكلا اذھل QGIS رایتخا مت اذامل

 .ردصملا حوتفمو يناجم ھنوكل •

 :لثم ،ةیجراخلا دراوملاو معدلا نم ریبك ردقب زیمتیو ملعتلا لھسو مادختسلاا لھس ھنوكل •

 /QGIS: https://docs.qgis.org/3.10/en/docs قئاثو •

 https://docs.qgis.org/3.10/en/docs/training_manual/index.html جمانربب صاخلا بیردتلا بیتك •
 https://gis.stackexchange.com/?tags=qgis :نیروطملاو نیمدختسملا طاسوأ •

 /http://plugins.qgis.org/planet :تانودملا •
 .تیبثتلا ةیلمع ءارجلإ تنرتنلإاب لاصتا وأ صیخرت دوجو مزلی لاو تیاب اجیم 500 يلاوح تیبثتلا فلم مجح غلبی ثیح ،ھتیبثت لھسلا نم •
 .تاودلأاو )ArcGIS يف تادادتملاا لداعی ام( ةیفاضلإا تانوكملا نم ةعونتم ةعومجم ىلإ اًناجم لوصولا نكمی .صیصختلل لباق •
 .رارمتساب ثیدحتلاو ةیقرتلل عضخی •
 يسیئرلا ببسلا نإف ،كلذ عمو .يلدابت وٍحن ىلع R وأ GRASS وأ Orfeo وأ SAGA وأ GDAL/OGR تاقاب مادختسا نكمملا نم ،QGIS ماظن يف •

 .ةیراجتلا جماربلا ةءافك سفنب بیتكلا اذھ يف ةجردملا طئارخلا مسر ماھم عیمج ءادأ ىلع رداق ردصملا حوتفم اجًمانرب ھنوك وھ QGIS رایتخا ءارو

 ھنأب امًلع .QGIS عقوم يف ةحاتملا تارادصلإا عیمج نیب نم Windows ماظنل QGIS نم )LTR( ىدملا لیوط رادصلإا عم مدختسملا لماعتی ،بیتكلا اذھ يف
 ىلع .دحاو ماع غلابلا يضارتفلاا هرمع دادتما ىلع ماظتناب ثیدحتلل عضخی ھنوك عم اًتابث رثكأ LTR رادصإ نوكل ارًظن رادصإ رخآ نع LTR رادصإ لیضفت مت دق
 .براجتلا ضعب لیدعت متی دق ،LTR رادصلإ يجیردتلا نسحتلل ارًظن ھنأ مھرابتعاب نومدختسملا عضی نأ
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 بیتكلا اذھل يلمعلا لكیھلا 1.3

 تادادعتلا ؛لثم ةیئاصحلإا تانایبلا عمج ةطشنأب ةقلعتملاو ةعئاشلا طئارخلا مسر ماھم ءادأ ةیفیك مدختسملا ملعت يتلا تابیردتلا نم ةعومجم مضی ثیحب بیتكلا اذھ ممص
 .ةیئاصقتسلاا تاساردلاو

 .جمانربلا مادختسلا ةمزلالا ةیرورضلا تاراھملا ةسرامم ىلع زیكرتلا عم ناكملإا ردق سوردلا يف يرظنلا ءزجلا صیلقت مت دقو

 بیتكلا اذھ حضوی ثیح .ةیعقاولا طئارخلا مسر لامعأ ذیفنتل مدختسملا اھیلع دمتعی يتلا تاراھملا زیزعتل اصًیصخ ةدعملا تابیردتلا نم ةلسلس لوح لوصفلا روحمتتو
 .اسًمحتم لظی نأو ھتاراھم يف ةٍسوملم تٍانسحت مدختسملا دھشی نأ جھنلا اذھ نمضیو .يجھنم لٍكشب ةضورعملا ماھملا نم ةمھم لك ءادلأ اھعابتا بجی يتلا تایلمعلا
 

 يف ةجردملا لوصفلا نم لصف لك عباتت عم قفاوتت تادلجم يف داوملا هذھ دادعإ مت دق ھنأب امًلع .اھظفحو ةقفرملا ةیبیردتلا داوملا لیزنت بجی ،بیتكلا اذھ مادختسلا
 https://www.spc.int/DigitalLibrary/SDD/Events/QGIS%20manual%20GLOBAL :ىدل اھیلع علاطلاا نكمیو بیتكلا

 بیتكلا اذھ يف ةعبتملا بیلاسلأا  1.4

 ةیصنلا تاقیسنتلا

 عابتا ریسیت نعً لاضف جمانربلاب ةفلتخملا رصانعلا زییمت ةیغب وحنلا اذھ ىلع تدرو دقو ،ةصاخ تٍاقیسنتب ةیلاتلا لوصفلا نمض ةدراولا صنلا ءازجأ ضعب رھظت
 :تاقیسنتلا هذھ نایب كیلإو .تامیلعتلا

 

 
 مئاوق نیب لقنتلا تاراسم نعً لاضف QGIS ذفاون اھنمضتت رٍارزأ ىلإ ریشی قیسنتلا اذھ
 .(View > Panels > Browser( جمانربلا

 

  .جمانربلاب رھظت يتلا QGIS تاحولو ذفاونو مئاوق ددحی قیسنتلا اذھ 

 
 :لاثملا لیبس ىلع ،تاقبطلا ءامسأو تافلملا تاراسم نیبی قیسنتلا اذھ
5_polygon_layers/Layers/HH_EAcode_4326.shp 

 

 
 وأٍ غیص وأ صوصن لاخدإ مدختسملل ھیف يغبنی يذلا تقولا نایبل مدختسی قیسنتلا اذھ
 .ةنیعم تاریبعت

 

  .حیتافملا ةحولب ةصاخلا حیتافملا نیبی قیسنتلا اذھ 

 
 ةرأفلا مادختسا

 فئاظولا نم ةفیظو لك حرش كیلإو .كیدی نیب يذلا بیتكلا ةءارق ةیناكمإ ریسیت لجأ نم عاطتسملا ردق طسبم بولسأب ةرأفلا ىلع رقنلاب ةصاخلا تامیلعتلا تدرو
 :ةرأفلاب ةقلعتملا

 

 فصولا بیتكلا يف دراولا رملأا

 رسیلأا رزلاب رقنا رقنا

 رسیلأا رزلاب اجًودزم ارًقن رقنا اجًودزم ارًقن رقنا

 نمیلأا ةرأفلا رز امًدختسم رقنا نمیلأا رزلاب رقنا
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 صنلا يف ةجردملا تانوقیلأا

 جمانرب ةھجاو نمض اھعاونأ فلاتخاب مكحتلا رصانعو رارزلأا داجیإ ىلع ھتدعاسم لجأ نم كلذو صنلا نمضً ةجردم  هذھ لثم تٍانوقیأ مدختسملا دجی
QGIS. 

 يمقرلا عباتتلاو تاحوللا

 .تاداشرلإا ةلوھسو حوضو ىلع دیكأتلا لجأ نم تاطقللا هذھ تجردأ دقلو .QGIS جمانرب تاحولو مئاوق فصت ارًوص بیتكلا اذھ تاحفص نیب مدختسملا دجی

 نمض ةدوجوملا ةیعرفلا ماسقلأاو مكحتلا رصانع نیب لقنتلا ىلع مدختسملا ةدعاسم يف لیلدلا اذھ نم ىلولأا لوصفلا تایط نیب ةفوصوملا تاحوللاو ذفاونلا مھستو اذھ
 .اھعاونأ فلاتخاب مئاوقلا

 اھعیمج ماقرلأاو فرحلأا هذھ ریشتو .فرحلأاـب صنلا لاوط تاوطخلا تجردأ امیف ،مئاوقلاب ةصاخلا روصلا نمض يمقرلا عباتتلا مادختسا مت ھنأ ىلإ هابتنلاا ىجری
 يف 1 ءارجلإا نأ دجن ،هاندأ نیبملا لاثملا يفف .نیبیترتلا لاك نیب رشابم طُابترا ةرورضلاب دجوی لا ھنأ ىلإ هابتنلاا يغبنی ھنأ لاإ ،تاءارجلإا ھب ذفنت يذلا بیترتلا ىلإ
 .صنلا يف ةجردملا ةوطخلا قباطی لا ةروصلا

 
 

 ىلإ عوجرلا مدختسملل نكمی امك .طقف ىلولأا لوصفلا يف لاإ لیصفتلاب ةیسیئرلا تایلمعلا حرشُت نل ،ھیلعو .جمانربلا اذھب ھتیارد دیزت اًئیشف اًئیش مدختسملا مدقت عمو
 .بیتكلا اذھ تایط نیب اًقحلا ھل ضرعتی سبل يأ دوجو لاح لوصفلا هذھ
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 ىلولأا تاوطخلاو جمانربلا تیبثت   2
 
 

  :لصفلا اذھ يف ملعتن

 ؛اھتیبثتو QGIS LTR ةخسن لیزنت ةیفیك •
 قیبطت نمض اھیف مكحتلاو اھتیبثتو اھلیزنت ةیفیكو )plugins( ةیفاضلإا تانوكملا ةدئاف •

QGIS. 

 

 
 
 

 QGIS 3 تیبثتو لیزنت 2.1

 /QGIS https://www.qgis.org/en عقوم ىدل لیزنتلا مسق يف QGIS نم تارادصإ ةدع رفوتت
site/forusers/download.html. تاصنملا فلتخمل ةحاتملا تارادصلإا رخآ نع تٍامولعم ةحفصلا ىلعأ دجتسو. 

 امیف امأ ،تب 32 رادصإ تیبثتب ىصوی ،تب 32 رادصإ تاذ لیغشتلا ةمظنأو رتویبمكلا ةزھجلأ .تب 64و 32 يرادصإ نیب رایتخلاا نكمی
 مادختسا حیتی ذإ ،تب 64 رادصإ تیبثتب ىصویو .نیرادصلإا لاك تیبثت نكمی تب 64 رادصإ تاذ لیغشتلا ةمظنأو رتویبمكلا ةزھجأب قلعتی
 .لضفأ وٍحن ىلع ماظنلا ةركاذ

 :كتصاخ رتویبمكلا زاھج ىلع ھتیبثتو QGIS لیزنتل اھعابتا كل يغبنی يتلا تاوطخلا كیلإ

 ىلع https://www.qgis.org/en/site/forusers/download.htmlناونعلا خسنا مث كب صاخلا تنرتنلإا حفصتم حتفا .أ
 .لقنتلا طیرش

 Long" رایخ ىلإ لقتنا ،OSGeo4W standalone install packagesتیبثتلا تاقاب مضی يذلا مسقلا يف .ب
term release repository" )كب صاخلا لیغشتلا ماظنو مءلاتی يذلا تب 64 وأ 32 نیب نم رتخاو )دملأا لیوط رادصإ. 

 .ددحملا رایخلا ىلع رقنلا دعبً ةرشابم لیزنتلا ةیلمع أدبت .تب 64 رایخلا ىلإ أجلنس لیلدلا اذھ يف
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 .اجًودزم ارًقن ھیلع رقنا مث رتویبمكلا زاھجب تیبثتلا فلم نیزخت عضوم ىلإ لقتنا ،جمانربلا لیزنت روف .ج
 

 
 
 

 .)معن( Yes قوف رقنا .ةشاشلا ىلع يلاتلا راوحلا عبرم رھظیس .د
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  .)يلاتلا( Next قوف رقنا ، (QGIS يف كب اًبحرم( Welcome to the QGIS راوحلا عبرم نم .ـھ
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 .)قفاوأ( I Agree قوف رقنا ،)صیخرتلا ةیقافتا( License Agreement راوحلا عبرم نم .و
 

 
 

 .)يلاتلا( Next قوف رقناو يضارتفلاا راسملا كرتا ،)تیبثتلا عقوم رتخا( Choose Install Location راوحلا عبرم نم .ز
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 Install قوف رقنا مث ةددحملا ةیضارتفلاا تانوكملا كرتا ،)تانوكملا رتخا( Choose components راوحلا عبرم نم .ح
 .)تیبثت(

 

 
 

 .رتویبمكلا زاھج ىلع نلآا تبثم جمانربلا .)ءاھنإ( Finish قوف رقنا ،تیبثتلا ةیلمع لامتكا روف  .ط
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 نل ،تیبثتلا فلم لیزنت درجبمف .قئاقد 10 نم رثكأ قرغتست نأ يغبنی لاو ،تنرتنلإاب لاصتلاا يضتقت لاو ةیاغلل ةطیسب ةیلمع تیبثتلا ةیلمع نإ
 .هلاعأ ةنیبملا تاوطخلا عابتا لاإ كمزلی

 ةقاب يف ةنمضتملا جماربلا فلتخم ىلإ لوصولل ةمزلالا تاراصتخلاا ةفاك مضیو بتكملا حطس ىلع QGIS 3.10 مسا لمحی دیدج دلجم أشنی
 .GRASS 7 عم QGIS Desktop 3.10 LTR بیتكلا اذھ مدختسی .تیبثتلا

 تیبثتلاو لیزنتلا ةیلمع :)Plugins( ةیفاضلإا تانوكملا 2.2

 قرطلا لھسأ نمو .رارمتساب ةیفاضإ تانوكم هومدختسمو QGIS وجمربم روطی امك .ةجمدملا فئاظولا نم دیدعلاب اًدوزم QGIS جمانرب يتأی
 نأ ملعت نأ كلو .QGIS قیبطت نمض جردملا )ةیفاضلإا تانوكملا ریدم( QGIS Plugin Manager ربع اھلیزنت وھ تاودلأا هذھ ىلإ لوصولل
 تامولعملا مظن جمارب نم هریغبً ةنراقم QGIS اھب زاتمی يتلا ةوقلا طاقن دحأ دعی ام وھو .امًامت يناجم تادادتملااو تاودلأا هذھ ىلإ لوصولا
 .ةصاخلا ةمدقتملا تاودلأا هذھ مادختسلا ةیفاضإ صخر ءارش يضتقت يتلاو ةیفارغجلا
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 QGIS جمانرب يف دیدج يفاضإ نوكم تیبثت ةیفیك

a. جمانرب حتفا QGIS. 

b. ىلإ لقتنا ،ةیولعلا ةمئاقلا نم Plugins > Manage and Install Plugins )اھتیبثتو ةیفاضلإا تانوكملا ةرادإ >ةیفاضلإا تانوكملا(... 

c.  نوكملا تیبثت دیرن autoSaver )بیتكلا اذھ يف اًقحلا ھمدختسنس يذلاو )يئاقلت ظفح. 

d. رایخ دیدحت نم دكأت All )ىرسیلا ةحوللا نم )لكلا. 

e. بتكا autosaver ثحبلا طیرش يف. 

f. هاندأ ةرھاظلا ةمئاقلا نم يفاضلإا نوكملا رتخا. 

g. قوف رقنا Install Plugin )يفاضإ نوكم تیبثت(. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 يفاضإ نوكم تیبثت ءاغلإ ةیفیك

 …)اھتیبثتو ةیفاضلإا تانوكملا ةرادإ >ةیفاضلإا تانوكملا( Plugins > Manage and Install Plugins ىلإ لقتنا ةیولعلا ةمئاقلا نم .أ

 .ىرسیلا ةحوللاب )تبثم( Installed ىلإ لقتنا .ب

 .ھتیبثت ءاغلإ يف بغرت يذلا يفاضلإا نوكملا رتخا .ج

 .)يفاضإ نوكم تیبثت ءاغلإ( Uninstall Plugin قوف رقنا .د

 .جمانربلا يف ةجمدم اھنوكل ةیساسلأا ةیفاضلإا تانوكملا نم يأ تیبثت ءاغلإ نكمی لا ھنأ ىلإ هابتنلاا ىجری .ـھ
 

  



 ىلولأا تاوطخلاو جمانربلا تیبثت | QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر 

 

20 

 
 
 

 يفاضإ نوكم لیطعت / نیكمت ةیفیك

 يأ لیطعتی يصون ،ةسلاسب ھلمعو قیبطتلا ةباجتسا نامض لجأ نمو .امًامت ھلطعت نع رفسی دقو لب قیبطتلا لمع رخؤی دق QGIS قیبطت يف ةیفاضلإا تانوكملا نم ریثكلا لیعفت نإ

 .ھلمعتست لا يفاضإ نٍوكم
 .…)اھتیبثتو ةیفاضلإا تانوكملا ةرادإ >ةیفاضلإا تانوكملا( Plugins > Manage and Install Plugins ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .أ

 .ةذفانلا نم ىرسیلا ةھجلاب )تبثم( Installed ىلإ لقتنا .ب

 .QGIS ةھجاو يف ةحاتملا ةیفاضلإا تانوكملا نیب نم دیرت يتلا ةیفاضلإا تانوكملا دیدحت غلا/ددح .ج
 .)قلاغإ( Close قوف رقنا .د
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 اھب ىصوملا ةیفاضلإا تانوكملا 2.3

 نم دیزمللو .ةیئاصقتسلاا تاساردلاو تادادعتلا تاعورشمل ةبسنلاب اھتیمھلأ كلذو اھنیعب ةیفاضإ تٍانوكم تیبثتب يصون ام امًئاد اننأ ظحلتس بیتكلا اذھ كتءارق ءانثأ

 /QGIS: https://plugins.qgis.org ـب ةصاخلا ةیفاضلإا تانوكملا ةباوب ىلإ عوجرلا ىجری ،QGIS ـل ةحاتملا ةیفاضلإا تانوكملا لوح تامولعملا

• Digitizing Tools: ـب ةیساسلأا ریرحتلا تاودأ ةمئاق اھنمضتت لا ةیفاضإ ةیھاجتا ریرحت/میقرت تاودأ يفاضلإا نوكملا اذھ مضی QGIS. 

• MMQGIS: تاھجتملا لیلحت تاودأ نم ةیفاضإ ةعونتم ةعومجم يفاضلإا نوكملا اذھ حیتی. 

• OSMDownloader: طئارخ لیزنت مدختسملل نوكملا اذھ حیتی OpenStreetMap. 

• Point sampling tool: لمعلا دنع ھتدئاف ھلو طاقن ةقبطل ةنیع مادختساب ةیكبشلا تاقبطلا وأ تاھجتملا تاقبط نم تاملعملا عمجی يفاضلإا نوكملا اذھ 

 .نكاسملا عقاوم تاقبطب

• QGIS Cloud Plugin: ربع ةكبشلا ىلع طئارخلاو تاعورشملا ةكراشم مدختسملل يفاضلإا نوكملا اذھ حیتی http://qgiscloud.com 

• QuickMapServices: طئارخ لثم ةیساسأ طئارخ ةفاضلإ مدختسی يفاضإ نوكم OSM وأ Bing Maps وأ Google. 

• SRTM Downloader: تاعبرم لیزنت مدختسملل يفاضلإا نوكملا اذھ حیتی SRTM مداخ نم NASA. باسح ءاشنإ نم دب لا ھنأ ةظحلام ىجری 

Earthdata ىلع https://search.earthdata.nasa.gov تانایب ةدعاق ىلإ لوصولا لجأ نم NASA. 

• autoSaver: ةددحم تٍارتف ىلع ةلدعملا تاقبطلاو تاعورشملا ظفح يفاضلإا نوكملا اذھ حیتی. 

 :ىلإ لاقتنلاا ىجری ،QGIS ـل ةیفاضلإا تانوكملا نع تامولعملا نم دیزمللو •

https://docs.qgis.org/3.4/en/docs/user_manual/plugins/plugins.html 
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 QGIS يف تاوطخلا ىلوأ 3
 

 :لصفلا اذھ يف ملعتت
 ؛QGIS ـب صاخلا يئیبلا ماظنلا يف ھجوتلا ةیفیك •

 ؛طیطختلا تاھجاوو عورشملا تایساسأ •

 .QGIS ةئیب نمض عیراشملا تافلم لمع ةیلآ •

 

 )Vector Layers( تاھجتملا تاقبط لیمحت 3.1

 .طئارخلا ةحول ىلإ تاقبطلا نم ةقبط ةفاضلإ قٍرط ثلاث ةمث

 تانایبلا رداصم ریدم ربع .1

 .غراف دیدج عورشم حتفل    قوف رقنا مث QGIS حتفا .أ

 .)تانایبلا رداصم ریدم( Data Source Manager حتفل    قوف رقنا .ب

 .رسیلأا بناجلاب ةدوجوملا ةمئاقلا نم )ھجتم( Vector رتخا .ج

 .تافلملا فشكتسم حتفل   قوف رقنا مث )ردصم( Source ةحول ىلإ لقتنا .د

 first_steps/Layers/Lilongwe_EA_2018_4326.shp_3 ضرعتسا .ـھ

 .)ةفاضإ( ADD قوف رقنا .و
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 QGIS ضرعتسم ربع .2

 ةدوجوملا QGI تاحول ىدحإك وأ )تانایبلا رداصم ریدم( Data Source Manager ةحول للاخ نم امإ )ضرعتسملا( Browser ىلإ لوصولا نكمی

 نم )ضرعتسملا > تاحوللا > ضرع( View > Panels > Browser ىلإ لقتنا ،اًیضارتفا )ضرعتسملا( Browser ةحول ضرعت مل لاح يف .ةھجاولاب

 .ةیولعلا ةمئاقلا

 .QGIS لخاد GIS تافلم ةرادإ نعً لاضف رتویبمكلا زاھج تافلم ماظن ربع لقنتلا مدختسملل )ضرعتسملا( Browser حیتی
 .)ضرعتسملا( Browser ىلإ لقتنا .أ

 first_steps/Layers/ Lilongwe_EA_2018_4326.shp_3 :ىلإ لصت ىتح تافلملا ةمئاق ضرعتسا .ب
 .طئارخلا ةحول ىلع ھجردأو ھبحسا وأ فلملا اذھ ىلع اجًودزم ارًقن رقنا .ج

 Windows Explorer ربع .3

 ھجردأو sh. دادتما لمحی يذلا فلملا بحسا مث /first_steps/ Layers_3 ىلإ لقتنا ،Windows Explorer نم shapefile تافلم دحأ حتفل

 .طئارخلا ةحول ىلع

 

 

 

 

 

 

 

 
 .Lilongwe_EA_2018_4326 ،هلاعأ ةنیبملا تاوطخلا عابتا دعب

 .)تاقبطلا( Layers ةحول يف ةدوجوملا )طئارخلا ةحول( Map Canvas ىلع shp ةقبط ضرعت
 

  

 مھم

 نم ةثلاث ىلإ Shapefile تافلم جاتحت

 اھلیعفت نكمی ىتح ةدعاسملا تافلملا تادادتما

 هذھ دجاوتت مل اذإو .GIS جمارب يف ةقبطك

 ةقبطلا رھظت نل ،دحاو دلجم يف تادادتملاا

 .طئارخلا ةحول يف ةبولطملا
 ظفحی( shp. يھ ةیمازللإا تادادتملااو

 )رشؤملا عضوم( shx.و )يسدنھلا لكشلا

 لودج يوحت ةیسایق تانایب ةدعاق( dbf.و

 .)تامسلا

 لاإ ،ایًمازلإ اًدادتما سیل وھف prj. دادتما امأ

 نع تٍامولعم يوحی ذإ ھنیمضتب يصون اننأ

 .ةیثادحلإا مظنلا
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 ةیساسلأا طامنلأا نییعت 3.2

 يتلا ةقبطلا ىلع نمیلأا ةرأفلا رزب رقناو ،)تاقبطلا( Layers ةحول ىلإ لقتنا ،)ةقبطلا صئاصخ( Layer Properties ةذفان حتفل  .أ

 .دیرت يتلا ةقبطلا ىلع اجًودزم ارًقن رقنا وأ ،)صئاصخلا( Properties رتخا مث دیرت

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 .تاراطلإاو ةئبعتلا صئاصخك تٍاملعم نییعتو طبض كنكمی ثیح )زیمرتلا( Symbology مسق ىلإ لقتنا ،ةمئاقلل رسیلأا بناجلا نم .ب

 .)قفاوم( OK قوف رقنلا مث نمو راطلإاو ةئبعتلل نول رایتخاب كب صاخلا طمنلا دیدحت كنكمی .ج
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 .اًقبسم ةددحملا طامنلأا دحأ رایتخا كنكمی وأ .د
 

 
 
 

 .جئاتنلا ضرعل )قیبطت( Apply قوف رقنا .ـھ

 .دیدجلا طمنلا نییعتل )قفاوم( OK قوف رقنا .و
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 ةیساسلأا تایمستلا نییعت 3.3

 .)ةقبطلا صئاصخ( Layer Properties حتفا .أ

 .)تایمست( Labels رتخا ،ةمئاقلا يف رسیلأا بناجلا نم .ب

 .)ةدرفم تایمست( Single Labels ـب )تایمست نودب( No Labels رایخلا لدبتسا ،ةلدسنملا ةمئاقلا نم .ج

 دوك نزخی يذلا لقحلا ،EA_CODE راتخن ةلاحلا هذھ يف .ةراتخملا ةقبطلا ةیمستل اھمادختسا ررقملا ةمسلا رتخا ،)ةمیقلا( Value ةلدسنملا ةمئاقلا نم .د

 .دادعتلا قطانم تاعلضم نم علضم لكل دادعتلا ةقطنم
 :اھقیبطت كنكمی يتلا تاقیسنتلا نم تارایخلا هذھ كیلإ .ـھ

• Text )ةیمستلا مجحو طمنو نولو مساب قلعتت تاملعم :)صنلا. 

• Formatting )ماقرلأاو تارقفلا قیسنت تارایخ :)قیسنتلا. 
• Buffer )ةطیرخلا ىلع حوضولاو نیابتلا زیزعتل تایمستلا لوح نولم يناكم مازح ةفاضلإ مدختست تاملعم :)يناكم مازح. 

• Background )تایمستلا فلخ لاكشلأاو ماجحلأا ةفلتخم تاحول نییعت تادادعإ :)ةیفلخلا. 

• Shadow )تایمستلا فلخ لظ راھظإ تادادعإ :)لظلا. 

• Callouts )طوطخلاو ملاعملاب تایمستلا طبرل :)حرش لئاسو. 
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• Placement )تایمستلل ةمءلام عقاوملا رثكأ طبضل تاملعم :)عضوملا نییعت. 

• Rendering )ریبكتلا ىوتسم لثم ةفلتخم لماوع ىلإ اًدانتسا ،ھمدع نم ةطیرخلا ىلع تایمستلا حوضو ریرقت :)ضرعلا / 

 .ةطیرخلا ىلع ىرخأ ملاعم عم لخادتلا وأ ریغصتلا

 

 

 

 
 .تارییغتلا ظفحل )قفاوم( OK قوف رقنا ،جئاتنلا نع كاضرو كعانتقا دعبو ،ةطیرخلا ىلع جئاتنلا ضرعل )قیبطت( Apply قوف رقنا .و
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 عورشم حتف/ظفح 3.4

 يف تازیمرتلاو رماولأا لخادتو طئارخلا تاقبط نیزخت نیمدختسملل تاعورشملا حیتت .تاعورشم QGIS يف اھذفنن يتلا تاسلجلا ىمست

 .ةصصخم تافلم تاقیسنت

 :ةیلاتلا تامولعملا QGIS تاعورشم تافلم نزخت ً،لاامجإ

 طئارخلا ةحولب ةفاضملا تاقبطلا •

 طامنلأاو زیمرتلا كلذ يف امب تاقبطلا صئاصخ •

 ةطیرخلا ضرع راھظإ •

 ةضورعملا تاقاطنلا رخآ •

 ةعابطلا تاطیطخت •

 تادادعلإا عم ةعابطلا تاطیطخت رصانع •

 ةعابطلا طیطخت سلطأ تادادعإ •

 میقرتلا تادادعإ •

 لوادجلا تاقلاع •

 عورشملل ةیضارتفلاا طامنلأا •

 ةیفاضلإا تانوكملا تادادعإ •

 .)تانایبلا دعاوق ریدم( DB Manager ىدل ةنزخملا تامولعملا •

 Save رز قوف رقنا مث ھلخادب ظفحلا دیرت يذلا عقوملا رتخاو  قوف رقنا ،ىلولأا ةرملل ھتیمستو عورشملا ظفحل  .أ

 .)ظفح(

 جمانربف .عاطتسملا ردق ةرركتم ةفصب تارییغتلا ظفحب يصونو . قوف رقنا ،عورشملا ىلع اھلخدت تارییغت ةیأ ظفحل .ب

QGIS اًقباس ھظفحت ملام لك دقفتس ،ئجافم لطع يلأ جمانربلا ضرعت اذإ ھنأ ينعی امب ،اًیئاقلت تارییغتلا ظفحی لا. 

 مھم

 نزخت لا عورشملا يف ةلمحملا تاقبطلا
 "يقبتسی" لب .عورشملا فلم يف
 تاقبطلا تاراسم ىلع عورشملا

 ھنأ ينعی ام وھو .اھعقاوم نم اھدیعتسیو
 وأ تاقبطلا نم يأ عقوم انریغ اذإ

 ةحول ىلإ ةقبطلا هذھ فاضت نل ،اھانفذح
 ثیح ادًدجم عورشملا حتف دنع طئارخلا

 .اھناكم "ةفرعم" نم نكمتی نل
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 .غراف دیدج عورشم حتفل  قوف رقنا .ج

 .)حتف( Open قوف رقنا مث )qgs. دادتما( عورشملا عقوم نع ثحبا ، قوف رقنا ،لعفلاب مئاق عورشم حتفل .د

 

 

 ةیساسأ ةطیرخ ةفاضإ 3.5
 

 QuickMap تامدخ 3.5.1

 .)2-2 لصفلا عجار ،تامولعملا نم دٍیزمل( )QuickMap تامدخ( QuickMapServices يفاضلإا نوكملا تبث .أ

b. ىلإ لقتنا ،ةیولعلا ةمئاقلا طیرش نم Web > QuickMapServices > Settings > More services )تامدخ > بیولا QuickMap < 

 .)ةمھاسم ةمزح ىلع لوصحلا( Get contributed pack قوف رقنا مث )ةیفاضإ تامدخ
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 .)ظفح( Save قوف رقنا مث نمو اھتحاتإ دیرت يتلا تامدخلا دیدحت غلا/ددحو )ةیؤرلا( Visibility ىلإ لقتنا .ج

 

 

 
 Web > QuickMapServices > Google > Google ىلإ لقتنا ،يعانصلا رمقلا نم ةروص ةیفلخ لیمحتل ،اھدعب .د

Satellite.  
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 .ةئبعتلا ةفافش طٍامنأ مادختسا لضفلأا نم ،يعانصلا رمقلا نم رٍوص مادختسا ءانثأ ةطیرخلا ةءارق ةلوھس نیسحتل

 .دیرت يتلا ةقبطلا ىلع اجًودزم ارًقن رقنلاب )ةقبطلا صئاصخ( Layer Properties حتفا .أ

 .تاعلضملا طامنأ تادادعإ لیدعتل )ةطیسب ةئبعت( Simple fill قوف رقنا مث نمو )زیمرتلا( Symbology ىلإ لقتنا .ب

 .ةفافشلا ةئبعتلا رتخا ،)ةئبعتلا نول( Fill colour نم .ج

 .دودحلا حوضوو ةیؤر نیسحت لجأ نم ةیفلخلا عم نیابتی يذلا علضملا طیطخت نول رتخا ،)ةطغضلا نول( Stroke color نم .د

 .ھحوضو ىدمو علضملا دودح لیصافت ىوتسم نیبً ةطسوتم ةمیق دجت نأ لواح ،)ةطغضلا ضرع( Stroke width نم .ـھ
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 .تارییغتلا ظفحل )قفاوم( OK قوف رقنا ،جئاتنلا نع كاضرو كعانتقا دعبو ،ةطیرخلا ىلع جئاتنلا ضرعل )قیبطت( Apply قوف رقنا .و
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 XYZ تاعبرم 3.5.2

 .XYZ تاعبرمل تلااصتا ءاشنلإ ناتقیرط ةمث

 يودیلا طبضلا .1

 لاصتا( New Connection رتخا مث نمو (XYZ تاعبرم( XYZ Tiles قوف نمیلأا ةرأفلا رزب رقنا ،)ضرعتسملا( Browser ةحول نم .أ 

 .)دیدج

 Google لاثملا لیبس ىلع ،لاصتلاا اذھل )ضرعتسملا( Browser ةحول ىلع هراھظإ يف بغرت يذلا مسلاا فضأ ،)مسلاا( Name تحت .ب

Satellite. 

 تاعبرملا طئارخ تامدخ نم ةعومجمل URLs نیوانع طباور دجتس ،first_steps/Other/Paths XYZ TILE SERVER.txt_3 نم .ج

TMS. طبار خسنا URL ناونعلا تحت Google Satellit )طباورلا طیرش يف ھعضو يصنلا فلملا نم )ثلاثلا رایخلا. 

 .)قفاوم( OK قوف رقنا .د
 .Google Satellite لاصتلاا نلآا رھظی ،XYZ Tiles لفسأ ،)ضرعتسملا( Browser ةحول نم .ـھ

 .Google Satellite قوف جودزملا رقنلاب طئارخلا ةحول ىلع لجوج نم يعانصلا رمقلا روص ةیفلخ ضرع كنكمی .و

 1Python صن مادختساب طبضلا .ز

 ىلع حاتملاو يلاتلا Python صن مادختساب ةدحاو ةرم TMS تامدخ نم ریبك ددع نییعت نكمی

https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geosupportsystem/python/qgis

_basemaps.py 
 .first_steps/Other/Script XYZ TILES.txt_3 ربع صنلا اذھ ىلإ لوصولا نكمی امك
 :تاوطخلا هذھ عابتاب TMS تامدخ لیمحت كنكمی

 .(Python مكحت ةادأ > ةیفاضلإا تانوكملا( Plugins > Python Console ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .أ

 .ةیلفسلا ةحوللاب دوجوملا صنلا خسنا ،(Python مكحت ةادأ( Python Console نم .ب

 .رملأا لیعفتل  قوف رقنا .ج

 
 

  

 
 qgis-in-basemaps-https://opengislab.com/blog/2018/4/15/add-30 :عقوم ىلعٍ حاتم رٍوشنم ىلإ لصفلا اذھ يف دری ام دنتسی 1
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 .TMS تامدخ نم ةحاتم ةریبك ةعومجم دجتس (XYZ تاعبرم( XYZ Tiles لفسأو ،)ضرعتسملا( Browser ةحول نم .د
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 QGIS يف تاطاقسلإا عم لماعتلا ةیفیك 3.6

 طاقسإ QGIS دیعی .4326 ـب EPSG دوك ردقی ثیح ،WGS 84 يعجرملا تایثادحلإا ماظنب QGIS يف تاعورشملا حتفت ،ةیضارتفا ةٍفصب

 ةمظنأ فلاتخا عم ىتح ھنأ ينعی ام وھو .)ةقباسلا تارادصلإا يف "OTF" ـب اھیلإ زمر( ينلآا لیوحتلاب فرعی ام وأ "on the fly" بولسأب تانایبلا

 .ھتاذ ىدملاب اھلیثمت ةداعإ QGIS لواحی ،ةددعتملا تاقبطلا عم تایثادحلإا

 عورشملا طاقسإ نم ققحتلا

 .عورشملا يف قبطملا )CRS( يعجرملا تایثادحلإا ماظن ضرعی QGIS ةھجاو نم نمیلأا بناجلا لفسأ يف .أ

 .CRS ىلإ لقتنا مث نمو )عورشملا صئاصخ( Project Properties حتفل قوف رقنا .ب

 .عورشملا يف ھقیبطت دیرت يذلا CRS ماظن رایتخا كنكمی ةحوللا هذھ نم .ج

 ."PDC Mercator" نع ثحبنس ،ةلاحلا هذھ يف .عورشملاو مءلاتی CRS ماظن داجیلإ ثحبلا طیرش مدختسا .د

 .3832:زمرلا لمحی يذلا CRS ماظن رتخا .ـھ

 .)قفاوم( OK قوف رقنا .و
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 ةقبطلا طاقسإ نم ققحتلا

a. 3 حتفا_first_steps/Layers/South_Tarawa_EAs2015_4326.shp 

 رقنا ،Layer Properties حتفل ،ركذت( ةقبطلا عم مدختسملا CRS ماظن نم ققحتلل )ةقبطلا صئاصخ( Layer Properties حتفا .ب

 .) "تاقبطلا"Layers ةحول نم ةقبطلا مسا ىلع اجًودزم ارًقن

 CRS ماظن دجتس ،)دوزملا نم تامولعم( Information from provider مسقلا يف .)تامولعم( Information ىلإ لقتنا .ج

 .)قفاوم( OK قوف رقنا .ةقبطلا عم مدختسملا

 

 

 

 
 ةقبطلا طاقسإ رییغت

 .يتابیركب رزجلا دودحل قفاوملا وھو ،first_steps/Layers/KIRJID_4326.shf_3 حتفا .أ

 .يتابیركل يفارغجلا قاطنلا طسو ربع رمی يلودلا خیراتلا طخ نلأ كلذو .ةطیرخلاب ةلباقتملا بناوجلا ىلع رزجلا نم نیتعومجم ضرع ظحلاتس

 نایدیریم لوح زكرمتتس لاثملا اذھ يف ةطیرخلا نأ لاإ ،0 نایدیریم ىلع WGS 84 وھو لاأ QGIS جمانربل يضارتفلاا يثادحلإا ماظنلا زكرمتی

 .دیدج CRS ماظن ىلع اھطبضنو انیدی نیب يتلا ةقبطلا طاقسإ دیعنس ،ةلكشملا هذھ جلاعلو .180
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 Export > Save Features ىلإ لقتنا مث نمو ةقبطلا مسا ىلع نمیلأا ةرأفلا رزب رقنا ،)تاقبطلا( Layers ةحول نم .ب
As )مساب ملاعملا ظفح > ریدصت(... 

 

 
 

 .ESRI Shapefile فلملا عون دیدحت نم دكأت )قیسنت( Format نم .ج

 .اھعقومو ةدیدجلا ةقبطلا مسا رتخاو تافلملا فشكتسم حتفل  قوف رقنا ، )فلملا مسا( File name بناجب .د

 تایثادحلإا ماظن ددحم( Coordinate Reference System Selector حتفل  قوف رقنا ،CRS طیرش بناجب .ـھ
 .)يعجرملا

 3832 :بتكا ،)حشرملا( Filter طیرش يف .و

 .)قفاوم( OK قوف رقنا مث هاندأ تاحوللا نم يأ يف WGS 84 / PDC Mercator CRS رتخا  .ز
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 .)قفاوم( OK رز قوف رقنا ،..)مساب تاھجتملا ةقبط ظفح.( Save Vector Layer as ةحول ىلإ عوجرلابو .ح

 .لصفلا اذھ ةیادب يف ةنیبملا تاوطخلا عابتاب CRS PDC Mercator EPSG:3832 ىلإ عورشملا طاقسإ رّیغ .ط

 .يداھلا طیحملا ةقطنم لوح طاقسلإا زكرمتل كلذو ،امًیلس اضًرع اھضرعو طئارخلا ةحول ىلع رزجلا روھظ ظحلاتس .ي
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 ةیساسأ دادعت ةطیرخ لوأ طیطخت 3.7

 ،ةطیرخلا طیطخت ذیفنت يف ءدبلا لبقو .)EA 21053008 لاثملا لیبس ىلع( دادعتلا قطانم ىدحلإ ،)يولام( وجنولیلل دادعت ةطیرخ ءاشنإ ىلإ مسقلا اذھ يف فدھن

 .غراف عورشم نمض ةطیرخلا زیھجت ىلع لمعنس

 . قوف رقنلاب QGIS لخاد اًدیدج اعًورشم وأ ةدیدج ةسلج حتفا .أ

 first_steps/Layers/Lilongwe_EA_2018_4326.shp_3 لمّح .ب 

 .)3-3و 2-3 مسقلا عجار( EA داوكلأ ةبسنلاب ءاضیب ةیناكم ةمزحأ تاذ تایمستو ةئبعتلا فافش اطًمن رتخا .ج
 .(XYZ تاعبرم( XYZ Tiles نم Google Satellite ةیفلخ فضأ .د

 ./first_steps_3 دلجملا لخاد عورشملا ظفحا .ـھ

 .هاندأ ةروصلل ةھباشم كیدی نیب يتلا ةطیرخلا نوكت نأ ضرتفملا نم ،هلاعأ ةنیبملا تاوطخلا عابتا دعب .و
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 دیدج ةعابط طیطخت ءاشنإ 3.7.1

 > عورشملا( Project > New Print Layout ىلإ لقتنا ةیولعلا ةمئاقلا نم وأ  قوف رقنا ،دیدج طیطخت حتفل  .أ
 .)دیدج ةعابط طیطخت

 .)ةعابطلا طیطخت( Print Layout ةھجاو رھظتسو )قفاوم( OK قوف رقنا مث نمو ،دیرت يذلا مسلاا طیطختلا مس .ب
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 ةحفصلا صئاصخ 3.7.2

 .)ةحفصلا صئاصخ( Page Properties قوف رقنا مث نمو ةغرافلا ةحفصلا قوف نمیلأا ةرأفلا رزب رقنا .أ
 

 
 
 
 
 
 
 
 
 
 

 .ةشاشلا نم نمیلأا بناجلا ىلع ةدوجوملا ةمئاقلاب )رصنعلا صئاصخ( Item Properties بیوبتلا ىلإ لقتنا .ب

 .ةلدسنملا ةمئاقلا نم A4 رتخا مث نمو )مجحلا( Size ىلإ لقتنا .ج 

 .)يقفأ( Landscape رتخا مث نمو )هاجتلاا( Orientation ىلإ لقتنا .د

 .ةحفصلا ةیفلخل اًنول رتخا ،)ةیفلخ( Background نم .ـھ
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  قوف رقنلاب كلذو رارمتساب اھیرجت يتلا تارییغتلا ظفح سنت لا ،ةیلاتلا تاوطخلا ذیفنت ءانثأ
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 ةطیرخ ةفاضإ 3.7.3

  قوف رقنا ،طئارخ ةحول ةفاضلإ .أ

 .ةطیرخلل ررقملا ناكملا يفً لایطتسم مسرا .ب

 .اھمجح رییغت وأ اھبحس دیرت يتلا )طیطختلا يف ھتأشنأ رخآ رصنع يأو( ةطیرخلا ةحول دیدحت كنكمی  مادختساب .ج

 .لضفت يذلا وحنلا ىلع ةطیرخلا زكرمت ىتحو طئارخلا ةحول لخادب ىوتحملا )بحسو ریغصت/ریبكت( كیرحتل  مدختسا  .د

 .ةفلتخم تابیوبت نمض ةبترم مئاوق ةدع دجتس ،)ةعابطلا طیطخت( Print Layout ةھجاولل نمیلأا بناجلا نم .ـھ

 سایقلا وأ مجحلا لثم تادادعلإا ضعب طبض اننكمی ةمئاقلا هذھ نم .)رصنعلا صئاصخ( Item Properties قوف رقنا ،ةطیرخلا ةحول دیدحت ءانثأ .و

 .بیتكلا اذھ نم ةیلاتلا لوصفلا يف لیصفتلا نم دٍیزمب ةمئاقلا هذھ ىلإ قرطتنس .ىرخلأا تادادعلإا نم دیزملاو ةطیرخلا ىلع ةضورعملا تاقبطلا وأ

 صئاصخ( Item Properties بیوبتلا ىلإ لقتنا ،ةعابطلا طیطخت ىلإ ةیسیئرلا QGIS ةھجاو نم ةطیرخلا ىدم خسن تدرأ اذإ .ز
 .)ةطیرخلا ةحولل ىدمك طبضلا( Set to map canvas extent قوف رقنا ،)ىدملا( Extents مسق نمو )رصنعلا

قوف رقنا مث نمو )رصنعلا صئاصخ( Item Properties ىلإ لقتنا ،ةعابطلا طیطخت ىلإ ةیسیئرلا QGIS ةھجاو نم ةطیرخلا ىدم خسن تدرأ اذإ  ح
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 ناونع ةفاضإ 3.7.4

 . قوف رقنا ،دیدج ناونع ةفاضلإ .أ 

 .ناونعلل ررقملا ناكملا يفً لایطتسم مسرا .ب

 .)ةیساسلأا صئاصخلا( Main Properties مسقلا يف دیرت يذلا ناونعلا بتكاو )رصنعلا صئاصخ( Item Properties ىلإ لقتنا. .ج
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 .صنلا ةاذاحمو ھنولو ھمجحو طخلا عون رتخا ،)رھظملا( Appearance نم .د

 سایق طیرش ةفاضإ 3.7.5

 .سایق طیرش ةفاضلإ  قوف رقنا .أ

 .سایقلا طیرشل ررقملا ناكملا يفً لایطتسم مسرا .ب

 .عطاقملا ددع وأ تادحولا وأ طمنلا لثم سایقلا طیرش تادادعإ طبض كنكمی ،)رصنعلا صئاصخ( Item Properties ةمئاق نم .ج

 ةروص ةفاضإ 3.7.6

 .ناونعلا بناجب ارًاعش فیضنس ،لاثملا اذھ يف .ةروص ةفاضلإ  قوف رقنا .أ

 .ةروصلل ررقملا ناكملا يفً لایطتسم مسرا .ب

 قوف رقنا ،)ةیساسلأا صئاصخلا( Main Properties مسقلا نم .)رصنعلا صئاصخ( Item Properties ةمئاق ىلإ لقتنا .ج

 

 .)حتف( Open قوف رقنا مث نمو ،first_steps/Images/QGIS logo.jpg_3 يف ةظوفحملا ةروصلا فضأ .د

 لامشلا مھس ةفاضإ 3.7.7

a. ىرخأٍ ةروص ةفاضلإ  قوف رقنا. 
 .لامشلا مھسل ررقملا ناكملا يفً لایطتسم مسرا .ب
 تانئاك ضرعتً ةشاش دجتس ،)ثحبلا لئلاد( Search Directories مسقلا نم .)رصنعلا صئاصخ( Item Properties ةمئاق ىلإ لقتنا .ج

 .لامشلا مھسلأ ةفلتخم جذامن اھنیب نم SVG قیسنتب
 .ةئبعتلاو تاراطلإا تادادعإ طبض كنكمی ،(SVG تاملعم( SVG Parameters مسق نم  .د

 ةطیرخلا حاتفم وأ حاضیلإا لئاسو ةفاضإ 3.7.8

 .ةطیرخلا حاتفم ةفاضلإ  قوف رقنا .أ

 .ةطیرخلا حاتفمل ررقملا ناكملا يفً لایطتسم مسرا .ب

 Auto update دیدحت غلا ،)ةطیرخلا حاتفم رصانع( Legend Items مسق نم .)رصنعلا صئاصخ( Item Properties ةمئاق ىلإ لقتنا .ج
 .ةنیاعملا ةحول لفسأ مكحتلا رصانع لیعفت ظحلاتس .ا�یودی ةطیرخلا حاتفم تایوتحم طبضل )يئاقلت ثیدحت(
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 . قوف رقنا مث نمو هددح ،رصانعلا نم رصنع يأ فذحل .د

 .ازًاجیإ رثكأ ھلعجو صنلا رییغتل  قوف رقنلا وأ دیرت يذلا رصنعلا قوف اجًودزم ارًقن رقنلا كنكمی .ـھ
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 ةطیرخلا ریدصت / ةعابط 3.7.9

 .ةطیرخلا ریدصت كنكمی ،دیعب دٍح ىلإ ةطیرخلا هذھ لثم ودبت نأ ضرتفملا نم يتلاو ،طیطختلا ةئیھ نع كاضر دعب
 

 
 
 

  قوف رقنا ً،ةرشابم ةطیرخلا ةعابطل .أ

  قوف رقنا ،ةروصك ةطیرخلا ریدصتل .ب

  قوف رقنا ،SVG قیسنتب ةطیرخلا ریدصتل .ج

  قوف رقنا ،PDF قیسنتب ةطیرخلا ریدصتل .د

 https://docs.qgis.org/3.4/en/docs/user_manual/print_composer/index.html :ىلإ عوجرلا ىجری ،تاطیطختلا نع دیزمللو
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  نكاسملا عقاوم:طاقنلا تاقبط  4
 )يساسلأا تاھجتملا لیلحت( 

 
 ةفلتخم تانایب رداصم نم طاقنلا تاقبط داریتسا 4.1

 
 قطانملا عقاومب ةصاخلا تامولعملل يفارغجلا عجرملا حبصأ .ةیعارزلا وأ ةیناكسلا تادادعتلا نم ةیئاصحلإا تانیعلا تاراطإ قاسُت امً ةداع

 امك .ةیدادعت قطانم نع ةرابع تادحولا تناك اذإ ةیئاصحلإا تادحولا ةمئاق جارختسا لھسیو .دیعب دٍح ىلإ ةیمقر ةغیصب نكاسملا وأ ةیدادعتلا

 تاساردلا لاح يف .ةعارزلا تارازوو ةیئاصحلإا تاسسؤملل ةریبك تٍارامثتسا يضتقی دق ،ةیدادعتلا ةقطنملا دودحل ةیمقر ةٍقبط ءانب نأ

 ةیمقرلا تانیعلا عمج راطإ ءاشنإ حیتی ام وھو .ةیمقرلا طئارخلا ساسأ ىلع ةیدادعتلا عقاوملا دیدحت نكمی ،ةیعارزلا وأ ةیلزنملا ةیئاصقتسلاا

 .طاقن ةقبط ءاشنإو

 لثم قفارم وأ )HHS ـب يلی امیف اھیلإ راشی( نكاسملا لیثمت لجأ نم ساسلأا يف ةیئاصقتسلاا تاساردلاو تادادعتلا يف طاقنلا تاقبط مدختست

 ءاشنإ عم ،ةیكذلا فتاوھلا وأ ةیحوللا ةزھجلأا وأ GPS تادحو مادختساب ةیطقنلا عقاوملا هذھ عمجت امً ةداعو .اھریغو تایفشتسملاو سرادملا

 .مدختسملا قیبطتلا وأ زاھجلا ىلإ اًدانتسا ةفلتخم تافلم تاقیسنت

 بوساحلا ةدعاسمب ةیصخشلا تلاباقملا ءارجإ قیبطت وأ GPS ةدحو مادختساب تئشنأ طاقن ةقبط لیمحت ةیفیك سردنس ،لصفلا اذھ يف

)CAPI( لخاد QGIS. دیدحت كل يغبنی ،تافلملا يف لمعلا ءدب لبق ،نیتلاحلا لاك يفو: 
 ؛تانایبلا عمج يف مدختسملا )CRS( يعجرملا تایثادحلإا ماظن •

 ىلع .اھتءارق QGIS جمانربل نكمی تاقیسنتو تٍادحو مادختسا نم دكأتلا عم ،"طاقنلا عقاوم" لیثمتل ةمدختسملا تاقیسنتلاو تادحولا •
 تاجردب امإ تایثادحلإا لیثمت نم دكأتلا انل يغبنی ،GPS يف مدختسملا تایثادحلإا ماظن ،WGS 84 مدختسن انك اذإ ،لاثملا لیبس
 .طاقنلا عقوم نییعت ءانثأ ءاطخأ يأ دوجو بنجتل نٍاوث/قئاقد/تاجرد ةغیصب وأ ةیرشع
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4.1.1 : CAPI ددحم يصن فلم ).csv( 

 تادادتما( Excel قیسنتب لوادجلا QGIS درتسی لا .اھعقوم دیدحتو CAPI تانایب ةدعاق نم GPS تانایب داریتسا ةیفیك مسقلا اذھ انل نیبی

.xls or .xlsx(. قیسنتب لوادجلا ظفحً لاوأ كل يغبنی اذل CSV (MS-DOS). 

 رداصم ریدم > ةقبطلا( Layer > Data Source Managerىلإ لقتنا ةیولعلا ةمئاقلا نم ،QGIS لخاد لوادجلا لیمحتل .أ
  قوف رقنا وأ ،)تانایبلا

 .)ددحم صن( Delimited Text رتخا ،ةمئاقلا يف رسیلأا بناجلا نم .ب

 .تافلملا فشكتسم حتفل  قوف رقنا مث نمو )فلملا مسا( File name ةحول ىلإ لقتنا .ج

 point_layers/Tables/MOZ_HHlocations.csv_4 حتفا .د 

 .)لصاوفب ةلوصفم میق( CSV (comma separated values) رایخ ددح ،)فلملا قیسنت( File Format نم .ـھ
 مث نمو )ةطقنلا تایثادحإ( Point coordinates رایخ ددح ،)يسدنھلا لكشلا فیرعت( Geometry Definition نم .و

 نم دكأت . )Y  لقح( Y field و )X لقح( X field تاحول يف ضرعلا رئاودو لوطلا طوطخ تایثادحلإ ةقفاوملا لوقحلا رتخا
 ةیرشعلا تاجردلاب لثمت انھ تایثادحلإا نأ كلذ )DMS تایثادحإ( DMS coordinates رایخلا دیدحت مدع
 رتخا ،)يسدنھلا يثادحلإا ماظنلا( Geometry CRS عم .ناوثلاو قئاقدلاو تاجردلا قیسنتب سیلو

EPSG:4326 - WGS 84. 

 .)قلاغإ( Close مث نمو )ةفاضإ( Add قوف رقنا .ز 
 

 

 
 

 اًعبتم طاقنلا مسری QGIS جمانربف ،ةمئلاملا ةقبطلا يھ تسیل ةقبطلا هذھ نأ ظحلا .طئارخلا ةحول ىلع كتلاخدمل ةقفاوملا ةیطقنلا ةباحسلا ضرعت

 اھیلع لیدعت يأ ءارجإ نكمی لا ،طاقنلا ضرع مغر ھنأ ينعی ام وھو .لودجلا نم تایثادحلإا ةءارقب كلذو "on the fly" ينلآا لیوحتلا بولسأ

  .shapefile قیسنتب لودجلا ردصن ،ةلكشملا هذھ جلاعلو .لاثملا لیبس ىلع اھفذح وأ اھجارختساك
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 Export > Save Features ىلإ لقتنا مث نمو"ةقبطلا" ىلع نمیلأا ةرأفلا رزب رقنا ،)تاقبطلا( Layers ةحول نم .ح 
As )مساب ملاعملا ظفح > ریدصت(. 

 .ESRI Shapefile رتخا ،)قیسنت( Format نم .ط

 .)ھب ىصوملا راسملا وھ /shapefile )4_point_layers/Layers فلم ظفح عقوم ددح مث  قوف رقنا .ي
 .EPSG:4326 - WGS 84 دیدحت نم دكأت ،CRS نم .ك

 .)قفاوم( OK قوف رقنا .ل
 

 
 
 

 .امًیلس اضًرع نكاسملا عقاوم ضرع نم ققحتلل Google Satelite تایفلخ نم يأ وأ لجوج طئارخ ىدحإ لمّح .م
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 )gpx. قیسنت( )Garmin Etrex ـل جذومن( GPS تادحو 4.1.2

 ،gpx. قیسنت مادختساب GPS طاقن داریتسا نكمی مث نمو USB ربع رتویبمكلا زاھجب Garmin Etrex 10/20/30 تازارط لیصوت نكمی

 .QGIS يف ةرشابم ھحتف نكمی يذلاو

 ،)تانایبلا رداصم ریدم > ةقبطلا( Layer > Data Source Managerىلإ لقتنا ةیولعلا ةمئاقلا نم ،gpx. فلم لیمحتل .أ
 قوف رقنا وأ

 .)ھجتم( Vector رتخا ،ةمئاقلا يف رسیلأا بناجلا نم  .ب

 .تافلملا فشكتسم حتفل  قوف رقنا مث نمو )فلملا مسا( File name ةحول ىلإ لقتنا .ج

 point_layers/Etrex/HHlocations_GPS.gpx_4 حتفا .د

 .)ةفاضإ( Add قوف رقنا .ـھ
 waypoints رایخلا ددح ، ...)ةفاضلإل تاھجتملا تاقبط نم ةقبط رتخا( Select Vector Layers to Add ةحول نم .و

 .)قفاوم( OK قوف رقنا مث نمو )قیرطلا طاقن(
 

 
 

 .)تانایبلا رداصم ریدم( Data Source Manager قلغأ .ز

 ةقبطلا قوف نمیلأا ةرأفلا رزب رقنا ،)تاقبطلا( Layers ةحول نم ،طئارخلا ةحول ىلع ةیطقنلا ةباحسلا رھظت مل لاح يف .ح
HHlocations_GPÎ رتخا مث نمو Zoom to Layer )ةقبطلل بیرقتلا( . 

 .امًیلسً اضرع قیرطلا طاقن ضرع نم ققحتلل Google Satellite تایفلخ ىدحإ لمح .ط
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 اھؤارجإ نكمی يتلا تایلمعلا نم دحی ام وھو .shapefile قیسنتب ظفحت لا ،قباسلا لاثملا يف csv. تافلم عم لاحلا وھ امك ،ةقبطلا هذھ نأ ظحلا

 .QGIS ةئیب نمض

 يف اھظفحاو shp. ىلإ csv. تافلم ریدصتل ةعبتملا تاوطخلا عبتا ،shapefile قیسنتب ةقبطلا هذھ ریدصتل .ي
LpointJayers/ Layers/. 

 
 

 طاقنلا تاقبط ریرحت 4.2
 

 ملاعملا فذح/ءاشنإ 4.2.1 

 .طئارخلا ةحولب point_layers/Layers/HHFrom_GPS_4326.shp_4 لمح مث نمو  اًدیدج اعًورشم حتفا .أ

 .ةقبطلا ریرحت ءانثأ اندیفی ام وھو .يعانصلا رمقلا روص تایفلخ ىدحإ حتفا .ب

 ،بابسلأا نم ببس يلأً أطخ تبكترأ اذإ ،اذھبو .ةیلصلأا ةقبطلا نمً لادب ةخسنلا ىلع تلایدعتلا ءارجإو ةقبطلا خسنب يصون ،ةقبطلا ریرحت ءانثأ

 .ةدوقفملا تانایبلا ةداعتسلا ةیطایتحا ةخسنك يلصلأا فلملا ىقبی ،ةیسدنھلا لاكشلأا نم لٍكش يأ فذحك

 ةقبطلا مسو  point_layers/Layers_4 ىلإ ةقبطلا ریدصتب ةخسن دادعإ كنكمی .ج
HHFrom_GPS_4326_EDITED.shp، لاثملا لیبس ىلع. 

 رایتخا مث نمو ةقبطلا ىلع نمیلأا ةرأفلا رزب رقنلاب )تاقبطلا( Layers ةحول نم يلصلأا shapefile فلم فذحا .د
Remove Layer )ةقبطلا ةلازإ(... 

 .ریرحتلا ةسلج ءدبل  قوف رقنا مث نمو )تاقبطلا( Layers ةحول نم  HHFrom_GPS_4326_EDITEDرتخا .ـھ
 بناجب ملقلا زمر روھظو )میقرتلا تاودأ طیرش( Digitizing Toolbar نمض مكحتلا رصانع ضعب لیعفت ظحلاتس
 .)تاقبطلا( Layers ةحولب ةیمستلا
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 .GPS تانایب ةدعاق نم اًیضارتفا ةدوقفملا عقاوملا ضعب ةفاضإ دیرن ،ةلحرملا هذھ دنع
 .دیدجلا عقوملل ررقملا عضوملل لصت ىتح برق  .و

 . ىلإ  نم رشؤملا ریغت ظحلتسو  قوف رقنا .ز

 .رقنا مث دیدجلا ةطقنلا عقوم قوف رشؤملا عض .ح
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 رقنا مث نمو )ملاعملا تامس( Features Attributes ةحول يف ةدوجوملا لوقحلا نم لقلأا ىلع اًدحاو لأما   .ط
 .)قفاوم( OK قوف

 .تارییغتلا ظفحل  قوف رقنا مث نمو طاقنلا نم دٍیزم عم تاوطخلا هذھ ررك .ي

 . قوف ىرخأً ةرم رقنا ،ریرحتلا ةسلج فاقیلإ  .ك

 ملاعملا كیرحت 4.2.2 

 .)ةمدقتملا میقرتلا تاودأ طیرش( Advanced Digitizing Toolbar مادختساب ىلولأا ةقیرطلاو .QGIS لخاد ملاعملا كیرحتل ناتقیرط ةمث 

 Advanced Digitizing رتخا ،)تاودلأا ةطرشأ( Toolbars مسق نمو ،ةیولعلا ةمئاقلا قوف نمیلأا ةرأفلا رزب رقنا .أ
Toolbar )مكحتلا رصانع لك لطعت امیف ةیولعلا ةمئاقلا نمض )هاندأ نیبملا( تاودلأا طیرش لخدی .)ةمدقتملا میقرتلا تاودأ طیرش. 

 

 
 

 .تاودلأا طیرش يف مكحتلا رصانع ضعب لیعفت ظحلتس .ریرحتلا ةسلج ءدبل      قوف رقنا .ب

 .  زمرلا اذھ ىلإ ةرأفلا رشؤم ریغتی   قوف رقنا.ج

 .دیدجلا اھعضوم يف ةطقنلا رھظتس .اًددجم رقناو دیدجلا عضوملا ىلإ ةرأفلا رشؤم كرح مث نمو اھرییغت دیرت يتلا ةطقنلا قوف رقنا .د
 .تارییغتلا ظفحل        قوف رقنا .ـھ

 طیرش( Digitizing Toolbar ـب ةدوجوملا ،)سأرلا ةادأ( Vertex Tool مادختساب يھف طاقنلا كیرحتل ةیناثلا ةقیرطلا امأ 
 .)میقرتلا تاودأ

 .          ىلإ ةرأفلا رشؤم ریغتیسو          قوف رقنا .أ

 .          ىلإ ریغت ةرأفلا رشؤم نأ دجتسو اھكیرحت دوت يتلا ةطقنلا قوف رشؤملا كرح.ب 

 .          ىلإ رشؤملا ریغتی مث نمو دیرت يتلا ةطقنلا قوف رقنا .ج 

 .اھتیبثتل رقنا مث دیدجلا اھعضوم ىلإ ةطقنلا كرح .د

 .تارییغتلا ظفحل        قوف رقنا .ـھ 

 .رسیلأا رزلاب رقنلا + ملعملا كیرحت + رسیلأا رزلاب رقنلا :ھتاذ بیترتلا مدختست امھلاك نأ كلذ ،دیعب دٍح ىلإ ناتقیرطلا ناتاھ ھباشتت

 تامسلا لودج لیدعت 4.2.3

 .HHFrom_GPS_4326_ EDITED ةقبطلا لوانتن انلزام يعرفلا مسقلا اذھ يف
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 .ةیولعلا ةمئاقلا نم         قوف رقنلاب )تامسلا لودج( Attribute Table حتفا مث نمو ةددحملا ةقبطلا رتخا )تاقبطلا( Layers ةحول نم .أ

 ةقبطلا قوف نمیلأا ةرأفلا رزب رقنلاب يھو لاأ )تامسلا لودج( Attribute Table ىلإ لوصولل ىرخأ ةقیرط ةمث
 .)تامسلا لودج حتف( Open Attribute Table رایتخا مث )تاقبطلا( Layers ةحول يف اھتددح يتلا
 

 
 
 

 لا لوقحلا هذھو .غراف اھعیمج نأ لاإ لوقحلا نم دیدعلا يوحی )تامسلا لودج( Attribute Table نأ ظحلا 
 .)مسلاا( Name لقحلا ادع امیف اًعیمج اھفذحنس مث نمو بیردتلا اذھل مزلت

 نمو ةیسیئرلا QGIS ةذفان نم اذھ مكحتلا رصنع ىلإ لوصولا نكمی .        قوف رقنا ،ریرحتلا ةسلج ءدبل  .ب
 .كلذك )تامسلا لودج( Attribute Table ةذفان

 .ةذفانلا ىلعأ مئاوقلا طیرش يف        قوف رقنا ،)تامسلا لودج( Attribute Table نم .ج

 .)قفاوم( OK قوف رقنا مث نمو )لوقحلا فذح( Delete Fields ةحول نم اھفذح دیرت يتلا لوقحلا رتخا  .د
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 Name لقحلا ىوس ةلحرملا هذھ يف )تامسلا لودج( Attribute Table مضی لا ،اذكھو .تارییغتلا ظفحل         قوف رقنا .ـھ
 .)مسلاا(

 فیضن ةلاحلا هذھ يفو .)تامسلا لودج( Attribute Table يف ایلاخلا لیدعت نكمی ،ریرحتلا ةسلج يف لمعلا ءانثأ  .و 
 .ھلمع ةیفیك ةبرجتل )مسلاا( Name لقحلا ىلإ ةیئاوشعلا ءامسلأا ضعب

 

 
 

 
 .)جئاتنلا نم ققحتلا( Identify Results ةحول ضرعتسو ةطیرخلا ةحولب طاقنلا نمً ةطقن ددح مث نمو           قوف رقنا  .ز

 تناك اذإ( )ملعملا جذومن ریرحت( Edit feature form رایخلا حاتی ،لیعفتلا دیق ریرحتلا ةسلج تناك اذإ .)تاءارجلإا( Actions ىلإ لقتنا  .ح

 .)"ملعملا جذومن ضرع" View feature form رایخلا ضرعی ،ةلعفم ریغ ریرحتلا ةسلج
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 .)قفاوم( OK قوف رقنا مث نمو يغبنی امك لوقحلا لأماو )ملعملا جذومن ریرحت( Edit feature form قوف رقنا .ط
 Attribute يف سكعنتو )ملعملا جذومن ریرحت( Edit Feature Form رایخلا يف ةلخدملا تلایدعتلا رھظت

Table )تارییغتلا ظفحل          قوف رقنا مث نمو.)تامسلا لودج. 
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 لٍقح ءاشنلإ قوف رقنا مث نمو ریرحتلا ةسلج لیعفت نم دكأت .)تامسلا لودج( Attribute Table ىلإ ىرخأ ةرم لقتنا .ي 

 .)تامسلا لودج( Attribute Table نمض )دومع( دیدج
 .لقحلا مسا بتكا ،)مسلاا( Name يف .ك
 .دیدجلا لقحلا يف اھنیزخت ررقملا تانایبلا عون ددحن ،)عونلا( Type يف .ل

Whole number )تانایبتسلاا داوكأ وأ ةیانبلا يف فرغلا ددعو نكسملا مجح لثم تٍانایبل )حیحص ددع. 

Decimal number )تلادعملا وأ بسنلاك ةیرشعلا ماقرلأا مادختسا يضتقت يتلا تانایبلل )يرشع ددع. 
Text )لاغشلإا ةلاح وأ ءامسلأاب ةصاخلا تانایبلل )صن. 

Date )خیراتلا( وDate & Time )دلایملا خیرات وأ ةلباقملا دعوم لثم تٍانایب ظفحل )تقولاو خیراتلا. 

 دارفلأا ددعل صصخم رخلآاو "Occupancy" مسا تحت لاغشلإا ةلاحل صصخم امھدحأ :نیلقح ئشنأ .م
 ."HHsize" مسا تحت نكسملا يف نیمیقملا

 Attribute Table و )ملعملا جذومن ریرحت( Edit Feature Form رایخلا امًدختسم فوفصلا ضعب ئشنأ .ن
 .تلایدعتلا ظفحل   قوف رقنا مث نمو )تامسلا لودج(

 )يناكم طبر( عقوملا بسح تامسلا طبر 4.2.4

 ىلإ تاعلضملا ةقبط نم تامولعملا لقنت .دادعتلا قطانم ةقبط مادختساب GPS طاقن تامس لودج ىلإ تامولعملا ضعب فیضنس
 .ةیناكم تاقلاع مادختساب طاقنلا ةقبط
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 _point_layers/Layers/MOZ_4 لمح مث نمو   اًدیدج اعًورشم حتفا .أ
HHlocations_4326.shp4 و_point_layers/Layers/MOZ_EA_ 

example_4326.shp طئارخلا ةحولب. 

 .نیتقبطلا لاك ةیؤر نكمی ىتح تاعلضملا ةقبط ىلعأ طاقنلا ةقبط عض ،)تاقبطلا( Layers ةحول نم .ب

 Vector > Data Management Tools > Join Attributes byىلإ لقتنا ،ةیولعلا ةمئاقلا نم .ج
Location )عقوملا بسح تامسلا طبر > تانایبلا ةرادإ تاودأ > ھجتم(. 

 لبقتست يتلا طاقنلا ةقبط يھو ،MOZ_HHlocations_4326.shpرتخا ،)لخدلا ةقبط( Input layer نم .د
 .تاعلضملا ةقبط نم تامولعملا

 .تامولعملا رفوت يتلا ةقبطلا يھو ،MOZ_EA_example_4326.shp ددح ،)طبرلا ةقبط( Join layer نم .ـھ

 .)نمضم( withinرتخا ،)يسدنھلا دانسلإا( Geometric predicate نم .و

 طاقنلا ةقبط ىلإ اھتفاضإ يف بغرت يتلا لوقحلا رتخا مث نمو     قوف رقنا ،)اھفیضت لوقح( Fields to add نم .ز
 .)قفاوم( OK قوف رقنا مث

 اھمساو دیدجلا طاقنلا ةقبط عقوم ددح مث          قوف رقنا )اھطبر دارملا ةقبطلا( Joined layer نم  .ح
)4_point_layers/Layers/MOZ_HHlocations_ ADDED_DATA_4326.shp لیبس ىلع 
 .)لاثملا

 .)لیغشت( Run قوف رقنا .ط
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 عجار .)اھطبر دارملا ةقبطلا( Joined layer ـك ةدیدجلا طاقنلا ةقبط رھظت )تاقبطلا( Layers ةحول نم .ي
Attribute Table )نم ةدیدجلا لوقحلا ةفاضإ نم دكأتتل ةقبطلاب صاخلا )تامسلا لودج MOZ_ 

EA_example_4326.shp. 
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  دادعتلا قطانم:تاعلضملا تاقبط  5
 )يساسلأا تاھجتملا لیلحت( 

 

 

 ةدیدج ملاعم میقرت :ةدیدج تاعلضم ةقبط ءاشنإ 5.1

 .بیردتلا ذیفنت اننكمی ىتح عورشملا فلم زھجن ،ةیادبلا يف

 _polygon_layers/Layers/MWI_5 لمح مث نمو   اًدیدج اعًورشم حتفا .أ
HH_EAcode_4326.shp طئارخلا ةحولب. 

 .دادعتلا قطانم دودح میسرت ءانثأ كدیفی ام وھو .طاقنلا ةقبط لفسأ يعانصلا رمقلا تایفلخ نم ةیفلخ لمح .ب

 قطانم نم ةقطنم لك دودح ریرقت ىلع اندعاسی ام وھو ،(EA( دادعتلا قطانم داوكأ يوحیً لاقح نكاسملا عقاوم ةقبط مضت
 .دادعتلا

 ىلإ لقتنا مث نمو )ةقبطلا صئاصخ( Layer Properties ةمئاق حتفا ،)تاقبطلا( Layers ةحول نم .ج
Symbology )زیمرتلا(. 

 .)فنصم( Categorized رتخا ،ىلولأا ةلدسنملا ةمئاقلا نم .د

 ةضورعم طاقنلا نأ ظحلا .)فینصت( Classify قوف رقنا مث نمو EA_CODE لقح رتخا ،)ةمیقلا( Value نم .ـھ
 .اھنم لٍكل )EA( دادعتلا ةقطنم دوك ىلإ اًدانتسا ةفلتخم نٍاولأب
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 :لكشلا اذھ ىلع ةطیرخلا جرخت نأ يغبنی .)قفاوم( OK قوف رقنا.و

 .دادعتلا ةقطنم دودح قفاوت ةیادبلا نم ةقبط ءاشنإ يھ ةیلاتلا ةوطخلا
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 > ةقبطلا( Layer > Create Layer > New Shapefile Layer ىلإ لقتنا ةیولعلا ةمئاقلا نم وأ ،    قوف رقنا .ز
 ...)ةدیدج Shapefile ةقبط > ةقبط ءاشنإ

 ،لاثملا لیبس ىلع( ھعقومو دیدجلا فلملا مسا نییعتل  قوف رقنا ،)فلملا مسا( File name نم .ح
5_polygon_layers/Layers/EnumAreas_4326.shp ). 

 .)علضم( Polygon رتخا ،)يسدنھلا لكشلا عون( Geometry type دنع .ط

 .EPSG:4326 - WGS 84 رتخا ،CRS دنع .ي

 )عونلا( Type ـلو eaid :ددحن )مسلاا( Name ـلو ،دیدج لقح ءاشنإ اننكمی ،)دیدج لقح( New Field مسقلا نم .ك
 Add to Fields List قوف رقنن مث نمو .10 :ددحن )لوطلا( Length ـلو ،Whole number :ددحن
 .)لوقحلا ةمئاق ىلإ ةفاضإ(

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 ةظحللا هذھ ىتح تاعلضم يأ ضرعت نل( )تاقبطلا( Layers ةحول ىلإ ةقبطلا فاضتسو )قفاوم( OK قوف رقنا .ل

 .)"ةغراف" تلازام ةقبطلا نأ كلذ

 .ریرحتلا ةسلج ءدبل   قوف رقنا مث نمو )تاقبطلا( Layers ةحول نم ةددحملا ةقبطلا رتخا  .م

 ،میقرتلا ةادأ كمادختسا عم ىتح ھنأ ركذت   ىلإ ةرأفلا رشؤم لوحتی.دیدج علضم ةفاضلإ   قوف رقنا .ن
 نمو ةرأفلا ةلجع ىلع طغضلاب اھئاجرأ نیب لقنتلا كنكمی امك ةرأفلا ةلجع ریودتب ةطیرخلا ىلع ریبكتلاو ریغصتلا كنكمی
 .ةطیرخلا ىلع اھبحس مث

 .اھعضت يتلا دودحلل تاملاعك ةیعانصلاو ةیعیبطلا ملاعملا مادختسا كنكمی .اھدودح لوط ىلع رقنلاب دادعتلا ةقطنم دودح عبتت .س 
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 لوقحلا لأما .)ملعملا تامس( Feature Attributes راوح عبرم رھظیسو ،علضملا مسر ءاھنلإ نمیلأا ةرأفلا رزب رقنا .ع

 .)قفاوم( OK قوف رقنا مث نمو ةمئلاملا تامولعملاب

 
 ىلع اھلخدت يتلا تارییغتلا ظفح سنت لاو .هلاعأ ةنیبملا تاوطخلا عابتاب دادعتلا قطانم تاعلضم نم دیزملا ءاشنإ كنكمی .ف

 . قوف رقنلاب كلذو رارمتساب ةقبطلا

 ةاذاحملا 5.2 

 تاغارفلا( ةیجولوبوطلا ءاطخلأا نم اضًیأ للقی امب ،تقولا رفوت ةادأ يھو .میقرتلا ةیلمع ذیفنت ءانثأ ضعبلا اھضعب تانئاكلا ةاذاحم مدختسملل ةاذاحملا ةادأ حیتت

 .)تاعلضملا نیب تلاخادتلاو

 اھضعبو تاعلضملا دودح قباطتت لا ،ىلولأا تاعلضملا ءاشنإ ءانثأ ةاذاحملا ةادأ مدختسن مل اننلأو .اھانأشنأ يتلا ةقبطلا ةیجولوبوط فیظنت يف أدبن ،كلذ دعب

 .ةیلاتلا ةروصلل ةھباشم ةقبطلا رھظت ھیلعو ،ضعبلا
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 قوف نمیلأا ةرأفلا رزب رقنا ،ةیولعلا ةمئاقلا نمضً لاعفم )ةاذاحملا ةادأ طیرش( Snapping Toolbar نكی مل اذإ .أ
 ةطرشأ( Toolbars مسق نم )ةاذاحملا ةادأ طیرش( Snapping Toolbar رتخا مث نمو ةیولعلا ةمئاقلا طیرش
 .)تاودلأا

 .ةاذاحملا ةادأ لیطعت/لیعفتل  قوف رقنا .ب
 All Layers, Active Layer or :ةاذاحملا ةادأ اھلجأ نم لعفت تاقبطلا يأ دیدحتل  قوف رقنا .ج

Advanced Configuration )ةمدقتم ةئیھت وأ ةطشنلا ةقبطلا ،تاقبطلا لك(. رتخا Active Layer )ةقبطلا 
 .ارًیسی ارًمأ ةادلأا هذھ مادختسا ىلع بردتلا نم لعجیسو تارایخلا طسبأ ھنوكل )ةطشنلا

 نیرایخلا لاك عم وأ )عطقم( Segment وأ )سأر( Vertex عم ةاذاحملا ةادأ لیعفت دیدحتل  قوف رقنا .د
Vertex and Segment )ثلاثلا رایخلا ددح .)عطقمو سأر: Vertex and Segment. 

 اننكمی .ةاذاحملا ةادلأ )توافتلا لدعم( Tolerance طبضل   ةمئاقلا هذھ مدختسا .ـھ
 دكأتتل براجتلا ضعب يرجت نأ لضفلأا نمو .ةطیرخلا تادحو وأ لسكیبلا تادحو مادختساب توافتلا لدعم لیلقت/ةدایز
 .لوبقملا لدعملا ىلع توافتلا طبض نم
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 لدعت ،ةادلأا هذھ مادختسا دنع( )يجولوبوطلا ریرحتلا( Topological Editing ةادأ نیكمتل   قوف رقنا .و

 نیب دودحلا میسرت يف اندیفی ام وھو )كرتشملا سأرلا اذھ كیرحت دنع ھتاذ تقولا يف نیعم سأر يف كراشتت يتلا ملاعملا
 .اھلیدعتو دادعتلا قطانم تاعلضم

 حیتت ةادلأا هذھ .)عطاقت دنع ةاذاحملا( Snapping on Intersection ةادأ لیطعت/لیعفتل   قوف رقنا .ز
 .اسًوؤر كلتمت لا يتلا تاعطاقتلا ةاذاحم كل

 )تامسلا ،دودحلا میسرت( ریرحتلا 5.3

 .ةرواجملا تاعلضملا عم ةكرتشملا دودحلا حوضوو ةفاظن نم دكأتلا عم ،اھنیسحتو تاعلضملا فیظنتب موقن ،ةاذاحملا ةادأ لیعفت ءانثأ

 ىلإ لقتنا مث نمو )ةقبطلا صئاصخ( Layer Properties ةمئاق حتفا ،)تاقبطلا( Layers ةحول نم .أ
Symbology )زیمرتلا(. قوف رقنا Simple fill )ةطیسب ةئبعت(. 

 ـل نیابتلا عفترم اًنول ددحو اھترتخا يتلا يعانصلا رمقلا ةیفلخ راھظلإ %50 ىلإ )ماتعلإا( Opacity لدعم للق.ب
Stroke )ءاطخأ يأ حیحصت ءانثأ اًعفن يدجت حوضوب تاعلضملا دودح ةیؤر ةیناكمإف .)ةطغضلا. 
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 .   ریرحتلا ةسلج أدباوEnumAreas_4326.shp رتخا ،)تاقبطلا( Layers ةحول نم .ج

 امنیح رمحلأا نوللا ىلإ تاعلضملا لوحت ظحلاتسو .)سأرلا ةادأ( Vertex Tool ةادأ لیعفتل   قوف رقنا .د 
 .رشؤملا اھولعی

 ،سأرلا لقن دیرت ثیح فلتخم طٍخ وأ سٍأر نم برقلاب رشؤملا كرح .ھقوف رقنلاب دیرت يذلا سأرلا ددح :سأر كیرحت .ـھ
 .دیدجلا ھعضوم ىلإ سأرلا لقنل ىرخأً ةرم رقنا .مئلاملا ناكملا ىلإ لقتنیو سأرلا بذجنیس

  



 

 )يساسلأا تاھجتملا لیلحت( نكاسملا عقاوم :طاقنلا تاقبط | QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر

 

66 

 
 

 
 
 
 
 
 
 
 

 اھقوف رقنا .ددحملا عطقملا طسو ةحرتقم ةدیدج ةمق رھظت ،علضملا ةفاح قوف ةرأفلا رشؤم كیرحت دنع :دیدج سأر ءاشنإ .و
 .دیدجلا عضوملا ىلإ اھلقنا مث

 وأ سأرلا لوح ھبحسو لیطتسم ىلع رقنلاب وأ ھقوف رقنلاو Shift ىلع طغضلاب دیرت يذلا سأرلا ددح :سأر فذح .ز
 Delete طغضا ،ةددحملا سوؤرلا فذحل .قرزلأا نوللا ىلإ ھنول لوحتی سأرلا دیدحت دنع .اھفذح يف بغرت يتلا سوؤرلا
 .)فذح(

 نل ،كلذ لعفت نإ امو .نمیلأا ةرأفلا رزب ھیلع رقنلاب ملاعملا نم مٍلعم ىلع ریرحتلا رصق كنكمی :ریرحتلا لبق ملعم رصح .ح
 اھضعبل ةرواجم تاقبط ةدع ریرحت دنع اًعفن يدجی ام وھو .هریغ نود علضملا اذھ ىلع لاإ ریرحتلا تاءارجإ قبطت
 ةرأفلا مادختساب لمعلا اھنیح رملأا يضتقیسو اھلیدعتو عطاقملاو سوؤرلا دیدحت بعصی تلااحلا هذھ لثم يفو .ضعبلا
 .ددحملا سأرلا ىلإ لصتل بیرقتلاو

 ریرقتل يعانصلا رمقلا روص ةیفلخ مدختسا .دادعتلا ةقبط تاعلضم نیب دودحلا طبرل اھفذحو اھبحسو سوؤرلا ءاشنإ اننكمی نلآاو
 .عاطتسملا ردق ةیعیبطلا ملاعملاو قرطلا امًدختسم ھجو لضفأب دودحلا عضوم

  قوف رقنلاب كلذو رارمتساب ةقبطلا ىلع اھلخدت يتلا تارییغتلا ظفح سنت لا .ط
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 )دودحلا میسرت ،داوكلأا ماظن( ةرادلإا تاسرامم لضفأ :دادعتلا قطانم جمد/میسقت 5.4 

 تاعلضملا میسقتب كلذو ةقبطلا ثّدِحَُن مث .علضم لك لخاد نكاسملا ددع بسحنو دادعتلا قطانم راطإ للحن ،بیردتلا اذھ يف
 .اًنكسم 150و 120 نیب ام مضت نأو دب لا دادعت ةقطنم لك نأ ىلع صنی يذلا طرشلا ققحتل اھجمدو

 . _____________ قوف رقنلاب QGIS ـب اًدیدج اعًورشم وأ ةدیدج ةسلج حتفا .أ

 _MWI و polygon_layers/Layers/HH_NOcode_4326.shp_5 تاقبطلا لمح .ب
Lilongwe_EA_4326.shp . 

 .يعانصلا رمقلا روص تایفلخ ىدحإ لمح .ج

 Count Points in ةادأ مدختسن ،)علضم لك يف طاقنلا ددع( دادعتلا قطانم نم ةقطنم لك نمض نكاسملا ددع باسحل
Polygon )علضملا يف طاقنلا باسح(. 

 ھجتم( Vector > Analysis Tools > Count Points in Polygon toolىلإ لقتنا ،ةیولعلا ةمئاقلا نم .د
 .)علضملا يف طاقنلا باسح > لیلحتلا ةادأ >

 MWI_Lilongwe_EA_4326.shp رتخا ،)تاعلضملا( Polygons مسقلا نم .ـھ

 HH_NOcode_4326.shp رتخا ،)طاقن( Points مسقلا نم .و

 HHnum بتكا ،)باسحلا لقح مسا( Count field name يف .ز

 .ةلحرملا هذھ يف انتابلطتم مئلاتل ةتقؤمً ةقبط ةادلأا هذھ أشنت ،اغًراف )باسح( Count مسقلا كرتا.ح

 .)قلاغإ( Close قوف رقنا ،ةیلمعلا هذھ ءاھنإ دنعو )لیغشت( Run قوف رقنا .ط
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 Attribute  Table حتفا .)تاقبطلا( Layers ةحول يف Count مسا تحت ةقبط رھظت ةلحرملا هذھ يف .ي
 .ھلخادب HHnum لقحلا ضرع نم ققحتو )تامسلا لودج(

 .دادعتلا ةقطنمب ةصاخلا مجحلا طورش عم مءلاتیل لیدعتلا ىلإ ةجاحب تاعلضملا يأ ریرقت اننكمی ،HHnum لقح مادختسابو
 120 نم لقأ يوحت يتلا قطانملا نأ نیح يف ،امًجح لقأ قطانم ىلإ اھمسقنس اًنكسم 150 نم رثكأ يوحت يتلا دادعتلا قطانمف
 .اھل ةمخاتم تٍاعلضم عم اھجمدنس اًنكسم

 ءاشنإ نمً لادبو .لدعملا دادعتلا قطانم راطإب ةصاخلا)EA( دادعتلا قطانم داوكأ ظفحو نیزختل دٍیدج لٍقح ءاشنإ انل يغبنی امك
 عقوتن انك اذإ( میسقتلل تعضخ يتلا دادعتلا قطانم ىلإ ةراشلإل )EA( دادعتلا قطانم داوكأ ىلإ امًقر فیضنس ،امًامتٍ ةدیدج دٍاوكأ
 ،EA 21048001 میسقت دعب لاثملا لیبس ىلع .)نیمقر ةفاضإ جاتحنس اھنیح ،ءازجأ 10 نم رثكلأ دادعتلا قطانم ىدحإ میسقت

 مل اذإو .يلاوتلا ىلع 121048001و EA 21048001 دوكب میسقتلا نع نیتمجانلاو نیتدیدجلا دادعتلا يتقطنم ىلإ زمرنس
 .210550101 دوكلاب اھیلإ زمرنس ،میسقتلا ىلإ ةجاحب EA 21055010 دادعتلا ةقطنم نكت

 Field حتفاو  Count ةقبطلاب صاخلا )تامسلا لودج( Attribute Table ىلإ لقتنا .أ 
Calculator )قوف رقنلاب)لوقحلا ةبساح  . 

 .)دیدج لقح ءاشنإ( Create a new field  رایخلا ددح .ب

 EA_2020 بتكا ،)جرخلا لقح مسا( Output field name يف .ج 
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 .)"حیحص ددع" يلامجإ مقر( Whole number (integer) رایخلا ددح ،)جرخلا لقح عون( Output field type يف .د

 10 بتكا ،)جرخلا لقح لوط( Output field length يف .ـھ

 'EA_CODE" || '1" بتكا ،)ریبعتلا( Expression ةحول يف .و

 .ءاطخلأاب لئاسر يأ دوجو مدع نم دكأت ،)جرخلا ةنیاعم( Output preview نم .ز

 .میلس وٍحن ىلع لقحلا ءاشنإ نم دكأتـلل تامسلا لودج عجارو )قفاوم( OK قوف رقنا .ح
 

 

 

 

 

 

 

 

 

 

 Export > Save Features As قوف نمیلأا ةرأفلا رزب رقنا )تاقبطلا( Layers  ةحول نم .ط
 /polygon_layers/Layers_5 مسلااب اھظفحاو ...)مساب ملاعملا ظفح > ریدصت(

MWI_Lilongwe_EA_2020_4326.shp 

 تاءارجإ لك ذفنت ،ةلحرملا هذھ نم اءًدب .ریرحتلا ةیلمع ءدبل ةمزلالا رصانعلاو تابلطتملا لك انیدل تعمتجا نلآاو
 MWI_Lilongwe_EA_2020_4326.shp ةقبطلا ىلع )تایلمعلا لیجستو جمدلاو میسقتلا( ریرحتلا

 ةلازإب موقنس ،MWI_Lilongwe_ EA_4326.shp ،ةیساسلأا ةقبطلا ىلع تارییغت يأ ءارجإ عنملو .ي
 دیدحت مث نمو ةقبطلا قوف نمیلأا ةرأفلا رزب رقنلاب كلذو )تاقبطلا( Layers ةحول نم ةقبطلا هذھ

Remove Layer )كلذو رارمتساب عورشملا ىلع اھیرجت يتلا تارییغتلا ظفح سنت لاو .)ةقبطلا ةلازإ 
 .        قوف رقنلاب

 دادعتلا قطانم تاعلضم میسقت

 .علضملا ةقبط تحت يعانصلا رمقلا ةقبط رھظت ىتح ةفافش ةئبعت امًدختسم ةقبطلا طمن ددح .أ

  MWI_Lilongwe_EA_2020_4326.shp ةقبطلل           ریرحتلا عضو لّعِف .ب



 

 )يساسلأا تاھجتملا لیلحت( نكاسملا عقاوم :طاقنلا تاقبط | QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر

 

70 

 

 لقح بسح فوفصلا زرفب مقو  )تامسلا لودج( Attribute Table  حتفا .ج
 HHnumىلع( اًنكسم 150 نع اھیف نكاسملا ددع دیزی يتلا دادعتلا قطانم نم يأ رتخا .لقحلا ناونع قوف رقنلاب 
 علضملا ىلإ بیرقتلل         قوف رقنا مث )اھلخادب اًنكسم 301 يوحت يتلا EA210550331 لاثملا لیبس
 .رفصلأا نوللاب ازًیمم طئارخلا ةحول يف ةراتخملا دادعتلا ةقطنم علضم رھظیس .ددحملا

 اننأ ركذت .دیدحتلا ءاغللإ  و دیرن يتلا تاعلضملا دیدحتل          مادختسا ىلإ جاتحن ،تاعلضملا میسقت ءانثأ .د 
 .)تاقبطلا( Layers ةحول نم ةفدھتسملا ةقبطلا دیدحتً لاوأ انل يغبنی ،ةقبط يأ نم اھنیعب ملاعم دیدحت يف أدبن نأ لبق

 مجحلا تابلطتمب ءافولا لجأ نم نیئزج ىلإ علضملا میسقت ىلإ جاتحن ،EA 210550331 ـل ةبسنلاب ،لاثملا لیبس ىلع 
 نأو دب لا ةدیدجلا قطانملا هذھ دودح نأ كردن نأ انل يغبنی ،ھتاذ تقولا يفو .)نكسم 150-120( دادعتلا ةقطنمب ةصاخلا
 .عقاولا يف اھیلع فرعتلا لھسی

 Select Features ةادلأا قوف رقنا مث )تاقبطلا( Layers ةحول نم |IH_NOcode_4326.sh رتخا .1
by Polygon )ةمئاقلا ضرعل  رزـل قصلاملا مھسلا قوف رقنا( )علضملا بسح ملاعملا دیدحت 

  .) قوف رقنا مث ةلدسنملا
 

 

 

 

 

 

 

 

 رقنا اھدعب .دیدجلا میسقتلا نمض اھجاردإ ررقملا نم يتلا طاقنلا نیمضتل اًعباتتم ارًقن رقنلاب علضم يأ میسرت كنكمی .و 
 .دیدحتلا ةیلمع ءاھنلإ نمیلأا ةرأفلا رزب
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 ةراتخم ةطقن 149 ةمث .ةددحملا طاقنلا ددع نیبت ةلاسر رھظت ،جمانربلا ةھجاو لفسأ يف .رفصلأا نوللاب ةددحملا طاقنلا للظت .ز
 .میسقتلا ةیلمع يف امًدق يضملا اننكمی اننأ ينعیام وھو ،موسرملا دیدجلا علضملل ةحضاو دٍودحب

 

 

 

 

 

 

 

 

 

 

 رز قوف رقناو        ریرحتلا ةسلج طیشنت نم دكأتو،MWI_Lilongwe_EA_2020_4326.shp رتخا .ح
Split Features )ملاعملا میسقت(         ـب دوجوملا Advanced Digitizing Toolbar )میقرتلا تاودأ طیرش 

 ةرأفلا رزب رقنا .رسیلأا ةرأفلا رزب اًعباتتم ارًقن رقنلاب كلذو نیئزج ىلإ علضملا مسقیس يذلا طخلا عبتت اھدعب .)مدقتملا
  .ھمیسقت ررقملا علضملا جراخ طخلل ةیاھنلاو ةیادبلا يتطقن دوجو نم دكأت دیدجلا دحلا میسرت ءانثأ .دیدجلا دحلا ءاھنلإ نمیلأا
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 نم طاقنلا ةقبط ددح .ةدیدجلا دادعتلا قطانم اھنمضتت يتلا طاقنلا ددع نم دكأتن ،نیملعم ىلإ دادعتلا ةقطنم میسقت دعبو .ط
 علضملا ددح .دیدجلا علضملا قوف نمیلأا ةرأفلا رزب رقنا مث          رتخا  ،)تاقبطلا( Layers ةحول

MWI_Lilongwe_EA_2020_4326. shp طاقنلا لك ددحت اھنیح .كمامأ رھاظلا راوحلا عبرم يف 
 .جمانربلا ةھجاو لفسأ ةلاسرلا يف رھاظلا طاقنلا ددع نم دكأت .ا̧یلآ علضملا لخاد ةدوجوملا
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 دادعتلا ةقطنم علضمل دیدج EA دوك صیصخت يغبنی ھیلعو .ةقبطلا تامس لودج يف نیقباطتم نیفص دوجو ظحلاتس ،علضملا میسقت دعب .ي

 لودج( Attribute Table يف قرزلأاب ددحملا علضملا عم قفاوتی فص نع ثحبا مث          مادختساب دیدجلا علضملا ددح.ةدیدجلا
 .)EA_2020 (2150550332 لقحلل اًدیدج اًدوك صصخ .)تامسلا

 .تلایدعتلا ظفحل   قوف رقنا .ك

 .اھلخادب اًنكسم 150 نم رثكأ يوحت يتلا دادعتلا قطانم لك عم ةیلمعلا هذھ ءارجإ يغبنی

 دادعتلا قطانم تاعلضم جمد

 ةیلاحلا دادعتلا قطانم نم اھریغ عم اھجمد اننكمی ،نكاسملا نم ةیاغللً لایلق اًددع يوحت دادعت قطانم ةمث ناك اذإ

 .لضفأ وٍحن ىلع ينادیملا لمعلا ةرادلإ وأ ةیئاصقتسلاا تاساردلا - تانیعلا عمج طورشب ءافولا لجأ نم

 قوف رقنلاب HHnum لقح بسح فوفصلا زرفب مقو  )تامسلا لودج( Attribute Table حتفا .أ

 .اًنكسم 40 نم لقأ يوحت يتلا دادعتلا قطانم ىدحإ رتخا .لقحلا ناونع

 اھجمد نكمملا نم ناك نإ امو جمدلا ىلإ جاتحت يتلا دادعتلا قطانم دیدحت يف انتدعاسمل ةزیمم تایمست مدختسنس

 .اھل ةمخاتملا قطانملاب

 

 ماھم

 لاإ اھضعب عم قطانملا نم يأ جمد نكمی لا

 هذھبو .ةرئادلا/يحلا/ةنیدملا سفن عبتت تناك نإ

 .يرادلإا مرھلا ىلع ءاقبلإا اننكمی ةقیرطلا

  

 مسقلا ىلإ لقتناو )ةقبطلا صئاصخ( Layer Properties ةحول حتفا مث ،MWI_Lilongwe_EA_2020_4326.shp رتخا .ب
Labels )تایمست(. 

 .ىلولأا ةلدسنملا ةمئاقلا نم )ةدرفم تایمست( Single labels رایخلا ددح .ج

 ةحوللا يف يلاتلا ریبعتلا بتكاو )ریبعتلا راوح عبرم( Expression Dialog حتفل  قوف رقنا ،)ةمیقلا( Value ةمئاقلا نم .د

 "TA_CODE" || '-' || "HHnum" :ةغرافلا
 .اًیوس نكاسملا ددعو ةنیدملا دوك ضرعت تٍایمست ئشنن ریبعتلا اذھب  .ـھ
 اًدحاو علضم لكب ةصاخلا تامولعملا ةعجارم مث نمو         )ملاعملا دیدحت( Identify features ةادأ مادختساب يھو لاأ ةلیدب ةقیرط ةمث  .و

 .رخلآا ولت
 .)قفاوم( OK قوف رقنا مث ریبعتلا يف ءاطخأ يأ دوجو مدع نم ققحتتل )جرخلا ةنیاعم( Output preview ةلاسر عجار  .ز
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 .)قفاوم( OK قوف رقنا مث نمو )ةنیابتم ناولأو مجحلا ریبك طخ( ةطیرخلا ىلع تایمستلل احًضاو اطًمن رتخا

 اھتاذ ةنیدملل ءامتنلاا طرشب يفت ،اھنیب نم ،قطانملا يأو جمدلا يضتقت دادعتلا قطانم يأ دیدحت اننكمی ،ةطیرخلا ىلع تایمستلا هذھ ضرع عم

 .)امھنم لٍكب صاخلا EA دوك نم ىلولأا سمخلا ماقرلأا تواست اذإ اھتاذ ةنیدملل دادعتلا قطانم اعلضم يمتنی(

  ریرحتلا طیشنت نم دكأت .أ

 .رقنلا + Shift ىلع طغضلاب ةدحاو ةقطنم يف اھجمد ررقملا دادعتلا قطانم ددحو  رز مدختسا .ب 

 .        )ةددحملا ملاعملا جمد( Merge Selected Features ةادأ قوف رقنا  .ج

 لوقحب اھیقبن میقلا يأ ریرقت اننكمی ةحوللا هذھ نمو .)ملاعملا تامس جمد( Merge Features Attributes ةحول ضرعت .د 

 .ةجمدملا تاعلضملا

 تامسلا صلختسا( Take attributes from selected featureقوف رقنن مث نمو فوفصلا دحأ ددحن ،لاثملا اذھ يف .ـھ
 .)ددحملا ملعملا نم

 .يولعلا فصلاب ةلدسنملا مئاوقلا يف ةدوجوملا تارایخلا نیمدختسم )جمد( Merge فصلا لوقح ءلم وھو لاأ رخآ رایخ ةمث .و
 .HHnum لقحلا نم )يلامجإ( Sum رایخلا مادختساب نكاسملا ددع فیضن ،ةلاحلا هذھ يف
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 .جمدلا ةیلمع ءاھنلإ )قفاوم( OK قوف رقنا ،لوقحلا زیھجت روف 
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 تاقبطلا طامنأ  5.5

 
 ةیرادلإا دودحلا ضرع دنع مئلاملا زیمرتلا  5.5.1

 تاعلضم ةقبط لیمحت دنعف .ةفیظنو ةلماش ةطیرخ زیھجت لجأ نم ةیساسلأا رییاعملا ضعب عضو ناكمب ةیمھلأا نم ،ةیرادلإا دودحلا لیثمت دنع

 .مئلام ریغ طمن تاقولأا مظعم يف وھو ،ةیضارتفاٍ ةروصب يئاوشع زٍیمرت طمن QGIS عضی ،طئارخلا ةحولب

 ىدحإ نمض جردتس تناك نإ وأ ةلیوطٍ ةرتفل كیدی نیب يتلا ةقبطلا عم لماعتتس تنك اذإ مئلام زیمرت طمن نییعت ىلع زیكرتلا كیلع بجی انھ نمو

 .طئارخلا

 ،ةیفلخك يعانصلا رمقلا نم ةروص يأ مادختسا تدرأ اذإو .ةنكادلاو ةبخاصلا ناوللأا نع دعتبنو ةبحاش/لیتساب ناولأ مادختسا ىلإ لیمن :ةئبعتلا

 .تاقبطلا لفسأ ةحضاو ةیفلخلا هذھ نوكت ثیحب علضملا تاقبط ةیفافش طبض ىلإ جاتحتس
 ةدایزل طخلا ضرع يف رییغتلا اننكمیو .لضفأ ازًییمت تاعلضملا دودح زییمتل ةئبعتلا نول عم نیابتت ناولأ مادختسا ىلإ لیمن دودحلا/تاطغضلا

 .ةطیرخلا ةقد تلق ،طوطخلا ضرع داز املك ھنأ ىلإ ھبتنن نأ ىلع ،اھحوضو لیلقت وأ دودحلا حوضو
 طخلا ناولأ يف رییغتلا كنكمی )ةعوبطملا طئارخلل طاقن 7-6 نم لقأ تسیل( اھتءارق لھستل يفكی امب ةریبكو ةطیسب اطًوطخ مدختسا :تایمستلا

 .ةنكاد تایفلخ قوف تاقبطلا دوجو ءانثأ تایمستلا ةیؤرو حوضو نیسحتل تایفلخلاو ةیناكملا ةمزحلأاو

 تاقبطلا طامنأ طبض  5.5.2

 .          قوف رقنلاب QGIS ـب اًدیدج اعًورشم وأ ةدیدج ةسلج حتفا .أ

 _5 و polygon_layers/Layers/HH_EAcode_4326.shp_5 ةقبطلا لمح .ب
polygon_layers/Layers/MWI_EA_Pop_4326.sh| . 

 .يعانصلا رمقلا روص تایفلخ ىدحإ لمح .ج

 دوك نمً لاك تایمستلا نمضتت .ةیفلخلا هذھ نودب ىرخلأاو يعانصلا رمقلا نم روص ةیفلخ يوحت ةٍطیرخل امھدحأ :نیطمن نییعت ىلع بردتنس

AE طاقنلل نكاسملا فرعمو دادعتلا قطانم تاعلضمل. 

 Zoom to Layer رتخا مث نمو HH_EAcode_4326.shp قوف نمیلأا ةرأفلا رزب رقنا ،)تاقبطلا( Layers ةحول نم د
 .)ةقبطلل بیرقتلا(

 رتخا مث نمو )تاقبطلا( Layers ةحول نم امھنم لٍك قوف نمیلأا ةرأفلا رزب رقنلاب عورشملا لخاد ناتأشنملا ناتقبطلا ررك .ـھ
Duplicate Layer )ةقبطلا راركت(. 

 .F2 ىلع طغضلاب وأ )ةقبطلا ةیمست ةداعإ( Rename Layer دیدحت مث نمیلأا ةرأفلا رزب رقنلاب امإ نیتقبطلا لاك مِّسَ اھدعب .و
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 رمقلا ةروص رھظت ىتح ةنیابتم دٍودح عم ةفافش ھبش وأ ةٍفافش ةِئبعت اذ طٍمن رایتخا كل يغبنی روصلا ةیفلخ تاذ ةطیرخلاب قلعتی امیف .ز

 لواحنس اننأ ریغ ةیساسلأا طامنلأا نم طمن رایتخا نكمملا نمف ،تایفلخ يأ يوحت لا يتلا ةطیرخلا طمن نع امأ .تاقبطلا لفسأ يعانصلا

 .ةطیرخلا ةءارق حوضو نم نسحی نٍول داجیإ

 مسق ،)ةقبطلا صئاصخ( Layer Properties ةحول ىلإ لقتنا ،ةمداق طئارخو تِاعورشمل ترتخا يذلا طمنلا ظفحل .ح 
Symbology )زیمرتلا(، قوف رقناو Save Symbol )لاثملا لیبس ىلع( طمنلا اذھل امًسا بتكاو )زمرلا ظفح EA 

transparent(. رایخلا ددح Add to favorites )ةلضفملل ةفاضإ(، قوف رقنا مث Save )ظفح( اھدعب نمو OK )يف .)قفاوم 

 .)ةلضفملا( Favorites ةحول نمض احًاتم EA transparent زمرلا حبصی ،زیمرتلا ةمئاق حتفت نیح ةمداقلا ةرملا
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 ةرأفلا رزب رقنا .)طامنلأا قصل/خسن( Copy/Paste styles ةادلأا مادختسا تاقبطلا نم ةٍقبط قیسنت خسنل ةمدختسملا قرطلا نم .ط

 Styles > Copy Style > All Style Categories ددح مث )تاقبطلا( Layers ةحول نم دیرت يتلا ةقبطلا قوف نمیلأا
 .)طامنلأا تائف لك > طمنلا خسن > طامنلأا(

 > طامنلأا( Styles > Paste Style > All Style Categories ىلإ لقتنا مث نمو تاعلضملا تاقبط نم ىرخأً ةقبط رتخا .ي
 يف اھتئیھت تمت يتلا تادادعلإا لك لقنت ،)طامنلأا تائف لك( All Style Categories رایتخابو .)طامنلأا تائف لك > طمنلا قصل

 .ىرخلأا ةقبطلا يف اھقصلن مث ةمئاقلا يف ةضورعملا تائفلا ىدحإ راتخن ،تائفلا نم ةدحاو ةئف لقنلو .ةیساسلأا ةقبطلا
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 تاقبطلا تاعوضوم  5.5.3

 : ـل تاعوضوم ةغایص مدختسملل حیتت ،)تاقبطلا( Layers ةحول ىلعأ ةدوجوملا           )تاعوضوم( Themes ةادأ نإ
 ؛طئارخلا ةحولب تاقبطلا ةیؤرو حوضو ىدم يف مكحتلا  • 
 ؛عوضوملا نمض ةجردم ةٍقبط لك طمن ىلإ ةراشلإا  •

 .)ةعابطلا طیطخت( Print Layout ةھجاو نم ةطیرخلا حاتفم ةئیھتب ةقلعتملا تادادعلإا ضعب لیغشت  •

 ةلازإ/دیدحت نود ىرخلأ ةٍطیرخ نم لقنتلا انل حیتت يھف .دحاولا عورشملا نمض ةفلتخم طئارخو تٍاطیطخت دوجو لاح يف اًعفن يدجت ةادلأا هذھو

 .ىرخلأا ولت ةدحاو ةقبط لك دیدحت

 .ةیفلخلا هذھ نودب ىرخلأاو يعانصلا رمقلا نم روص ةیفلخ يوحت ةٍطیرخل امھدحأ :نیعوضوم دعن فوس ،لاثملا اذھ يفو

 .قباسلا مسقلا يف ةقبطلاب صاخلا طمنلا ةئیھتب انمق دقو .ةیفلخلا تاذ ةقبطلا ددح ،)تاقبطلا( Layers ةحول نم .أ

 .)عوضوم ةفاضإ( Add Theme  رایخلا ددح مث  قوف رقنا .ب
 .)قفاوم( OK قوف رقنا مث )Background لاثملا لیبس ىلع( دیدجلا عوضوملل امًسا فضأ .ج

 .تأشنأ يذلا عوضوملا دوجو ظحلتس ،)تاعوضوم( Themes ةمئاقلا حتف دنع .د
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 تاعوضوملا نیب لدبو )يعانصلا رمقلا ةقبط لیطعت سنت لا( يعانصلا رمقلا روصل تایفلخ يوحت لا يتلا تاقبطلل اعًوضوم ئشنأ اھدعب .ـھ

 .ةطیرخلا ةھجاو يف

 ةدعاق ىلإ ةدنتسملاو ةجردتملا طامنلأاو تائفلا  5.5.4

 تائفلا مادختساب زیمرتلا

 طئارخلا ةحولب polygon_layers/Layers/MWI_EA_Pop_4326.shp_5 ةقبطلا لمح .أ
 .)زیمرتلا( Symbology مسقلا ىلإ لقتنا مث )ةقبطلا صئاصخ( Layer Properties ةحوللا حتفا .ب
 .)فنصم( Categorize رتخا ،ایلعلا ةلدسنملا ةمئاقلا نم .ج

 ىلع ةفلتخم ءایحأ عقوم نییعت دیرن ،لاثملا اذھ يفو .ةفلتخم تٍائف ءاشنلإ ھمادختسا دیرن يذلا لقحلا رتخا ،)ةمیقلا( Value ةمئاقلا نم .د

 .(DIST_NAME( ھمسا وأ )DIST_CODE( يحلا دوك امإ راتخنس ھیلعو ،ةطیرخلا
 ىلع اھضرع يف بغرتلا يتلا ندملا دیدحت ءاغلإ/دیدحت كنكمی .هلاعأ ةحوللا يف تائفلا لك رھظتسو )فینصت( Classify قوف رقنا .ـھ

 ةئف لك نول رییغت كل حیتی امب ،)زومرلا ددحم( Symbol Selector ةحول رھظت ،زمر يأ قوف اجًودزم ارًقن ترقن اذإو .ةطیرخلا

 .ةدح ىلع
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 .)قفاوم( OK قوف رقنا دیرت يذلا زمرلا لیدعت نم ءاھتنلاا دعب  .و

 ةجردتملا زومرلا 

 .)رمتسم ریغتم سایق بسح نولت وأ قطانملا اھیف للظت ةیعوضوم طئارخ( ينوللا جردتلاب طئارخ ءاشنلإ ةجردتملا زومرلا مادختسا نكمی

 يف رصانعلا ددع يلامجإب وأ ةقطنملا بسح تانایبلا میسقت يھ كلذل قرطلا رھشأو .ریغتملا دیحوت نم دبلا ،ينول جردت ةطیرخ مادختسا دنعف

 .)نكاسملا وأ دارفلأا ،بیردتلا اذھ يف( ةقطنملا

 .دادعتلا ةفاثك تامولعملً لاقح أشنن اھدعب مث ةقطنملا مادختساب دادعتلا تامولعم دیحوت ىلإ جاتحن ،ةجردتملا زومرلا مدختسا يف ءدبلا لبقو
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 .دادعتلا قطانم تاعلضم نم علضم لك ةحاسم نزخی يذلا لقحلا ئشننً لاوأ

 .اھررك وأ ىرخأً ةرم 1WI_EA_Pop_20936.shp ةقبطلا لمح .أ
  )لوقحلا ةبساح( Field Calculator حتفا مث نمو )تامسلا لودج( Attribute Table حتفا .ب
 .ةیناكسلا ةفاثكلا لثمیً لاقح ئشننس )لوقحلا ةبساح( Field Calculator مادختساب .ج
 area :بتكا ،)جرخلا لقح مسا( Output field name لخاد .د

 نوكی نأ ىلع )"يقیقح" يرشع ددع( ) Decimal number (real) رتخا ،)جرخلا لقح عون( Output field type نم .ـھ
field length )لقحلا لوط(= و 10 precision )2 = )ةقدلا. 

 بسحی ،WGS 84 يثادحلإا ماظنلا مدختسن امدنع اننأ ظحلا( area / 1000000$ :بتكا ،)ریبعتلا( Expression ةحول يف  .و

QGIS ةدحولا يھو ،عبرم رتم ولیك ىلإ ةحاسملا ةدحو لوحنل 1,000,000 ىلع مسقن اذكھو ،ا¿یضارتفا ،عبرملا رتملاب تاحاسملا 

 ).ةیناكسلا تافاثكلا عم امًادختسا رثكلأا
 .)تامسلا لودج( Attribute Table يف حیحص وٍحن ىلع لقحلا ءاشنإ نم دكأتو )قفاوم( OK قوف رقنا .ز

 .ةحاسملا ىلع ناكسلا ددع ةمسقب ةیناكسلا ةفاثكلا بسحن اھدعب
 pop_dens :بتكا ،)جرخلا لقح مسا( Output field name لخاد .ح

 نأ ىلع )"يقیقح" يرشع ددع( ) Decimal number (real) رتخا ،)جرخلا لقح عون( Output field type نم  .ط

 .2 = )ةقدلا( precision و 10 =)لقحلا لوط( field length نوكی

 "TOT_POP" / "area" :بتكا ،)ریبعتلا( Expression ةحول يف  .ي

 .)تامسلا لودج( Attribute Table يف حیحص وٍحن ىلع لقحلا ءاشنإ نم دكأتو )قفاوم( OK قوف رقنا .ك
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 .دیرن يتلا ينوللا جردتلا ةطیرخ میمصت اننكمی ،ةیناكسلا ةفاثكلا لقح انأشنأ نأ دعبو
 .)زیمرتلا( Symbology مسقلا ىلإ لقتنا مث )ةقبطلا صئاصخ( Layer Properties ةحوللا حتفا .ل
 .)جردتم( Graduated رایخلا ددح ،ایلعلا ةلدسنملا ةمئاقلا نم .م
 .pop_dens لقحلا رتخا ،)دومع( Column مسقلا نم .ن

 .ةلدسنملا ةمئاقلا حتفل )ينوللا جردتلا( Color ramp رایخلا نیمی ىلع مھسلا قوف رقنا .س
 .ةحرتقملا ةینوللا تاجردتلا نم اًدحاو رتخا .ع
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 .تانایبلا فینصتل )"ئفاكتم باسح" ةئزجت( Quantile (Equal Count) ةقیرطلا ددح ،)عضولا( Mode نم .ف
 .)فینصت( Classify قوف رقنا مث 5 ددح ،)تافینصتلا( Classes نم .ص

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 .)قفاوم( OK قوف رقنا .ق
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 .ةحضاو لٍلاظب عتمتت يتلا ناوللأا مادختسا لضفی ،ةماع ةفصبو .ينبلاو يلاقتربلاو رضخلأا نوللا تاجردتب ةیناكسلا تافاثكلا لیثمت لضفی

 .(COLORBREWER 2.0 )http://colorbrewer2.org عقومب ةحرتقملا ناوللأا تاحول ضعب ةیؤر اننكمی هاندأ ةروصلا يفو

 ً.لایكشت رثكأ نٍاولأ تاحول QGIS يوحی 

 رایخلا نیمی ىلع مھسلا قوف رقنا اھدعب ،)زیمرتلا( Symbology رتخا مث )ةقبطلا صئاصخ( Layer Properties ىلإ لقتنا .أ
Color ramp )ةلدسنملا ةمئاقلا حتفل )ينوللا جردتلا. 

 :Catalog رایخلا ددح ...)دیدج ينول جردت ءاشنإ( Create New Color Ramp رتخا ،ةلدسنملا ةمئاقلا نم .ب
ColorBrewer )جولاتك: ColorBrewer) قوف رقنا مث نمو OK )قفاوم(. 

 .)قفاوم( OK ىلع رقنلا دعب colour brewer تاططخم مادختساب ينوللا جردتلا ةئیھتل ةصاخ ةمئاق رھظت 
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 دعاوق ىلإ ةدنتسم زومر

 دادعتلا قطانمل ةفلتخم زومر ةدع عضنس ،انیدیأ نیب يذلا لاثمللو .تاقبطلا نم ةقبط يأ زیمرت يف مكحتلل دعاوق عضو QGIS يف اننكمی

 .سكعلاو ثانلإا نع روكذلا لدعم اھیف دیزی يتلا

 .اھررك وأ اًددجم MWI_EA_Pop_20936.shj ةقبطلا لمح .أ
 .)زیمرتلا( Symbology مسقلا ىلإ لقتنا مث )ةقبطلا صئاصخ( Layer Properties ةحول حتفا .ب
 .)ةدعاق ىلإ دنتسم( Rule-based رایخلا ددح ،ایلعلا ةلدسنملا ةمئاقلا نم .ج
 .)ةدعاقلا ریرحت( Edit Rule ةحوللا رھظت مث نمو ىلولأا ةدعاقلا ةفاضلإ   قوف رقنا .د
 .ةئفلا هذھل دیرت يذلا مسلاا وأ male :بتكا ،)تایمست( Label لخادب .ـھ
 )ریبعتلا( Expression ةحول يف ”MALE”>”FEMALE“ ریبعتلا اذھ بتكاو   قوف رقنا ،)حشرملا( Filter نم .و

 .)قفاوم( OK قوف رقنا مث نمو
 .)قفاوم( OK قوف رقنا مث زمرلل اًنول رتخا .ھمدع نم ریبعتلا حاجن نم ققحتلل )رابتخا( Test قوف رقنا .ز
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 .ةیناثلا ةدعاقلا ةفاضلإ  قوف رقنا .ح
 female :بتكا ،)تایمست( Label لخادب .ط

 هذھ دنتستس لاثملا اذھ يفو .ةقباسلا دعاوقلا نمض جردنت مل يتلا دادعتلا قطانم لك ددحی رایخ وھو .)ىرخأ( Else رایخلا ددح .ي

 .ثانلإا نع روكذلا تلادعم اھیف لقت دادعت قطانم ىلإ ةدعاقلا
 .ةطیرخلا ةھجاو ىلع جئاتنلا نم ققحت مث )قفاوم( OK قوف رقنا .ك
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 ةمدقتملا ةیمستلا 5.6

 .ةضورعملا تامولعملا حوضوو ةدوج نیسحت ىلع كدعاسی ام وھو ،ةیمستلا تاراھم نیسحتل قرطلا ضعب مسقلا اذھ يف ملعتت

 ةیمستلا عضوم صیصخت  5.6.1
 .       قوف رقنلاب QGIS ـب اًدیدج اعًورشم وأ ةدیدج ةسلج حتفا .أ

 polygon_layers/Layers/CHL_Datos_Censo_2017_ Provincia_4326.shp_5 ةقبطلا لمح .ب

 polygon_layers/Layers/SAmerica_ bkground_4326.shp_5و
 )ةقبطلا صئاصخ( Layer Properties ةحول حتفا مث ،CHL_Datos_Censo_2017_Provincia_4326.shp ددح .ج

 اًقیسنت اھل صصخو NOM_PROVIN لقحلا مادختساب موسولا وأ تایمستلا ضعب ئشنأ .)تایمست( Labels مسقلا ىلإ لقتناو

 .تاقبطلا ةءارق حوضو نیسحتل امًئلام
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 QGIS يفخی ،ةضورعم ةحاسم يف تایمستلا نم نیعم ددع ةمث ناك اذإف .تایمستلا ضعب روھظ مدع ةظحلام كنكمی هلاعأ ةنیبملا ةروصلا يف

 .اھریغ عم لخادتت يتلا تایمستلا ةیضارتفاٍ ةروصب

 Show all رایخلا ددح مث نمو )ضرع( Rendering ةیعرفلا ةمئاقلا رتخا ،)تایمست( Labels نم ،ةیصاخلا هذھ رییغتلو .د
labels for this layer )ةقبطلا هذھب تایمستلا لك ضرعا(. 
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 فئاظو نیب نم ،مدختسملل ةادلأا هذھ حیتت .QGIS 3.4 LTR يف ةنمضتملا ةیمستلا كرحم ةادأ مدختسنس تایمستلا عقوم نییعت ةلكشم لحل

 .ةریثك تٍایمستب تٍاطیطخت ءاشنإ ءانثأ اًعفن يدجی ام وھو ،ا¿یودی ةیمست لك عضوم ددحتو لقتسم نایكك مسو وأ ةیمست لك لیدعت ،ىرخأ

 قوف نمیلأا ةرأفلا رزب رقنا ،ةیولعلا ةمئاقلا يف احًضاو   اذھ تاودلأا طیرش نكی مل اذإ .ـھ

 .)تایمستلا تاودأ طیرش( Labels Toolbar ددح،)تاودلأا ةطرشأ( Toolbars مسقلا نمو ةیولعلا ةمئاقلا

 .)ةقبطلا طمن دیدحت( Layer Styling ةمئاقلا حتفل  قوف رقنا .و

 ملعملا قوف رقنا ،اًددجم ةیمستلا ضرعلو .رقنلا + Shift ىلع طغضلاب ةیمستلا ءافخإ كنكمی          رتخا ،تایمستلا ءافخإ/ضرعل .ز

 .ةیمستلاب صاخلا
 .دیدجلا عقوملا ىلإ اھبحسا مث نموً لاوطم طغضاو دیرت يتلا ةیمستلا قوف رقنا مث             رتخا ،تایمستلا عقوم رییغتل .ح
 .ریودتلا ةجرد ریغت ىتح رارمتسلاا عم دیرت يتلا ةیمستلا قوف رقنا مث          رتخا ،تایمستلا ریودتل .ط
 ،اھنیعب تٍادادعإ رییغتب كل حمست ةمئاق رھظت اھنیح .اھلیدعت دیرت يتلا ةیمستلا قوف رقنا مث        رتخا ،ةدرفم ةیمست يأ قیسنت رییغتل .ي

 .ةیناكملا ةمزحلأاو طخلاك
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 انل يغبنیو .)ةقبطلا صئاصخ( Layer Properties ةحوللا نم )تایمست( Labels ةمئاقلا نم تادادعلإا لیدعت انناكمإب لاز لا
 طیرش( Labels Toolbar مكحتی ،)تایمستلا تاودأ طیرش( Labels Toolbar نم ةادأ يأ طیشنت روف ھنأ كردن نأ
 يف مكحتلا ةداعإ اننكمی ،كلذ عمو .)تایمست( Labels ةمئاق لحم لحیو تایمستلا تادادعإ يف ةٍیرصحٍ ةروصب )تایمستلا تاودأ

 رقنا ،)تایمست( Labels ةمئاقلا نم طخلا تادادعإ رییغت نم نكمتنل ،لاثملا لیبس ىلع ."تایمست" ةمئاق ىلإ تادادعلإا
 نكمی ،اًدعاصف نلآا نم  ىلإ تادادعلإا يف مكحتلا لقتنی اذكھو.)طیشنت ءاغلإ( Deactivate رتخا مث نمو            قوف

 .طقف ةمئاقلا نم تادادعلإا يف مكحتلا

 
 تایمستلا مادختساب ةقبطلا زیمرت ءاھنإ 5.6.2

 ةقطنم لكل دادعتلا ماقرأ ضرعنس ،لاثملا لیبس ىلعف .ةطیرخلل ةیفاضإ تٍامولعم ةفاضلإ موسولا وأ تایمستلا مدختسن ،بیردتلا اذھ يف 

 .QGIS يف ةطیسبلا ةیریبعتلا ةیوغللا رماولأا مادختساب كلذو تایمستلا يف ةیرادإ

a. 5 ةقبطلا لمح_polygon_layers/Layers/CHL_Datos_Censo_2017_ Region_4326.shp و 
5_polygon_layers/Layers/SAmerica_ bkground_4326.shp 

b. ةحول حتفا Layer Properties )ةقبطلا صئاصخ( مسقلا ىلإ لقتنا مث Labels )رایخلا ددح .)تایمست Single 
Labels )قوف رقنا مث نمو)ةدرفم تایمست . 

c.  يلاتلا ریبعتلا لخدأ: "NOM_REGION" ||' (Tpop: '|| (format_number( "TOTAL_PERS",0))||')' 

d. تادادعلإا لّدع )font size, buffer( "تاقبطلا ةءارق حوضو نیسحتل "يناكملا مازحلاو طخلا مجح. 
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 .ةدیدج لٍوقح ءاشنإ ىلإ ةجاحلا نود تایمستلل میقلا ةفاضإ اننكمی ،هانلخدأ يذلا ریبعتلا مادختسابو

 :NOM_REGION" ||' (Sex ratio" يلاتلا ریبعتلا لاخدإبو .ـھ
'||(format_number(("HOMBRES"/ "MUJERES" *100),1)) || '%)' ىلإ روكذلا ةبسن فاضت 

 .ةیمستلا ىلإ ةیرادإ ةقطنم لكل ثانلإا
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 /"format_number(("HOMBRES( مادختساب تامسلا لودج يف دیدج لقح ءاشنإ انناكمإب ناك ھنأ ظحلا

"MUJERES" *100),1)) ةنورم رثكأو عرسأ اًقباس اھانیب يتلا ةقیرطلا نأ لاإ .تاقبطلا ىوتحم يف مكحتلل لقحلا اذھ مادختسا ةیناكمإ عم. 

 .تایمستلا نول يف مكحتلل تاریبعتلا مادختسا اضًیأ اننكمی امك

 ،)نوللا( Color مكحتلا رصنعب نمیلأا ءزجلا نمو )صن( xtTe يعرفلا مسقلا ىلإ لقتنا ،)تایمست( Labels مسقلا نم .و
 .)ریرحت( Edit رتخا مث          قوف رقنا

 :يلاتلا ریبعتلا لخدأ .)ریبعتلا لسلاس أشنم( Expression String Builder ةحوللا رھظت . ز
case when ( "HOMBRES" > "MUJERES" ) then color_rgb(0,0,255) else 

color_rgb(255,0,0)end 

 .اھنم لقأ وأ %100 نم رثكأ ثانلإاو روكذلا نیب ةبسنلا نوك بسح فلتخت ةطیرخلا ىلع تایمستلا ناولأ نأ نلآا ظحلت
  



 )مدقتملا تاھجتملا لیلحت( دادعتلا قطانم :تاعلضملا تاقبط | QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر

 

94 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 مادختسا ىلإ أجلن اضًیأ رایخلا اذھ يفو .ةدعاق ىلإ ةدنتسملا تایمستلا رایخ مادختسا يھو لاأ ،تاریبعتلا ةقیرط مادختسلا لٍیدب بٍولسأ ةمث

 .طسبأ اھنإ لاإ ،تاریبعتلا

 polygon_layers/Layers/CHL_Datos_Censo_2017_ Region_4326.shp_5 ةقبطلا لمح .أ

-Rule رایخلا ددح .)تایمست( Labels مسقلا ىلإ لقتنا مث )ةقبطلا صئاصخ( Layer Properties ةحوللا حتفا .ب
based labeling )ةدیدج ةدعاق ةفاضإ          قوف رقنا مث)ةدعاق ىلإ ةدنتسم تایمست  

 < "HOMBRES" :ثانلإا نع روكذلا لدعم اھیف دیزی يتلا تلااحلل يلاتلا ریبعتلا لخدأ ،)حشرملا( Filter لخادب .ج
"MUJERES" 

 :ةبكرملا تایمستلا جارختسلا ھتاذ ریبعتلا مدختستنس ،)ةمیقلا( Value نمو .د

 NOM_REGION" ||' (Sex ratio: '||(format_number(("HOMBRES"/ "MUJERES" *100),1))" .ـھ
|| '%)' 

 ةمزلالا ىرخلأا تلایدعتلا لكو )يناكملا مازحلا( Bufferو ،)لاثملا لیبس ىلع ،نكاد يدامر( )نوللا( Color طبضا .و

 .تایمستلا ةءارق ةلوھس نیسحتل
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 .  ةدیدج ةدعاق فضأ .ز

 "HOMBRES" < "MUJERES" :يلاتلا ریبعتلا لخدأ ،)حشرملا( Filter لخادب .ح

 .)ىرخأ( Else رایخلا دیدحت وھو لاأ رخآ رایخ ةمث .ط

 .)ةمیقلا( Value تحت ةجردنملا تایمستلل ھتاذ ریبعتلا مدختسا .ي
 .تایمستلا ةءارق ةلوھس نسحت يتلا تلایدعتلا نم اھریغو يناكملا مازحلاو "يلاقترب" ىلع نوللا طبضا .ك
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  دادعتلا قطانم:تاعلضملا تاقبط  6
 )مدقتملا تاھجتملا لیلحت( 

 
 اھحیحصتو تلاخادتلاو ةیسدنھلا ءاطخلأاو تاغارفلا داجیإ :ةیجولوبوطلا فیظنت 6.1

 ءًاطخأ يوحت يتلا تاقبطلا نعو .ةیجولوبوطلا ءاطخلأا بنجت عم ةدیدج ملاعم ءاشنإ يف مھست عطاقتلا/ةاذاحملا تاودأ نمً ةعومجم QGIS يوحی

 .اھجلاعو ءاطخلأا نم اھریغو لاوحلأا بلغأ يف ةیاغلل ةریغصلا تلاخادتلاو تاغارفلا داجیإ ةمھم نم ففخی يفاضإ نوكم ةمث ،لعفلاب

 .          قوف رقنلاب QGIS ـب اًدیدج اعًورشم وأ ةدیدج ةسلج حتفا .أ

 .polygon_layers_advanced/layers/EAs_toclean_3460.shp_6 لمح .ب

 لاح ةٍیطایتحا ةٍخسنك يلصلأا فلملا ظفحنسو .يلصلأا فلملا لیدعت نمً لادب ةخسنلا هذھ ىلع لیدعتلاو فلملا نم ةخسن ءاشنإ لضفلأا نمو

 .اھجلاع نكمی لا ءاطخأ يأ ثودح
 نم دكأتو )اھتیبثتو ةیفاضلإا تانوكملا ةرادإ >ةیفاضلإا تانوكملا( Plugins > Manage and Install Plugins ىلإ لقتنا .ج

 .)ةیجولوبوطلا ققدم( Topology Checker يفاضلإا نوكملا لیعفتو تیبثت
 Vector > Topology ىلإ لاقتنلااب امإ )ةیجولوبوطلا ققدم( Topology Checker          ةحول ىلإ لوصولا كنكمی .د

Checker )هاندأ ةحولل ةھباشم ةحول حتفت جمانربلا ةھجاو يف .ةیولعلا ةمئاقلا يف  قوف رقنلاب وأ )ةیجولوبوطلا ققدم >ھجتم. 
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 ةدعاق فضأ

 
 .)ةیجولوبوطلا ةدعاق تادادعإ( Topology Rule Settings رھظتسو   )ةئیھت( Configure قوف رقنا .ـھ

 ،بیردتلا اذھ يف يھو ،اھتیجولوبوط نم ققحتلا دیرن يتلا ةقبطلا رتخا ،ىلولأا ةلدسنملا ةمئاقلا نم  .و
EAs_toclean_3460.shp 

 صخت ءاطخأ يأ ىلع رثعی ثیح( )تاغارف يوحت لاأ بجی( must not have gaps رتخا ،ةیلاتلا ةلدسنملا ةمئاقلا نم .ز

  قوف رقنا اھدعب .)ةقبطلاب ةدوجوملا تاغارفلا
 .هاندأ ةدوجوملا ةحوللا ىلإ ةدیدجلا ةدعاقلا فاضت اھنیحو 

 ریغ ةیسدنھ لاكشأ يوحت لاأ بجی( must not have invalid geometries نیتدعاقلا عم اھتاذ تاوطخلا ررك  .ح
 .)قفاوم( OK قوف رقنا مث نمو )بكارتت لاأ بجی( must not overlapو )ةحلاص

 .ةقبطلا اھیوحت يتلا ةیجولوبوطلا ءاطخلأا لكب ةمئاق رھظتس .ةقبطلا ىلع دعاوقلا لك قیبطت نم ققحتلل  قوف رقنا

 .ةطیرخلا ىلع ءاطخلأا زییمتل ةمئاقلا راسی لفسأ )طئارخلا راھظإ( Show Errors رایخلا ددح
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 .   ریرحتلا ةسلج لیعفت ىلإ جاتحن ،ءاطخلأا جلاع يف ءدبلا لبق
 رایخلا لیطعت نمو  )ةاذاحملا( Snapping ةادأ طیشنت نم ققحت

 Topological editing )يجولوبوطلا ریرحتلا(  . 

 ءانثأ حیحصلا ناكملل جمانربلا لاقتنا نم دكأتلل ةقبطلاب صاخلا تایثادحلإا ماظن عم عورشملا يف مدختسملا تایثادحلإا ماظن قباطت نم دكأت

 .اھجلاع ررقملا ءاطخلأا دیدحت

 تاغارفلا حیحصت

 كل يغبنیو .اھلخاد وأ تاعلضملا نیب تاغارف يأ دوجو نودً لاماكتم احًطس تاعلضملا لك لكشت نأ بجی ،ةیرادلإا دودحلا ىلع لمعلا ءانثأ

 ىدحإ ةاذاحمب تمق اذإ ھنأ ينعی ام وھو .ةمقلاب ةمقلا لاصتا ربع امھیقلات متی نأو دب لا ،امھنیب دودحلا يف ناكرتشی نیعلضم يأ نأ ركذتت نأ

ٍ غارف ةمث نكی مل نإو ىتح ،تاغارفلا ءاطخأ نم أطخ كیدل أشنیس ،اًقبسم ةدوجوملا ممقلاب لصتی لا وھو ،مخاتملا علضملا بناوج دحلأ ممقلا

 .نیعلضملا نیب

 .ةطیرخلا ھیلإ برقتسو gaps تاغارفلا ءاطخأ نم يأ قوف رقنا ،)ةیجولوبوطلا ققدم( Topology Checker ةحوللا نم .أ

 .غارفلا حوضو زیزعتل )ءاطخلأا راھظإ( Show errors رایخلا دیدحت غلا

 .لباقملا سأرلا يذاحی نأ ىلإ ھبحساو سأرلا قوف رقنا مث         )سأرلا ةادأ( Vertex Tool لعف .ب
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 سأر ءاشنإ .ةیلاتلا تاوطخلا عابتا كل يغبنی ،ةیجولوبوطلا ءاطخلأا نم يأ جلاعل ھفذح وأ سأر ءاشنإ رملأا ىضتقا لاح يف .ج 
 .دیدجلا عضوملا ىلإ اھلقنا مث اھقوف رقنا .ددحملا عطقملا طسو ةیضارتفا ةدیدج ةمق رھظت ،علضملا دح قوف ةرأفلا رشؤم كیرحت دنع

 سوؤرلا وأ سأرلا لوح ھبحسو لیطتسم ىلع رقنلاب وأ ھقوف رقنلا + Shift ىلع طغضلاب دیرت يذلا سأرلا ددح :سأر فذح .ز

 .)فذح( Delete طغضا ،ةددحملا سوؤرلا فذحل .قرزلأا نوللا ىلإ ھنول لوحتی سأرلا دیدحت دنع .اھفذح يف بغرت يتلا

 .اھیلع لمعن يتلا ةقطنملا يف ةیغارفلا ءاطخلأا جلاع نم ققحتلل  )ىدملا ةحص نم ققحتلا( Validate Extent قوف رقنا .د

 اًددجم رقنا .)ةیجولوبوطلا ققدم( Topology Checker ةحول يف ءاطخأ يأ رھظت نل ،ةیجولوبوطلا تلاكشملا جلاع لاح يف

 .رثكأو رثكأ ةیلمعلا هذھ مھفتل تاغارفلا نم دیزم جلاعو         )لكلا ةحص نم ققحت( Validate All رزلا قوف

 .تارییغتلا ظفحل   قوف رقنا .ـھ 

 ةحلاصلا ریغ ةیسدنھلا لاكشلأا حیحصت 
 .میلس ریغ علضملا لكیھ نأ ينعی اذھف ،حلاص ریغ يسدنھ لكش دوجوب ءاطخأ دصر لاح يف
 لاكشأ( Invalid Geometries ءاطخأ نم يأ قوف رقنا ،)ةیجولوبوطلا ققدم( Topology Checker ةحوللا نم .أ

 .ھیلإ بیرقتلل )ةحلاص ریغ ةیسدنھ

 .رثكأ وأ نیسأر بكارت نم أشنت يتلا كلت ةحلاصلا ریغ ةیسدنھلا لاكشلأا ءاطخأ لھسأ نمو

 ةبكارتملا سوؤرلا ةظحلام نكمی .ھقوف نمیلأا ةرأفلا رزب رقنلاب علضملا رصحاو         )سأرلا ةادأ( Vertex Tool مدختسا .ب

 .اھلصف وأ ةبكارتملا سوؤرلا فذح يغبنی ،ءاطخلأا نم عونلا اذھ حیحصتلو .نوللا ءارضخ تاملاعب ةزیمم رھظت ذإ ةلوھسب
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 .طخً لاكشم امًامت اطًوغضم علضملا رھظی ،ىرخأ تلااح يفو

 تابكارتلا وأ تلاخادتلا حیحصت

 .ھیلإ بیرقتلل )تابكارتلا( overlaps  ءاطخأ نم يأ قوف رقنا ،)ةیجولوبوطلا ققدم( Topology Checker ةحوللا نم .أ

 .رضخلأا نوللاب أطخلا لحم علضملا ءازجأ لك زییمت ظحلا

 ةقاش ةمھم بكارتلا اذھ لثم ىلع روثعلا دعی ،تلااحلا مظعم يفو .لخادتلا ةطقنل ددحملا عقوملاب انتفرعم مدع يھ انھ اھھجاون يتلا ةلكشملاو

 .جمانربلاب ةجمدملا يسدنھلا لكشلا قیقدت ةادأ مادختساب اھلیجعت نكمی ةلممو
 . EAs_toclean_3460 ةقبطلل           ریرحتلا ةسلج طیشنت غلا .ب
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 قیقدت( Check Geometries ةحوللا حتفل )ةیسدنھلا لاكشلأا قیقدت > ھجتم( Vector > Check Geometries ىلإ لقتنا .ج

 Plugins ىلإ لقتنا ،ةمئاقلا يف )ةیسدنھلا لاكشلأا قیقدت( Check Geometries رایخلا رفوت مدع لاح يف( .)ةیسدنھلا لاكشلأا
> Manage and Install Plugins )نیبی .يفاضلإا نوكملا اذھ لیعفتل ...)اھتیبثتو ةیفاضلإا تانوكملا ةرادإ >ةیفاضلإا تانوكملا 

 )ةیفاضلإا تانوكملا لیطعت/لیعفت ةقیرط 2-2 لصفلا
 .ةادلأا اھذفنت يتلا تاقیقدتلا ةئیھتل )طبض( Setup بیوبتلا ددح د
 . EAs_toclean_3460 ةقبطلا دیدحت نم دكأت )تاھجتملا تاقبط لاخدإ( Input vector layers نم .ـھ
 Multipolygonو )علضم( Polygon تارایخلا ددح )اھب حومسملا ةیسدنھلا لاكشلأا( Allowed geometry types نم .و

 .)ةددعتم تاعلضم(

 ماسقلأا يف ةیضارتفا ةروصب ةلعفملا تارایخلا دیدحت يغلنس ،قیقدلا دیدحتلا تابكارتلا عقوم دیدحت وھ ھیلع لمعن يذلا يساسلأا فدھلا ناك امل ز
Geometry validity وGeometry properties وGeometry conditions )صئاصخو يسدنھلا لكشلا ةیحلاص 

 .)يسدنھلا لكشلا طورشو يسدنھلا لكشلا
 Check for overlaps smaller than (map units sqr.) رتخا )ةیجولوبوطلا قیقدت( Topology checks نم .ح

 0.0000 ةیضارتفلاا ةمیقلا كرتاو )عبرملاب ةطیرخلا تادحو( نع لقت يتلا تابكارتلا نم ققحت(
 قیسنتلا رتخا مث )ةدیدج تاقبط ءاشنإ( Create new layers ددح )ةجرخملا تاھجتملا تاقبط( Output vector layers نم .ط

 .ةدیدجلا ةقبطلل دیرت يذلا عقوملاو
 .قیقدتلا ةیلمع ءدبل )لیغشت( Run قوف رقنا .ي
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 Geometry check يف كلذو لودجلا يف تلاخادتلا ءاطخأ ضرعیو اًیئاقلت )جئاتنلا( Result بیوبتلا حتفی .ك
result section )ةیسدنھلا لاكشلأا قیقدت جئاتن مسق(. 

 ،)ىلإ طئارخلا ةحول لقنا ،فوفصلا دحأ دیدحت دنع( When a row is selected, move to canvas to مسقلا يف .ل
 .)ةددحملا ملاعملا طیحم لیلظت( Highlight contour of selected featuresو )أطخ( Error نیرایخلا دیدحت نم دكأت

 layers ةحول ىلإ overlapsEAs_ toclean_3460 مسا تحت ةدیدج ةقبط فاضت قیقدتلا ةیلمعل ةجیتن
 .)تاقبطلا(

  overlapsEAs_toclean_3460 ةقبطلا مدختسنس . EAs_toclean_3460 لفسأ دیدجلا ةقبطلا هذھ عض .م
 .EAs_toclean_3460 ةقبطلا يف حیحصتلاو ریرحتلا ةیلمع يف انلزلا اننأ لاإ ،أطخلا عقوم دیدحتل

 .EAs_toclean_3460 ةقبطلل            ریرحتلا ةسلج لّعف .ن
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 عقوملا ىلإ ةطیرخلا برقت .لودجلاب فوفصلا دحأ قوف رقنا ،)ةیسدنھلا لاكشلأا قیقدت( Check Geometries ةحوللا نم ،اھدعب . س

 .ءارمح ةرئادب ھتطاحإو رفصلأا نوللاب ھلیلظت عم ،لخادتلا أطخل حیحصلا

 مدع وأ سوؤرلا نم يأ بایغ مدع نم دكأتلاو دودحلا ةاذاحمل اھضعب فذحاو ممقلا ضعب ئشنأ ،)سأرلا ةادأ( Vertex Tool مادختساب .ع

 .بكارتلا ءأطخأ ثودح بابسأ مھأ دحأ وھو .دحلا لوط ىلع ھتكراشم
 دودحلا دنع تابكارتلاو تاغارفلا ءاطخأ نم ریثكلا طبارتل كلذ ،تابكارتلا ءاطخأ جلاع يف ءدبلا لبقً لاوأ تاغارفلا لك ةلازإ لضفلأا نم .ف

 .تاعلضملا نیب

 . قوف رقنلاب كلذو رارمتساب ةقبطلا ىلع اھلخدت يتلا تارییغتلا ظفح سنت لا .ص

 اھنع مجنی دق ةیجولوبوطلا ءاطخأف .اھب ءاطخأ يأ جلاعو ةقبطلا ةیجولوبوط نم ققحتلاب يصون ،تاعلضملا تاقبط نم ةقبط يأ ىلع لمعلا لبق

 .تاقبطلا يف اًدیقعت رثكأ تٍایلمع ذیفنت ءانثأ رھظت تلاكشملا نم ریثكلا

 لوادجلا طبر 6.2

 رئاودلا دودحب صاخلا shapefile فلم لمحن ً،لاوأ .shapefile فلمب اھطبرن مث نمو لوادجلا دحأ نم ةیجراخ تٍانایب بلجنس ،مسقلا اذھ يف

 .نامیلس رزجل ةیباختنلاا

 .    قوف رقنلاب QGIS ـب اًدیدج اعًورشم وأ ةدیدج ةسلج حتفا  .أ

 polygon_layers_advanced/layers/Sol_Ward_4326.shp_6 لمّح .ب

 ةیباختنلاا رئاودلا ءامسأو داوكلأا اھنیب نمو ،اھمضی يتلا تامولعملا نم ققحتو    )تامسلا لودج( Attribute table حتفا .ج

 .میلاقلأا وأ تاعطاقملاو
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 لوادجلا لك ظفح يغبنی ھیلعو .xlsx. وأ xls. دادتما تاذ تافلملا ةءارق ھنكمی لا ھنأ ىلإ ھبتنن نأ انل يغبنی ،QGIS لخاد لوادجلا داریتسا دنع

 ىلع 2009 دادعت نم ةیحصلا قفارملاو هایملا دراوم تانایب يوحی هداریتسا انل ررقملا لودجلاو .CSV (MS-DOS) قیسنتب Excel لخاد

 .ةیباختنلاا رئاودلا ىوتسم

 . قوف رقنا وأ)تانایبلا رداصم ریدم > ةقبطلا( Layer > Data Source Manager ىلإ لقتنا . د

 .)ددحم صن( Delimited Text مسقلا ىلإ لقتنا .ـھ 

 polygon_layers_advanced/tables/solomon_ data.csv_6 رتخا ،)لقحلا مسا( File Name نم  .و
 .)لصاوفب ةلوصفم میقCSV (comma separated values ) رایخلا ددح ،)فلملا قیسنت( File Format نم .ز

 .)يسدنھ لكش نودب( No geometry رایخلا ددح ،)يسدنھلا لكشلا فیرعت( Geometry Definition نم .ح

 ضرعی .)ةفاضإ( Add قوف رقنا مث نمو میلسلا وحنلا ىلع تانایبلا ةنیاعم روھظ نم دكأتتل )تانایبلا ةنیع( Sample Data عجار .ط
 .)تاقبطلا( Layers ةحول نمض لودجلا

 .انیدی نیب يتلا ةقبطلا ىلإ ةدیدج لوقح ةفاضإ نعً لاضف shapefile فلم تامس لودج ىلإ يجراخلا لودجلا بلجنس ةلحرملا هذھ يف

 .)طباور( Joins مسقلا ىلإ لقتنا مث ،)ةقبطلا صئاصخ( Layer Properties ةحول نم Sol_Ward_4326.shp حتفا .ي
 .)ھجتم طبار ةفاضإ( Add Vector Join ةمئاقلا حتفل قوف رقنا ك
 solomon_data رتخا ،)طابترلاا ةقبط( Join layer نم .ل

 Code رتخا ،)طابترلاا لقح( Join field نم .م
 WID رتخا ،)فدھتسملا لقحلا( Target field نم .ن

 يفو .تامسلا لودج ىلإ solomon_data لودجلا نم اھلقن دوت يتلا لوقحلا ددح ،)اھطبر دارملا لوقحلا( Joined Fields نم .س
 .ةقبطلا يف نیجردم امھنوكل Warda و Code يلقح ادع لوقحلا لك ددحنس بیردتلا اذھ

 .)لقحلا مسا ةئداب صیصخت( Custom Field Name Prefix يف اًیضارتفا رھظت يتلا صوصنلا لك لزأ .ع
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 .ةدیدجلا لوقحلا ةفاضإ نم دكأتلل )تامسلا لودج( Attribute Table عجارو )قفاوم( OK قوف رقنا .ف

 عم ةقبطلا ظفحل جاتحن ،تاقبطلا تامس لودج نمض ةمئاد ةفصب لوقحلا ظفحلو .ةتقؤمً لاوقح لوقحلا هذھ دعت ةظحللا هذھ ىتح ھنأ ظحلا

 .دیدج shapefile فلمك قفرملا لودجلا
 ظفح > ریدصت( Export > Save Features As رتخا مث نمو ةقبطلا قوف نمیلأا ةرأفلا رزب رقنا .ص
 …)مساب ملاعملا

 مساب ةقبطلا هذھ ظفحنسو .)قفاوم( OK قوف رقنا مث نمو اھعقومو ةدیدجلا ةقبطلا مسا لخدأ
Sol_ward_censusdata.shp 
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 :لوقحلا ةبساح 6.3
 ةیساسلأا تاریبعتلا

 يتلاو ةیحصلا قفارملاو هایملا دراوم تارشؤم يوحت يتلا لوادجلا زیھجتو لوادجلا نم ةدراولا تانایبلا ةجلاعمل لوقحلا ةبساح مدختسنس ،مسقلا اذھ يف

 .)ةیوئملا بسنلا وأ تلادعملا عم زیمرتلا اذھ مادختسا نم دب لا( ينوللا زیمرتلا وأ جردتلا مادختساب ةطیرخلا ىلع اھعیزوت نكمی

 polygon_layers_advanced/layers/Sol_Ward_ CensusDatatest_4326.shp_6 لمح  .أ

 ىلإ لوصولا لدعم ىلإ نكاسملا ةبسن :)WASH( ـب فرعت ام يھو ةماعلا ةفاظنلاو ةیحصلا قفارملاو هایملا تارشؤم ئشننس ،ةدراولا لوقحلا مادختساب

 بیبانلأا ربع ةلوقنملا هایملا رابتعلااب عضنس بیردتلا اذھلو .ةنملآا ةیحصلا قفارملا ىلإ لوصولا لدعم ىلإ نكاسملا ةبسنو ةنملآا برشلا هایم رداصم

 دحأ وھ انیدی نیب يذلا بیردتلا اذھ .ةنملآا ضاحرملا قفارم نم هایملاب فیظنتلاو درطلا تانازخ ربتعت امیف .ةنملآا برشلا هایم رداصم نم هایملا تانازخو

 دنع اًدیقعت رثكأ دعت )WASH( ةماعلا ةفاظنلاو ةیحصلا قفارملاو هایملل ةینفلا تارابتعلاا نأ كردن نحنو ةیبیردتلا ةیفارغجلا تامولعملا مظن تاسرامم

 .ا¿یلباقتً لایلحت اھرابتعاب بیردتلا اذھ نم ةاقتسملا جئاتنلا ىلإ رظنلا يغبنی لا ھیلعو .ةنمآ ریغ /ةنمآ اھرابتعاب يحصلا فرصلا قفارمو هایملا دراوم فینصت
 .)ةبساحلا( Calculator  حتفل           قوف رقنا مث)تامسلا لودج( Attribute Table حتفا .ب
 .)دیدج لقح ءاشنإ( Create a new field رایخلا ددح .ج
 safe_water :بتكا ،)جرخلا لقح مسا( Output field name لخاد .د
 .)"يقیقح" يرشع ددع( Decimal Number (real) رتخا ،)جرخلا لقح عون( Output field type نم .ه

 وأ %20.25 لثم بسن ىلع لمعن( 2 ىلع )ةقدلا( Precision طبضاو ،3 رتخا ،)جرخلا لقح لوط( Output field length نم .و

 .)كلذ نم لوطأ لسلاس دوجو عقوتن لا اذل ،100.00%
 )to_int /( to_int( "piped_w" ) + to_int( "tank_w" )) :ةیلاتلا ةغیصلا بتكا ،)ریبعتلا( Expression ةحول نم .ز

"tot_HH" ) * 100 

 لغشم ةفاضإ انل يغبنی ،( piped_w" + "tank_w" / "tot_HH" * 100" ( ةبسنلا باسحب ةصاخلا ةغیصلا يف ھنأ ظحلا
to_int )جمدی ،لسلاسلا قیسنت تاذ لوقحلا مادختسا دنعو .)فرحأ ةلسلس( لسلاسلا قیسنتب يتأت لوقحلا نلأ كلذ )حیحص ددعل لیوحتلا 

 .اھیلإ علطتن يتلا ةجیتنلا يھو ،)135 = 83 + 52( ةیضایرلا ةلداعملا باسح نمً لادب )5283 = 83 + 52( فرحلأا + لغشم

 :ةیلاتلا ةغیصلا مادختسا عم اھتاذ تاوطخلا عبتا ،safe_toile لقحلا جارختسلا .ح
(to_int( "flush_t" ) + to_int( "wtrseal_t" ) )/ to_int( "tot_HH" ) *100 

 قوف رقنلاب كلذو رارمتساب shapefile فلم ىلع اھلخدت يتلا تارییغتلا ظفح سنت لا .ط

 تلاكشملا وأ لئاسملا لحل دحاو بولسأ ةمث سیلف .shape file فلمب ھطبرو QGIS ىلإ لودجلا دیروت مث Excel لخاد تاباسحلا هذھ ذیفنت نكمملا نم 

 راھظإ وھ بیردتلا اذھ نم يساسلأا فدھلا نأ سنن لاو .ماھملا ءاھنإ يف صاخلا ھبولسأ دجیس مدختسم لكف ،ةیفارغجلا تامولعملا مظن يف
 .)تامسلا لودج( Attribute Table لخاد ةدیدج تٍامولعم جارختسا ةیناكمإ

 

 .ةقباسلا لوصفلا يف ھتملعت ام بسح اجًردتم ازًیمرت امًدختسم safe_toile و safe_water تارشؤم طئارخ مسر لواح نلآاو
 يحصلا فرصلاو هایملا دراومو قفارم نیسحت يغبنی يتلا قطانملا فادھتسا ءانثأ رارقلا عانصو نیططخملل ةبسنلاب ھتیمھأ ھل طئارخلا نم عونلا اذھو

 .اھیف ةماعلا ةفاظنلاو
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 تامسلا لوادج مادختسا 6.4

 Attribute Table مادختسابو .)تاعلضملا لخاد طاقن ،لاثملا لیبس ىلع( ةیناكملا طورشلا مادختساب ملاعملا دیدحت ةیفیك ةقباسلا لوصفلا يف انملعت 
 لودج مدختسن اننأ ول امك ،اھنیب نم رایتخلااو لقح لك تانایب حیشرت وأ زرفل ةیقطنم تٍاریبعت مادختسا اننكمی ،)تامسلا لودج(
 .)spreadsheet( تانایب

 .)تامسلا لودج( Attribute Table نم حیشرتلاو ءاقتنلاا تاودأ مادختسا ةیفیك نیبن ةیلاتلا ةلثملأا يفو
  



 )مدقتملا تاھجتملا لیلحت( دادعتلا قطانم :تاعلضملا تاقبط | QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر

 

108 

 
 polygon_layers_advanced/layers/Sol_ward_Data.shp_6 لمح .أ

 نلآا رھظی tot_HH لقحلا نأ ظحلا .Sol_ward_Data.shp ـب صاخلا )تامسلا لودج( Attribute table حتفا .ب
 نم كلذ نم ققحتلاب وأ نیمیلا ىلع ماقرلأا ةاذاحم ببسب كلذو ةلوھسب كلذ دیدحت اننكمی( ةحیحص دادعأ ةئیھ ىلع
 .)"ةقبطلا صئاصخ" Layer Properties ةحوللا نم )ردصملا لوقح( Source Fields مسقلا

 وأ/و ةددحملا ملاعملا ددع حضوتً ةلاسر ةحوللا ىلعأ حملن ھتاذ تقولا يفو .قرزلأا نوللاب فصلا للظیسو ملعم دیدحتل طخ لك. قوف رقنا .ج

 .ةحشرملا
 .رخلآا ولت اًدحاو يلاحلا رایتخلال رصانع ةفاضإ اننكمی رقنلا + CTRL ىلع طغضلاب .د

 .هدیدحت دیرن رصنع رخآ ىتح دیدحتلا دیدمت اننكمی رقنلا + SHIFT ىلع طغضلابو .ـھ
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f. ةددحملا ملاعملا لك دیدحت ءاغللإ  قوف رقنا. 

g. دیدحتلا سكعل  قوف رقناو. 

h. قوف وأ لودجلل رسیلأا يولعلا بناجلا قوف رقنلا كنكمی ،ملاعملا لك دیدحتل . 

i. ةددحملا رصانعلا ىلإ طئارخلا ةحول برقتسو  قوف رقنا ،ةطیرخلا ىلع ةددحملا ملاعملا راھظلإ. 

 ،)ریبعتلا( Expression لخاد .)ریبعتلا بسح دیدحت( Select by Expression ةحوللا حتفل  قوف رقنا 
 :يلاتلا يساسلأا ریبعتلا بتكا

 "PName" = 'Choiseul' 

 .)قلاغإ( Close قوف رقنا مث ،)ملاعملا دیدحت( Select features قوف رقنا اھدعب

j. ةعطاقمل ةعباتلا ةیباختنلاا رئاودلا لك دیدحتب انمق اذكھ .ةطیرخلا ىلع دیدحتلا ةجیتن ریبكتل   قوف رقنا Choiseul. 

k. ـب ةصاخلا ةیباختنلاا رئاودلا ةفاضإ اندرأ اذإو Guadalcanal، ةحوللا ىلإ لقتنن Select by Expression )بسح دیدحت 
 .  )ریبعتلا

l. يلاتلا ریبعتلا بتكا: "PName" = 'Guadalcanal' 

m. رزلل رواجملا مھسلا ىلع طغضا Select features )رایخلا ددح مث نمو )ملاعملا ددح Add to current 
selection )يلاحلا دیدحتلا ىلإ فضأ(. 
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 .قباسلا دیدحتلا ىلإ دیدحتلا اذھ فاضی

 هذھ ءارجلإو .نكسم 1000 نع نكاسملا ددع دیزی ثیحو %50 نع ةنمآ ضیحارمب عتمتت يتلا نكاسملا ةبسن اھیف لقت يتلا رئاودلا ددحنس نلآاو

 ریبعتلا ةباتكو )ریبعتلا بسح دیدحت( Select by Expression ةحوللا مادختسا كنكمی ً،لاوأ :نیتقیرط عابتا اننكمی ،ةوطخلا

 :يلاتلا

 "safejoile" < 50 and "tot_HH" >1000 

 مادختساب ملاعملا حیشرت/دیدحت( Select/Filter Features using form ةادلأا مادختسا كنكمی ،ریبعتلا مادختسا يف بغرت لا تنك نإ امأ
 .)غیصلا

 .ةمئاقلا حتفل       قوف رقنا مث )تامسلا لودج( Attribute table حتفا .أ

 .نیمیلا ىلع مكحتلا رصنع مادختساب )نم ربكأ( )<) Greater than رایخلا ددحو 1000 بتكا ، tot_HH لقحلا يف  .ب
 .)نم رغصأ( )>) Less than رایخلا ددحو 50 بتكا ،safe_toile لقحلا يف .ج

 .ةددحملا رئاودلا ىلع فوقولل لودجلاو ةطیرخلا عجارو )ملاعملا دیدحت( Select features قوف رقنا .د
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 دودحلا ةباذإ  6.5

 .ةیباختنلاا رئاودلا ةقبط نم میلقلإا وأ ةعطاقملا ةقبط ئشننس لصفلا اذھ يف

 polygon_layers_advanced/layers/Sol_Ward_4326.shp_6 لمح .أ

 > ةیفارغجلا ةجلاعملا تاودأ > ھجتم( Vector > Geoprocessing Tools > Dissolve ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .ب

 .ةادلأا هذھب ةصاخلا ةمئاقلا رھظتسو ) ةباذإ
 Sol_Ward_4326.shp رتخا ،)لخدلا ةقبط( Input layer نم .ج

 .)تاعطاقملا دوك( pid  رتخا مث   قوف رقنا،)لقحلا ةباذإ( Dissolve field نم .د

 .(Sol_prov.shp لاثملا لیبس ىلع( اھمساو ةدیدجلا ةقبطلا عقوم ددح ،)باذم( Dissolved ةمئاقلا نم .ه

 تایوتسملا نیب ةیمرھلا ةقلاعلا ببسبو .تاعطاقملا لثمت ملاعم 10 دوجو ظحلتس تامسلا لودج تعجار اذإ .طیطختلا ةھجاو يف تاعطاقملا ةقبط ضرعت

 .ةباذلإا ةادأ مادختساب ایلعلا تایوتسملا ءاشنإ نكمی ،ایندلا ةیرادلإا تایوتسملا ةقبطب صاخلا تامسلا لودجب ةفلتخملا

 ةیناكملا ةمزحلأا ءاشنإ  6.6

 .رحبلا نم مك 1 نع لقی ام دعب ىلع عقت يتلا قطانملا مضیو مك 1 ةفاسم ىلع يلحاس طخ ءاشنإ ةیفیك لصفلا اذھ يف ملعتن

a. ـب اًدیدج اعًورشم وأ ةدیدج ةسلج حتفا QGIS قوف رقنلاب . 

b.  6 لمح_polygon_layers_advanced/layers/DMA_Land_4326.shp 

c. ىلإ لقتنا ةیولعلا ةمئاقلا نم Vector > Geoprocessing Tools > Buffer )مازح > ةیفارغجلا ةجلاعملا تاودأ > ھجتم 
 .ةادلأا هذھب ةصاخلا ةمئاقلا رھظتسو )يناكم

d. نم Input layer )رتخا ،)لخدلا ةقبط DMA_Land_4326.shp 

e. لخادبو Distance )ءاوتسلاا طخ نم ةبیرقلا قطانملا يفو .تاجردلاب تادحولا لاخدإ ةرورض ىلإ ھبتنن ،)ةفاسملا 
 .0.01 لخدن ،مك 1 ةفاسم ىلع يناكم مازح عضول ،ھیلعو .مك 111 ـب ةدحاولا ةجردلا ردقت

f. ملعملا مكحتی Segments )يناكملا مازحلا ضرع ءانثأ ةرئاد عبر نیوكتل تئشنأ يتلا طخلا عطاقم ددع يف )عطاقملا. 
 .عطقم 20 لخدنس بیردتلا اذھ يف .ةقد رثكأ وٍحن ىلع جتانلا يناكملا مازحلا مسری ،ةمیقلا تعفترا املكو 

g. لخاد Buffered )مازحب طاحم(، قوف رقنا مث نمو ةتقؤم ةقبط ءاشنلإ ةیضارتفلاا ةمیقلا كرتا Run )لیغشت(. 
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 Buffered ةقبطلا دوجو نم دكأتتل )تاقبطلا( Layers ةحول نم تاقبطلا زرف برج ،هلاعأ ةنیبملا مازحلا ةقطنم رھظت مل اذإ .ح
 DMA_ Land_4326.shp لفسأ )مازحب ةطاحملا(
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 1 ةفاسم ىلع يلخاد طخ ءاشنإ وھ بیردتلا اذھ نم دصقلا نإ .رحبلا هاجت مك 1 يلاوحب علضملا ةحاسم ىطختی حطس وھ ةقیقحلا يف هانأشنأ امف

 ىلع كدعاسی تاوطخلا يف عباتتلا اذھ نأ لاإ ،ةمھملا هذھ ذیفنتل عرسأ قرط ةمث ھنأ مغرو .هاندأ ةنیبملا تاوطخلا عبتا ،ضرغلا اذھ قیقحتلو .مك

 .QGIS يف ةحاتملا ةیساسلأا ةجلاعملا تاودأ ىلع رثكأو رثكأ فرعتلا

 طوطخ ىلإ تاعلضملا لیوحت

 .طوطخ ةقبط ئشنتو تاعلضملا ةقبط ذخأت ةیمزراوخلا هذھ

 .طخلا يبناج ىلع يناكملا مازحلا أشنی ،ةیطخ ةقبط ىلع يناكملا مازحلا ةادأ قیبطت دنع ھنلأ كلذ .طخ ىلإ تاعلضملا ةقبط لیوحت ىلإ جاتحن ً،لاوأ

a. ىلإ لقتنا ،ةیولعلا ةمئاقلا نم Vector > Geometry Tools > Polygons to Lines )ةیسدنھلا لاكشلأا تاودأ > ھجتم 
 ...)طوطخ ىلإ تاعلضم >

b. نم Input layer )رتخا ،)لخدلا ةقبط DMA_Land_4326.shp 

c. لخاد Lines )طوطخ(، قوف رقنا مث نمو ةتقؤم ةقبط ءاشنلإ ةیضارتفلاا ةمیقلا كرتا Run )لیغشت(. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 طوطخلا ةقبط لوح مك 1 ةفاسم ىلع مازح ءاشنإ

 )يناكم مازح > ةیفارغجلا ةجلاعملا تاودأ > ھجتم( Vector > Geoprocessing Tools > Buffer ىلإ لقتنا ةیولعلا ةمئاقلا نم .أ
 .ةادلأا هذھب ةصاخلا ةمئاقلا رھظتسو

 )طوطخ( Lines رتخا ،)لخدلا ةقبط( Input layer نم .ب

 0.01 لخدأ ،)ةفاسملا( Distance يف .ج
 

 .عطقم 20 لخدأ ،)عطاقملا( Segments يف .د

 هذھ نأ ظحلا( .)لیغشت( Run قوف رقنا مث نمو ةتقؤم ةقبط ءاشنلإ ةیضارتفلاا ةمیقلا كرتا ،)مازحب طاحم( Buffered لخاد .ـھ

 )قئاقد عضب قرغتست دق ةیلمعلا
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 مازحلا نم ءزج عاطقتسا 

 ةقبطلا عم ةیلاحلا مازحلا ةقطنم "عطق"ـب موقنس ،ةیلمعلا هذھ ءارجلإو .مازحلا نم طیحملل ھجاوملا ءزجلا لیزنس ،ةوطخلا هذھ يف
DMA_Land_4326.shp. 

 .)عطق > ةیفارغجلا ةجلاعملا تاودأ > ھجتم( Vector > Geoprocessing Tools > Clip ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .أ
 .ةادلأا هذھب ةصاخلا ةمئاقلا رھظتسو

 .ةقباسلا ةوطخلا يف ةیطخلا ةقبطلا نم أشنملا مازحلا ددح ،)لخدلا ةقبط( Input layer نم .ب

 DMA_Land_4326.shp رتخا ،)لخادتلا ةقبط( Overlay Layer نم .ج
 .،لاثملا لیبس ىلع( ھب صاخلا فلملاو مك 1 ةفاسم لغشی يذلا يلحاسلا مازحلا مسا ددح ،)عطقم( Clipped نم .د

1kmBuffer_4326.shp). 
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 .هاندأ ةنیبملا ةروصلا يف رضخلأا نوللاب ةضورعملا ةقبطلل ةھباشم ةجیتن جورخ نم ققحتتل طئارخلا ةحول عجارو )لیغشت( Run قوف رقنا .ـھ
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 سرادملا - نكاسملاب ةطیحملا ملاعملا برقأ ىلع روثعلا  6.7

 يف ةسردم برقأ ىلإ )ةیئاوشع ةفصب عقاوملا هذھ تئشنأ( نكسم لك عقوم نم ةفاسملا بستحنس .نیتطقن نیب ةفاسملل لیلحت ءارجإ ةیفیك لصفلا اذھ يف ملعتن

 .ةعطاقملا هذھ يف سرادملا ىلإ لوصولا ةلوھس ىدم مییقت يف ةیلمعلا هذھ نع ةجتانلا ةقبطلا اندعاست .)قیبمزوم( ازاج ةعطاقم
 .غراف دیدج عورشم حتفل  قوف رقنا .أ

 ,polygon_layers_advanced/layers/MOZ_GazaProv_4326 shp_6 لمح .ب

6_polygon_layers_advanced/layers/Roads_Gaza_4326.shp, 

 6_polygon_layers_advanced/layers/Households_4326.shp و 

6_polygon_layers_advanced/layers/Schools_4326.shp 

 .قرطلاو تاعطاقملا تاقبط ىوتسم ىلع ساردملاو نكاسملا ضرع نم دكأتلل )تاقبطلا( Layers ةحول يف ةدوجوملا تاقبطلا زرفا .ج

 Processing Toolbox ةحول حتفل )تاودلأا قودنص > ةجلاعملا( Processing > Toolbox ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .د
 .)ةجلاعملا تاودأ قودنص(

 تاودلأا حشرت مث نمو hub distance بتكا ،)ةجلاعملا تاودأ قودنص( Processing Toolbox ةحول ىلعأ ثحبلا طیرش لخاد .ه

 .ةحاتملا تارایخلا نیب نم ةقباطملا

 .)"طاقن" زكرم برقأ ىلإ ةفاسملا( Distance to Nearest Hub (Points) قوف رقنا .و

 .Households ةقبطلا ددح ،)رداصملا طاقن ةقبط( Source points layer نم .ز

 . Schools ةقبطلا ددح ،)تاھجولا زكارم ةقبط( Destination hubs layer نم .ح

 .OBJECTID لقحلا رتخا ،)زكرملا ةقبط مسا ةمس( Hub layer name attribute نم .ط

 .)راتمأ( Meters رتخا ،)سایقلا ةدحو( Measurement unit نم .ي
 .(HH_Dist2School .لاثملا لیبس ىلع( اھمساو ةدیدجلا ةقبطلا عقوم بتكا ،)زكرملا ىلإ ةفاسملا( Hub distance لخاد .ك
 )قئاقد عضب قرغتست دق ةیلمعلا هذھ نأ ظحلا( .ةیلمعلا هذھ ءاھنإ روف )قلاغإ( Close مث نمو )لیغشت( Run قوف رقنا .ل
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 زییمت زیمرتلا مادختساب اننكمی ،ةلحرملا هذھ يفو .ةسردم برقلأ ةلصافلا ةفاسملا يوحی اًدیدجً لاقح تفاضأ امك نكاسملا ةقبط نم ةخسن ةادلأا هذھ تأشنأ

 .سرادملا نم اھبرق بسح قطانملا فلتخم

 Layer ةحوللا حتفا مث ،)تاقبطلا( Layers ةحول نم (Hub distance مسلااب رھظتس اًبلاغ( HH_Dist2School ةقبطلا رتخا .أ
Properties )ةقبطلا صئاصخ( ىلإ لقتناو Symbology )زیمرتلا(. 

 .)جردتم( Graduated رایخلا ددح ،ایلعلا ةلدسنملا ةمئاقلا نم .ب

 .HubDist لقحلا رتخا ،)ةمیقلا( Value نم .ج

 .)يفیط( Spectral رایخلا انددح لاثملا اذھ يفو .امًئلام هارت يذلا رایخلا ددح ،)ينوللا جردتلا( Color ramp نم .د

 .)فینصت( Classify قوف رقنا مث )ةیواستم تارتف( Equal interval ددح ،)عضولا( Mode نم .ه

 .سكعلا دیرن اننكلو ،رمحلأا نوللاب برقلأاو قرزلأا نوللاب دعبلأا تافاسملا لیثمت ظحلاتس

 حبصأ نلآاو .)ينوللا جردتلا سكع( Invert Color Ramp ددح مث نمو )ينوللا جردتلا( color ramp رزلا قوف نمیلأأ ةرأفلا رزب رقنا .و
 .ةیقطنم رثكأ زیمرتلا

 .مھیلإ لوصولا ةلوھسل حاضیلإا لئاسو وأ ةطیرخلا حاتفمو فینصتلا تاقاطن "فیظنت" ىلإ جاتحن ،لضفأ وٍحن ىلع تانایبلا لیثمتلو
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 .مك 4.82 لثم میق نع اھركذتو مك 5 لثم میق ةءارق لھسلا نم نوكی امً ةداعف 

 وأ ةطیرخلا حاتفم ىلع ضرعت يتلا میقلاو ةئفلا طباور لیدعتل )ةطیرخلا حاتفم( Legends و )میقلا( Values نم لك قوف اجًودزم ارًقن رقنا .ز
 .)قفاوم( Ok قوف رقنا مث .حاضیلإا لئاسو

 .عاطتسملا ردق نكاسملا نع اھزییمتل كلذو ساردملا ىلإ ةراشلإل اًیناكم ازًمر مدختسا  .ح

 .طئارخلا ةحول ىلع جئاتنلا نم ققحت مث )قفاوم( OK قوف رقنا .ط
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 طئارخلل تمتؤملا جاتنلإا  7

 دنع لاحلا وھ امك ،ةلثامملا طئارخلا نم ریبك ددع جاتنإ دنع اھنع ىنغ لا ةمس يھف .QGIS جمانربل ةبسنلاب طئارخلل ةیللآا جاتنلإا ةادأ وھ سلطلأا

 .دادعتلا يبودنمل ةینادیملا طئارخلا جاتنإ

 تاعوضوملا راركت مدع لجأ نم يساسلأا قیسنتلا نییعت لعفلاب مت ثیح Atlas. qgz مساب ةقبسم ةئیھتب عورشمب لصفلا اذھ يف أدبتس

 .ةقباسلا لوصفلا يف اھلوانت مت يتلا

 .تابوعص يلأ كتھجاوم لاح يف كداشرلإ ةیبیردتلا داوملا دلجم يف AtlasResult. qgz مساب عورشم عضو مت ،لصفلا دیقعتل ارًظن

 .لصفلا اذھ يف ةمدقملا تابیردتلل طیطختلا جئاتن لك عورشملا مضیو

 ةیساسلأا ةئیھتلاو سلطلأا طیطخت  7.1

 راطإ ةقبطو )HH( نكاسملا عقاوم لیمحت مت دق ھنأ ظحلا .automated_map/Atlas.qgz_' عورشملا حتفل  قوف رقنا .أ

 .طئارخلا مسر ةحول يف )AE( دادعتلا قطانم لمع

 رذعت اذإ .طئارخلا ةحول يف يعانصلا رمقلا ةروص ةیفلخو HH_atlas_4326.shpو EA_atlas_4326.shp لیمحت نم ققحت .ب

 (XYZ تاعبرم( XYZ tiles طئارخلا ةمدخ نم ةیفلخلاو automated_map/Layers_7 دلجم نم تاقبطلا لیمحتب رداب ،كلذ
 . )ضرعتسملا( Browser ةحول يف ةنئاكلا

 ةیطغتلا ةقبط نإف ،دادعتلا قطانم نم ةقطنم لكل ةطیرخ جاتنإ يف بغرن اننأ امبو .طئارخلا جاتنإ يف مكحتت اھرودب يتلاو ةیطغت ةقبط سلطلأا بلطتی

 للاخ نم كنكمی .اًیئاقلت طئارخلا جتنیو دادعتلا قطانم نم ةقطنم لكل "ةروص طقتلیس" سلطلأا نأب ينعی اذھو .EA_atlas_4326.shp نوكتس

 .تافلملا ءامسأ نییعتو اھتعابط متیس يتلا روصلا دیدحتل حشرمو اًیئاقلت نیوانعلا ةفاضإ ةیطغتلا ةقبط تامس لودج

 ضرعُتس . Atlas_ landscape طیطخت حتفاو )تاطیطختلا> عورشملا( Project > Layouts ىلإ لقتنا ،يولعلا طیرشلا نم .ج

 .ناونعلاو ةطیرخلا ةحول كلذ يف امب ،يساسلأا طیطختلا ةئیھت عم )طیطختلا( Layout ةھجاو

 امإ كنكمی ،اًیئاقلت اھروھظ مدع ةلاح يف.طیطختلل ةفلتخم مئاوق دجوت ثیح ةھجاولا نم نمیلأا بناجلا يف )سلطأ( Atlas ةمئاق رھظت نأ بجی .د

 .)سلطلأا تدادعإ > سلطأ( Atlas > Atlas settings  ىلإ لاقتنلاا وأ  قوف رقنلا

 .)سلطأ ءاشنإ( Generate an atlas مامأ ةملاع عض ، )سلطأ( Atlas ةمئاق يف .ه

 .اھمسر يف بغرن يتلا تاعلضملا يوحت يتلا ةقبطلا يھ هذھ نأ امب ،EA_atlas_4326 ددح ،)ةیطغتلا ةقبط( Coverage layer نم .و

 .طئارخلا ىلع دادعتلا قطانم دودح ضرع ىلإ ةجاحب اننلأ ارًظن ،)ةیفخلا ةیطغتلا ةقبط( Hidden coverage layer رایخلا ددحت لا .ز

 .دادعتلا قطانم داوكأ مادختساب ةحفصلا ءامسأ نییعتل eaid لقحلا ددح ،)ةحفصلا مسا( Page name يف .ح

 .يلاحلا تقولا يف دیدحت نودب )مادختساب حیشرت( Filter with رایخ كرتا .ط

 .دادعتلا ةقطنم دوك مادختساب طئارخلا زرفل eaid لقح ددحو )بسح زرف( Sort by رایخلا ددح .ي

 Single file export when دیدحت غلا .ك
possible )يلاتلا لخدأو يضارتفلاا ریبعتلا فذحا        قوف رقنا ،)نكمأ نإ دحاو فلم ریدصت: "eaid" 

 طئارخلا ةیمستل ةمدختسملا میقلا نوكت نأ بجی .ةروصلا قیسنت ىلإ سلطلأا ریدصت دنع فلم مساك دادعتلا ةقطنم دوك نییعت ىلع اًیئاقلت دادعلإا اذھ لمعیس

 .ریدصتلا ةیلمع للاخ ةرركملا تافلملا ءامسأ تاذ طئارخلا زواجت متیس لاإو ،ضعبلا اھضعب نع ةدرفتم

 jpeg.و Jpg .اھریدصت مت يتلا طئارخلل بولطملا قیسنتلا ددح ،)ةروصلا ریدصت قیسنت( Image export format نم .ل

 .اعًویش رثكلأا يھ png.و

  .م
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 Controlled رایخلل لصت ىتح لفسلأ ررم . )رصنعلا صئاصخ( Item Properties ةمئاق ىلإ لقتناو ةطیرخلا ددح ،طئارخلا ةحول نم .م

by Atlas )هددحو )سلطأ ةطساوب مكحتلا. 

 %10 ىلع اھنّیعو )ملعملاب طیحملا شماھلا( Margin around feature ددح .ن

 .)سلطأ تاودأ طیرش( Atlas Toolbar نیكمتل  قوف رقناو ةیولعلا ةمئاقلا ىلإ لقتنا .س
  .طئارخلا فلتخم نیب امیف لقنتلل  رارزأ مدختسا

  تاملعم ةئیھتب لعفلاب انمق دق اننأ امب ،ةفلتخملا دادعتلا قطانم ىلإ ةرشابم لاقتنلاا اننكمی  تاحفصلا ضرع مادختساب
Page name )ةقیرطلا هذھب )ةحفصلا مسا. 

 . قوف رقنلاب رارمتساب عورشملا يف تارییغت يأ ظفح نم دكأت .ع

 هذھ يفو .دادعتلا قطانم نم ةقطنم لكل ةطیرخ لمعب موقی نأ دادعتلا ةقطنم لمع راطإ ربع ھلقنت ءانثأ ھنأ نمضن اننإف ،هذھ ةیساسلأا سلطلأا ةئیھت مادختساب

 .سایقملاو ةریزجلا مساو دادعتلا ةقطنم دوك ؛لثم ،اھل ةطیرخ مسر متی يتلا ةقطنملاب ةقلعتملا تامولعملا نم دیزملا ریفوتل طیطختلا نیسحت ىلإ جاتحن ،ةلحرملا

 .ةیطغتلا ةقبط تامس لودج نم ةدافتسلاا للاخ نم اًیكیمانید نیوانعلا فلتخم رییغت سلطأ ملعمل نكمی

 ةیللآا نیوانعلا

 .ناونعلا عضول ررقملا ناكملا يفً لایطتسم مسرا . قوف رقناو )طیطختلا ةھجاو( Layout Interface ىلإ لقتنا .أ
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 . )رصنعلا صئاصخ( Item Properties ةمئاق ىلإ لقتناو طیطختلا ةحول يف ناونعلا راطإ رایتخا نم دكأت .ب

 :يلاتلا لخدأو )ریبعت لاخدإ( Insert an Expression قوف رقنا ،)ةیساسلأا صئاصخلا( Main Properties نم .ج

'EA Code: '||"eaid" 

 .احًوضو رثكأ ناونعلا لعجل مجحلا ةدایز عم اضًیرع ھلعجاو نوللا رییغت للاخ نم صنلا طخ نّیع .د

 .ةطیرخلا ىلع ةلثمملا دادعتلا ةقطنم عم EA دوك قباطت نم ققحتلل   مادختساب طئارخلا نیب لقنت .ه

 / '|| "Village name: '|| "v_name' :يلاتلا ریبعتلا مادختساب دیدج يصن عبرم ةفاضإب ةیرقلاو ةریزجلا ءامسلأ ةیللآا نیوانعلا لخدأ .و
Island name: '||"i_name" 

 ریشت امنیب ،صنلا ىلإ ةراشلإل ' ةدرفملا سابتقلاا تاملاع مدختستو .تاریغتملا وأ صنلا طبرل || زمرلا مدختسی ،ةغللا يف QGIS تاریبعتل ةبسنلاب ھنأ ركذت

 .تامسلا لودج نم لوقح ىلإ " ةجودزملا سابتقلاا تاملاع

 يللآا سایقملا طیرش

 .ناونعلل ررقملا ناكملا يفً لایطتسم مسرا  . قوف رقناو)طیطختلا ةھجاو( Layout Interface ىلإ لقتنا .ز
 .)تادحولا( Units ةیعرفلا ةمئاقلا حتفاو )رصنعلا صئاصخ( Item Properties ةمئاق ىلإ لقتنا .ح

 ،)تادحولل ةیمستلا( Label for Units يفو )تارتمولیكلا( Kilometers رایخ ددح ،)سایقملا طیرش تادحو( Scalebar Units نم .ط
 km بتكا

 طبضاو )عطقملل بسانملا ضرعلا( Fit segment width رایخ ددح ،راطلإل رصنعلا يطخت مدع نامضلو ،يكیمانید سایقملا طیرش نأ امب .ي

 .ملم 100و 50 نیب مجحلا
 .ملم 100 ىلع راطلإا )ضرع( Width طبضاو )مجحلاو عضوملا( Position and Size ىلإ لقتنا مث .ك
 .لمعی يكیمانیدلا سایقملا طیرش نأ نم ققحتلل              مدختسا .ل
 مسقلا يف طیطختلاو عورشملا سفن ىلع لمعلاب رمتسنس          قوف رقنلاب رارمتساب عورشملا ىلع اھلخدت يتلا تارییغتلا ظفح نم دكأت .م

 .يلاتلا

 )سلطأ تاریغتم( سلطأ عم ةلعافتملاو دعاوقلا ىلإ ةدنتسملا طامنلأا  7.2

 .طئارخلا ةءارق ةیناكمإ نیسحتل سلطأ عم اھتنمازم متیس يتلاو )HH( نكاسملاو )EA( دادعتلا قطانم تاقبط نم لكل طامنأ نّیعنس ،مسقلا اذھ يف

 علضملا ةقبط طمن

 Symbology ىلإ لقتنا ،)ةقبطلا صئاصخ( Layer Properties ةحول نم .EA_atlas_4326 حتفاو ةیسیئرلا QGIS ةھجاو ىلإ دعُ .أ
 .)زیمرتلا(

 .ایلعلا ةلدسنملا ةمئاقلا يف )دعاوقلا ىلإ دنتسملا( Ruled-based رایخ ددح .ب

 Edit Rule ةحول حتفل   قوف رقناو اھددح وأ اًیلاح ةضورعملا ةدعاقلا قوف اجًودزم ارًقن رقنا .ج
 .)ةدعاقلا ریرحت(

 Selected EA :بتكا ،)ةیمستلا( Label يف .د

 atlas_featureid = $id@ :يلاتلا ریبعتلا لخدأو  قوف رقنا ،)حشرملا( Filter نم .ه

 .)قفاوم( OK قوف رقنا مث .و

 .حیحص وٍحن ىلع لمعت ةغیصلا نأ نم دكأتتل )رابتخا( TEST قوف رقنا .ز

 .)قفاوم( OK قوف رقناو يلاقترب دح طمنب ةفافش ةئبعت نّیع ،كلذ دعب .ح
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 ةدیدج ةدعاق ةفاضلإ  قوف رقنا .ط

 Not selected EA :بتكا ،)ةیمستلا( Label يف  .ي

 .)ىرخأ( Else رایخ عجار .ك

 .ةیلاقتربلا )ةطغضلا( Stroke عون سفنب طمنلا نیع .ل

 .%50 ىلع )ماتعلإا( Opacity طبضاو قرزلأا نوللابً لاظ ددح ،)ةئبعتلا( Fillـل ةبسنلاب .م

 بجی . Atlas_landscape طیطخت عم نمازت دق يطرشلا قیسنتلا نأ نم ققحتو تارییغتلا ظفحل ةیلاتلا مئاوق ثلاثلا يف )قفاوم( OK قوف رقنا .ن

 .ةفافش ھبش ءاقرز ةئبعتب ةددحملا ریغ دادعتلا قطانمو فافشلا ةئبعتلا قیسنت عم ةددحملا دادعتلا ةقطنم رھظت نأ

 ةیمست ضرع ىلإ جاتحن لا اننأب امًلع .ةطیرخلا ىلع طقف ةددحملا ریغ دادعتلا ةقطنم تایمست رھظت ثیحب دادعتلا ةقطنم تایمست لیدعت ىلإ جاتحن ،كلذ دعب

 بجح نم ةیمستلا عنمل كلذو ددحملا علضملا ىلع ةیمست عضو بنجتن اننإف ،كلذ ىلع ةولاع .ناونعلا يف اھضرع متیس ھنلأ ارًظن ةددحملا دادعتلا ةقطنم

 .تایمستلا نم اھریغ وأ نكاسملا عقاوم ؛لثم ،علضملا يف ةدوجوملا تامسلا

 .)تایمستلا( Labels ىلإ لقتنا ، )ةقبطلا صئاصخ( Layer Properties ةحول نم .EA_atlas_4326 حتفاو ةیسیئرلا ةھجاولا ىلإ دعُ .أ

 .ةدیدج ةدعاق ةفاضلإ  قوف رقناو )ةدعاق ىلإ ةدنتسملا ةیمستلا( Rule-based labelling رایخ ددح .ب
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 . )ةدعاقلا ریرحت( Edit Rule ةحول رھظتس ذئدنع
 .)قفاوم( OK قوف رقنا مث atlas_ featureid <> $id@ :يلاتلا ریبعتلا لخدأو  قوف رقنا ،)حشرملا( Filter نم .ج

 .حیحص لٍكشب لمعت ةغیصلا نأ نم دكأتتل )رابتخا( Test قوف رقنا .د

 .ةطیرخلا ةءارق ةیناكمإ نمضیس ام وھو ةقباسلا لوصفلا يف انلعف امك ةیمستلا قیسنت سفن نّیعو eaid لقحلا رتخا ،)ةمیقلا( Value يف .ه

 . )ةدعاقلا ریرحت( Edit Rule ةحول حتفل   قوف رقناو     ةدیدج ةدعاق ئشنأ .و

 Label with يف لقح يأ لخدن لا اننكل atlas_ featureid = $id@ :يلاتلا ریبعتلا لخدأو  قوف رقنا ،)حشرملا( Filter نم .ز
 .)قفاوم( OK قوف رقنا مث .ةیمست يأ ضرع مدع نم دكأتلل )ـب ةیمست(

 .عقوتملا بسح لمعی يطرشلا قیسنتلا نأ نم ققحتو ةیلاتلا ةبقاعتملا مئاوقلا يف )قفاوم( OK قوف رقنا .ح

 

 

 راھظإ يف طقف بغرن نحن ةلاحلا هذھ يف .دادعتلا ةقطنم تاعلضمب ةصاخلا كلتل ةلثامم تادادعإ ةئیھتب موقنس ،(HH( نكاسملاب ةصاخلا طاقنلا ةقبط طمنل

 ةقطنم يف ةدوجوملاو )1ـل اًیواسم ددحملا لقحلا اھیف نوكی يتلا طاقنلا( يضارتفلاا حسملا اذھل اھدیدحت مت يتلا طاقنلا :نیطرشلا نیذھ عابتاب اھتیمستو طاقنلا

 .سلطلأا ةطساوب ةددحملا دادعتلا
 .)زیمرتلا( Symbology ىلإ لقتنا ،)ةقبطلا صئاصخ( Layer Properties ةحول نم .HH_atlas_4326 حتفا .أ

 .ایلعلا ةلدسنملا ةمئاقلا نم )دعاوقلا ىلإ دنتسملا( Ruled-based رایخ ددح .ب

 ریرحت( Edit Rule ةحول حتفل   قوف رقناو اھددح وأ اًیلاح ةضورعملا ةدعاقلا قوف اجًودزم ارًقن رقنا .ج
 .)ةدعاقلا

 Selected HH :بتكا ،)ةیمستلا( Label يف .د

 :)HH( نكاسملا عقاوم ةقبط طورش ءافیتسلا ةیلاتلا ةغیصلا لخدأو  قوف رقنا ،)حشرملا( Filter نم .ه

"Selected" = 1 and intersects(@atlas_geometry, $geometry) 

 .حیحص لٍكشب لمعت ةغیصلا نأ نم دكأتتل )رابتخا( TEST قوف رقنا .و

 .يعانصلا رمقلا ةروص للاخ نم لضفأ لٍكشب ةیئرم طاقنلا لعجل طمنلا نّیع .ز

 .)قفاوم( OK قوف رقنا مث ، )ةدعاقلا ریرحت( Edit Rule ةحول حتفل  قوف رقنا  ةدیدج ةدعاق ئشنأ .ح

 .HH فرّعم ضرعت يتلا ةیساسلأا تایمستلا نییعت ىوس جاتحت لاف ،ةطیسب تایمستلا ةئیھت دعت ةرملا هذھ

 .)ةدرفم تایمست( Single labels رایخلا ددحو )تایمست( Labels ىلإ لقتنا .ط

 .id لقح ددح ،)ـب ةیمست( Label with يف .ي
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 .طئارخلا يف HH داوكلأ ةحیحصلا ةءارقلا ةیناكمإ نامضل ضیبأ يناكم مازح ةفاضإو طخلا مجح ةدایزب طمنلا نّیع .ك

 تیرجأ يتلا تارییغتلا ظفحل           قوف رقناو عقوتم وھ امك لمعی يطرشلا قیسنتلا نأ نم دكأتتل )طیطختلا ةھجاو( Layout Interface عجار .ل

 .عورشملا يف

 .قیسنتلا ىلإ ةطیرخ حاتفم فیضنس ،طمنلا ةئیھت ءاھنلإ

 .ةطیرخلا حاتفم عضول ررقملا ناكملا يفً لایطتسم مسراو  قوف رقناو AtlasJandscapc ىلإ لقتنا .أ
 .)رصنعلا صئاصخ( Item Properties ةمئاق حتفاو ةطیرخلا حاتفم ددح .ب

 .)يئاقلت ثیدحت( Auto update رایخ دیدحت ءاغلإب رداب .ج

 .ةطیرخلا حاتفم نم ھتلازلإ   قوف رقناو Google Satellite لاخدإ ددح .د

 .ةطیرخلا حاتفم لخاد رصانعلا فلتخم بیترتل           مكحت حیتافم مدختسا 

 .ناونع يھ ملعم لك ةیمست نلأ تاقبطلا مسا حسمنس ،ةلاحلا هذھ يف .نیوانعلا رییغتل رصانعلا نم رصنع لك قوف اجًودزم ارًقن رقنا .ه
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 ،)ةعومجملا( Groupو )ناونعلا( Title :ةیلاتلا تائفلا نم ةئف لكل طوطخلا نّیع .)طوطخلا( Fonts مسق حتفاو لفسلأ ةماقلا ررم .و
 .)رصنعلا( Itemو )ةیعرفلا ةعومجملا( Subgroupو

 .ةفلتخم ةدمعأ ىلع ةطیرخلا حاتفم میسقت اننكمی ،)ةدمعلأا( Columns يف .ز

 .ھصاقنإ وأ مجحلا ةدایز اننكمی ،)زمرلا( Symbol يف .ح

 .ةطیرخلا حاتفم يف رصانعلا فلتخم نیب ةدوجوملا تافاسملا يف مكحتلا نكمملا نم ،)دعابتلا( Spacing يف .ط

 ةیسأرلا/ةیقفلأا تاطیطختلا  7.3 

 يف رخلآا ضعبلاو ةیقفأ ةحفص يف لضفأ لٍكشب تاعلضملا ضعب عمج نكمی ھنأ ظحلان ،عورشملا يف اھنییعت دیرن يتلا ةفلتخملا دادعتلا قطانم ىلإ رظنلاب

 .ةیسأر ةطیرخ

 .ةیسأرو ةیقفأ طئارخ ءاشنإو نیھاجتلاا لاك نیب اًیئاقلت زییمتلل سلطلأا ةئیھت ةقیرط ىلع فرعتتس ،مسقلا اذھ يف
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 ةیقفلأا تاطیطختلا عم لضفأ لٍكشب مءلاتت تاعلضملا تناك اذإ ام ددحی )تامسلا لودج( Attribute Table يف لقح ءاشنإ يھ ةوطخ لوأ نوكتس

 .ةیسأرلاو

 .EA_ atlas_4326 ةقبطب صاخلا )تامسلا لودج( Attribute Table حتفاو )تاقبطلا( Layers ةحول ىلإ لقتنا أ
 .)لوقحلا ةبساح( Field Calculator حتفل  قوف رقنا ب
 .)دیدج لقح ءاشنإ( Create a new field رایخلا ددح .ج 
 orient :بتكا ،)جرخلا لقح مسا( Output field name لخاد .د

 نیزخت يف بغرن اننلأ ارًظن اًدج مھم اذھ .))ةلسلس( صنلا( Text (string) رایخلا ددح ،)جرخلا لقح عون( Output field type نم .ـھ

 .لقحلا اذھ يف فورحلا

 :ةیلاتلا ةغیصلا لخدأ ، )ریبعتلا( Expression راوح عبرم يف .و

 if(bounds_width($geometry)>bounds_height($geometry),'L,'P') 

 اًدیدجً لاقح دجن نأ بجی .حیحص لٍكشب ئشنأ دق دیدجلا لقحلا نأ نم دكأتتل )تامسلا لودج( Attribute Table عجارو )قفاوم( OK قوف رقنا ز

 .Pو L فرحأب ءولمم ،orient ىمسی
 .ریرحتلا ةسلج قلاغإو تلایدعتلا ظفحل   قوف رقنا .ح

 .يقفلأا هاجتلاا تاذ ةحفصلا قباطت يتلا دادعتلا قطانم حیشرتل Atlas_landscape قیسنت ةئیھتب موقنس نلآا
 .)مادختساب حیشرت( Filter with ددح مث )سلطأ( Atlas ةمئاق ىلإ لقتنا .أ

 'orient" = 'L" :يلاتلا ریبعتلا لخدأو  قوف رقنا .ب
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 .يقفلأا هاجتلاا تاذ دادعتلا قطانم رایتخا نلآا سلطلأ نكمی يلاتلابو )سلطأ تاودأ طیرش( atlas toolbar نم ققحت  .ج

 .ةطیرخلا رصانع عضوم نییعت ةداعإو ةحفصلا هاجتا رییغتو طیطختلا اذھ راركت ةیلاتلا ةوطخلا نمضتت

 .)طیطختلا راركت > طیطخت( Layout > Duplicate Layout ىلإ لقتنا ،)طیطختلا ةھجاو( Layout Interface ةیولعلا ةمئاقلا نم .أ
 Atlas_portrait مساب دیدجلا طیطختلا ددح .ب
 ...)تاحفصلا صئاصخ( Pages Properties ددحو طیطختلا ةحول قوف نمیلأا ةرأفلا رزب رقنا .ج

 .)ةیفلخلا نولو هاجتلااو مجحلا( ةحفصلا صئاصخ )رصنعلا صئاصخ( Item Properties ةمئاق رھظتس .د
 .)يسأر( Portrait رایخ ددح ،)هاجتلاا( Orientation يف .ـھ

 .)سلطأ( Atlas ةمئاق حتفا .و 
 'orient" = 'P" :ةباتكب يلاحلا ریبعتلا لدبتسا ،)مادختساب حیشرت( Filter with يف ز
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 ةحفصلا ةئیھت عم مءلاتت اھلعجل اھمجح رییغتو ةطیرخلا رصانع عیمج بحس ىوس جاتحن لا ،دیدجلا طیطختلا اذھ لامكتسلا .ح

 .ةدیدجلا

 سلطأ ملعم نأب امًلع .روصلا تافلم ىلإ طئارخلا ریدصتل ةعباتملا اننكمی ،ةزھاج ةیقفلأاو ةیسأرلا تاطیطختلا نمً لاك حبصت نأ ام 

 .اًیئاقلت طئارخلا هذھ عیمج جاتنإ انل حیتی
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 سلطأ ریدصت > سلطأ( Atlas > Export Atlas as Images ىلإ لقتنا ،ةیولعلا )طیطختلا ةھجاو( Layout Interface ةمئاق نم .أ
 .)سلطأ تاودأ طیرش( Atlas Toolbar يف دوجوملا   قوف رقنلا وھو رخآ رایخ دجوی .)روصك

 .ھیلإ طئارخلا ریدصت متیس يذلا راسملا ددح .ب

 ظفتحنس ،بیردتلا اذھ يف .روصلا ةقدب ةطبترملا تادادعلإا ةئیھت اننكمی ، )ةروصلا ریدصت تارایخ( Image Export Options ةحول يف .ج

 .)ظفح( Save قوف رقنا .ةیضارتفلاا میقلاب
 .يلامجلإا نم لعفلاب ةعوبطملا طئارخلا ددع زربتل زرحملا مدقتلا طیرش ةحول ضرعتس .د

 دادعتلا قطانم ددعل وٍاسم ةردصملا طئارخلا ددع نأ نم ققحتلا مھملا نم .دلجملا سفن ىلإ يسأرلاو يقفلأا طیطختلا نم لك نم طئارخلا ردصنس 

 .دادعتلا ةقطنم داوكأ قباطت تافلملا ءامسأ نأو تامسلا لودج يف
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 سلطأ مكحتل ةعضاخلا لوادجلا 7.4

 ةنمازم سلطأ ملعم انل حیتیو .ةطیرخلا ىلع ةضورعملا نكاسملاب ةقلعتملا تامولعملل لودج ىلع يوتحی ةطیرخل اطًیطخت مسقلا اذھ يف ئشننس

 طیطخت راركت ىلإ ةجاحب نحن ،بیردتلا اذھب مایقلل .ةطیرخلا ىلع ةضورعملا ةقطنملا عم لوادجلا كلت يف ةجردملا تامولعملا
Atlas_landscape ءاشنإو Atlas_landscape_ table قباسلا لصفلا يف ةحضوملا تاوطخلا عابتاب. 

 .لودجلل ةحاسم ریفوتل سایقملا طیرش كرّحو ةطیرخلا مجح للق .أ
 .طیطختلا لخادب لودجلل ررقملا ناكملا يفً لایطتسم مسراو      قوف رقنا .ب
 .)ةیساسلأا صئاصخلا( Main Properties ةیعرفلا ةمئاقلا ددحو )رصنعلا صئاصخ( Item Properties ةمئاق ىلإ لقتنا .ج
 . )ةقبطلا صئاصخ( Layer features رایخ ددح ،)ردصملا( Source يف .د
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 1H_atlas_4326 ددح ،)ةقبطلا( Layer نم .ـھ

  قوف رقناو )ةدمعلأا( Columns ضرع يف هدیدحتب HHid لقحلا ةلازإب مقو )تامسلا( Attributes قوف رقنا .و

 .              مكحت حیتافم مادختساو مھدیدحتب id, name, status. Selected ةقیرطلا هذھب لوقحلا زرفا مث . ز

 . قوف رقناو)يدعاصت( Ascending رایخ ددح مث ،id ددح ،)زرفلا( Sorting يف. ح
 

 .لودجلا يف تیرجأ يتلا تارییغتلا ظفحل )قفاوم( OK قوف رقنا .ط 

 ،كلذل ةفاضلإاب .ةطیرخلا يف ةضورعملا كلت قباطت طاقنلا نم ةطقن يأ دجوت لا ھنأ ظحلانس ،ةطیرخلا يف ةضورعملا طاقنلاو لودجلا ىوتحم انعجار اذإ 

 .لوادجلاو طئارخلا نمً لاك ةنمازمل ةمزلالا تاملعملا نییعت ىلإ اھدعب جاتحن .وھ امك لودجلا لظی ،اھیلت يتلا ةطیرخلا ىلإ ةطیرخ نم لاقتنلاا دنع
 .)ملاعملا حیشرت( Feature Filtering ةیعرفلا ةمئاقلا ىلإ لقتنا .ي

 .اًفص 30 ءاوتحلا فٍاك لودجلا مجح نأ نم دكأتو 30 نّیع ،)فوفصلل ددع ىصقأ( Maximum rows يف .ك
 .)سلطأ ةیصاخ عم طقف ةعطاقتملا صئاصخلا راھظإ( Show only features intersecting atlas feature رایخلا ددح .ل
 Selected" = 1" :يلاتلا ریبعتلا لخدأ ،)مادختساب حیشرت( Filter with يف .م

 طوطخلا( Fonts and Text Stylingو )ةكبشلا راھظإ( Show Gridو )رھظملا( Appearance ةیعرفلا مئاوقلا يف .ن
 .لودجلا قیسنت نیسحتل ةیرورضلا تادادعلإا ىلإ لوصولا اننكمی ،)صنلا میمصتو
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 موقن لوادجلا هذھ للاخ نمف .طئارخلا فلتخم ربع لوجتلاب انمایق ءانثأ ةریغتملا دادعتلا قطانم عم لودجلا ةنمازم متی ،تادادعلإا هذھ ذیفنت عم

 .ةینادیملا لامعلأا ذیفنت نابإ اًعفن يدجت دق )ناكسلا ددع ،ناونعلا ،مسلاا( ةیفاضإ تامولعمب دادعتلا يبودنم دیوزتب
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  ةیكبشلا جذامنلاب لمعلا 8

 )سیراضتلا تانایب(

 ةقباسلا لوصفلا يفو .ةیكبشلا تانایبلاو )تاعلضملاو طوطخلاو طاقنلا( تاھجتملا تانایب :ةیناكملا تانایبلا نم نیعون مادختساب يساسأ لٍكشب GIS مظن لمعت

 .ةیئاصحلإا تانایبلا عمج ةطشنأ ىلع لمعلل ةمءلام رثكأ ،تلااحلا بلغأ يف تناك يتلاو ،تاھجتملا تانایب عم انلماعت بیتكلا اذھ نم

 ةقطنملاب ةقلعتملا تامولعملا لثمت ةمیق ىلع ةیلخ وأ لسكب ةدحو لك يوتحتو .لسكبلا تادحو نم )ةكبش وأ( ةفوفصم نم ةیكبشلا تانایبلا ةعومجم نوكتت

 .ةیناكسلا ةفاثكلا وأ يضارلأا للاغتسا بیلاسأ وأ رادحنلاا وأ عافترلاا ،لثم ،لسكبلا اذھ اھیطغی يتلا

 اسان ةلاكول ةعباتلا Earthdata ةمدخ نم يمقرلا عافترلاا جذومن تانایب عاجرتسا 8.1

 ىلع لصفلا اذھ يف لصحنسو .تباث حطس نم عافترا تانایب ىلع لسكبلا تادحو ھیف يوتحت يكبش جذومن نع ةرابع وھ ،DEM وأ يمقرلا عافترلاا جذومن

DEM ةمدخ نم Earthdata يفاضلإا نوكملا للاخ نم اسان ةلاكول ةعباتلا SRTM Downloader. 
 .  قوف رقنلاب QGIS ـب اًدیدج اعًورشم وأ ةدیدج ةسلج حتفا .أ
 .ةیسیئرلا طئارخلا ةحول يف Raster/layers/land_4326.shp_8 لمح .ب 

 نإف يلاتلابو ،)ةقبطلل بیرقتلا( Zoom to Layer ددحو and_4326.shp قوف نمیلأا ةرأفلا رزب رقنا ،)تاقبطلا( Layers ةحول نم .ج

 .SRTM نزخم نم لیزنتلل ھجاتحن يذلا عبرملا وأ ةحوللا ةفرعم لھسیل ةیرورض ةوطخلا هذھ دعتو .ةقبطلا ىلع زكرت طئارخلا ةحول
 اذھ تیبثت مدع ةلاح يف .(SRTM لیزنت ةادأ > ةیفاضلإا تانوكملا( Plugins > SRTM Downloader ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .د

 .يفاضلإا نوكملا تیبثت ةیلمعل اًیلیصفت احًرش دری ثیح 2.2 لصفلا ىلإ عوجرلا ىجری ،يفاضلإا نوكملا
 نوكملا ةمئاق ضرَعُتسو قوف رقنا وأ (SRTM لیزنت ةادأ > ةیفاضلإا تانوكملا( Plugins > SRTM Downloader ىلإ لقتنا .ـھ

 .يفاضلإا
 نوكملا لمعیس ،ةیئاقلتلا دودحلا هذھ للاخ نمف .اًیئاقلت لمعلا ةقطنم دودح لاخدلإ )ةحوللا قاطن دیدحت( Set canvas extent قوف رقنا  .و

 .SRTM ةمدخ نم DEM جذومنب ةلصلا تاذ تاعبرملا عاجرتسا ىلع يفاضلإا
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 Load Images to رایخلا ددح مث يكبشلا جذومنلا فلم ھیف نزخیس يذلا دلجملا ددح ،)جرخلا راسم( Output-Path يف .ز
QGIS )ـل روصلا لیمحت QGIS(. 

 ةعباتلا Earthdata ةمدخ ىلإ لوصولل لوخدلا لیجست لیصافت بلطتو ةیلاتلا ةحوللا ضرعتسو )لیزنت( Download قوف رقنا .ح

 //:https :انھ نم اًعیرس باسح ءاشنإ كنكمی ،ةمدخلا هذھل باسح كیدل نكی مل اذإ .اسان ةلاكول

urs.earthdata.nasa.gov/users/new 

 .لوخدلا لیجست لیصافت كلصتس ،باسح ءاشنإ نم ءاھتنلاا درجمب

 .)قفاوم( OK قوف رقناو كب ةصاخلا مدختسملا لیصافتب )رسلا ةملك( Passwordو )مدختسملا مسا( Username لوقح لأما .ط
 .طئارخلا ةحول ىلع اًیئاقلت يكبشلا جذومنلا تافلم لیمحت متیس ،ءاھتنلاا درجمب .لیزنتلا ةیلمع مدقتلا طیرش رھظُیس
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 .قمغأ نول تاجردب ةضفخنملا تاعافترلاا رھظت امنیب ،ةیلاعلا تاعافترلاا حتفلأا نوللا تاجرد رھظُت .وكیروتروب تاعافترا ةیكبشلا جذامنلا رھظُت .ي

 ىلع يكبشلا جذومنلا ىلإ لوصولا كنكمی ،ببس يلأ كب صاخلا رتویبمكلا زاھج ىلع ةیلمعلا هذھ حلفت مل اذإ 
8_Raster/DEM/PRI_AST_DEM_comp  بیتكلا اذھ عم ةجردملا ةیبیردتلا داوملا يف. 
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 2يكبشلا جذومنلا ةیؤر نیسحت 8.2

 ةیناكملا تامولعملا هذھ لیثمت نیسحت ةیناكمإ نع كیھان .ةمات ةلوھسب ةضفخنملاو ةیلاعلا تاعافترلاا نیب زییمتلا كنكمی ،ةیلاحلا ضرعلا تادادعإ مادختساب

 عافترلاا ةقبط بكارت ىلع لمعنس ،كلذ قیقحتل .اھملاعم فصوو سیراضتلا رادحنا ریسفت هرودب لھسی ام وھو ،حطسلل داعبلأا يثلاث جذومن ءاشنإ للاخ نم

 .يكبشلا DEM جذومن سفن نم اتأشن دق نیتقبطلا لاك نأب ملعلا عم .اھلفسأ ةدوجوملا للاتلا ةقبط ىلع ةنولملا ةیجذومنلا

 للاتلا
 .          قوف رقنلاب QGIS ـب اًدیدج اعًورشم وأ ةدیدج ةسلج حتفا .أ

 Raster/DEM/PRI_AST_DEM_comp_8 لیمحتب رداب .ب

 .)ةقبطلا راركت( Duplicate Layer ددحو  PRI_AST_DEM_comp قوف نمیلأا ةرأفلا رزب رقنا ،)تاقبطلا( Layers ةحول يف .ج
 ىلإ لقتناو )لفسلأاب ةدوجوملا ةقبطلا(  PRI_AST_DEM_comp copy يف )ةقبطلا صئاصخ( Layer Properties حتفا .د

Symbology )زیمرتلا(. 
 Hillshade رایخ ددح ،ةلدسنملا )ضرعلا عون( Render type ةمئاق نمو ،ةیعرفلا )قاطنلا ضرع( Band Rendering ةمئاق ىلإ لقتنا .ـھ

 .)للاتلا(

 0.00001 لخدأ ،)Z لماعم( Z Factor يف .و

 ةددعتم ةلیسولا لمعت ،ءوضلل دحاو ردصمب نیعتست يتلا ةیدیلقتلا للاتلا جذامن فلاخب .)تاھاجتلاا ددعتم( Multidirectional رایخلا ددح.ز

 .ةقد رثكأ اجًذومن مدقت اھنإف كلذبو ةفلتخم تاھاجتا ةعبرأ نم حطسلا ةءاضإ ىلع تاھاجتلاا
 Bilinear ىلع ھطبضا ؛)لخادلا( In رایخل ةبسنلاب .)برقم( Zoomed ىلإ لقتنا ،)تانیعلا ذخأ ةداعإ( Resampling ةیعرفلا ةمئاقلا يف .ح

 ةمیقلا طبضا ،)تانیعلا ذخأ يف طارفلإا( Oversampling يفو ؛)يداع( Average ىلع ھطبضا ،)جراخلا( Out رایخل ةبسنلاب امأ ؛)يئانث(

 2.00 ىلع
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 qgis-in-visualization-dem-com/blog/2018/3/20/3dhttps://opengislab- :يھیجوتلا لیلدلا اذھ ىلإ 8.3و 8.2 نیلصفلا لاك دنتسی  2 •
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 ةدراولا ةروصلا عم يكبشلا جذومنلا قباطت نم دكأتتل طئارخلا ةحول عجارو زیمرتلا يف تارییغتلا ظفحل )قفاوم( OK قوف رقنا .ـط

 .هاندأ

 ىلإ ریشی ثیحب مسلاا رییغت ىلع صرحا .)ةقبطلا ةیمست ةداعإ( Rename Layer ددحو ةقبطلا قوف نمیلأا ةرأفلا رزب رقنا .ي 

 .)PRI_AST_DEM_comp hshade ؛لثم( للات نع ةرابع ةقبطلا هذھ نأ

 عفترم ينول جردتب ضورعملا DEM جذومن

 Symbology ىلإ لقتناو )ةیولعلا ةقبطلا(  PRI_AST_DEM_comp يف )ةقبطلا صئاصخ( Layer Properties حتفا .أ
 .)زیمرتلا(
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 رایخ ددح ،)ضرعلا عون( Render type ةلدسنملا ةمئاقلا يفو ،)قاطنلا ضرع( Band Rendering ةیعرفلا ةمئاقلا ىلإ لقتنا .ب
Singleband pseudocolor )دحاولا قاطنلل فئازلا نوللا(. 

 Create New Color رایخ ددح .ةلدسنملا ةمئاقلا حتفل نیمیلا ىلع نئاكلا مھسلا قوف رقنا ،)ينوللا جردتلا( Color ramp بناجب .ج
Ramp )دیدج ينول جردت ءاشنإ(. 

 .)قفاوم( OK قوف رقناو  Catalog: cpt-city رایخ ددح ،)ينوللا جردتلا عون( Color ramp type ةحول يف .د
 Selections by theme بیوبت ةملاع ددح ،)ينوللا Cpt-city جردت( Cpt-city Color Ramp ةحول يف .ـھ

 رقنا مث .ةحاتملا ناوللأا تاجردت دحأ ددحو )ضرلأا ملاعم فصو( Topography مسق ىلإ لقتنا مث ،)عوضوملا بسح تارایتخلاا(

 .)قفاوم( OK قوف

 .)لصفنم( Discrete ددح ،)ءارقتسا( Interpolation يفو ،)زیمرتلا( Symbology ةمئاق ىلإ دع .و 
 .طیحملا لثمیل قرزلأا نوللا بستكیل م 0 ىلع عافترلاا طبضاو )ةمیق ىصقأ/ىندأ تادادعإ( Min / Max Value Settings ىلإ لقتنا .ز
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 .)ددعتم( Multiply رایخ ددحو )جزملا عضو( Blending Mode ةمئاق ىلإ لقتنا ،)نوللا ضرع( Color rendering يف .ح
 .%80 ىلع )ماعلا ماتعلإا( Global Opacity طبضا مث ،)ةیفافشلا( Transparency ددحو راسیلا ىلع ةنئاكلا ةمئاقلا ىلإ لقتنا .ط

 عورشملا ىلع تلخدأ يتلا تارییغتلا ظفح سنت لا .طئارخلا ةحول يف هذھ ةدیدجلا زیمرتلا تادادعإ جئاتن عجارو )قفاوم( OK قوف رقنا

  قوف رقنلاب

 ةءارقو للاظلا فلتخم ىلع ءًانب عافترلاا دیدحت نلآا نكمملا نمف يلاتلابو .سیراضتلاب قلعتی امیف ةیرث تامولعم ىلع نلآا ةطیرخلا يوتحت 

 .للاتلا لضفب كلذو سیراضتلا لاكشأ
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 داعبلأا ةیثلاث طئارخلا ضورع مادختسا 8.3

 نوكمل ةفیظو تناك ةقباسلا تارادصلإا يف داعبلأا ةیثلاث تاروصتلا نأ نیح يف ،ةیلصأ داعبلأا ةیثلاث روصتلا ةادأ نوكت ،QGIS 3 جمانرب يف

 يف ةیقفلأا طوطخلاب قلعتت يتلا ةیفاضلإا تامولعملا ضرعل ةدیج ةلیسو داعبلأا ةیثلاث طئارخلا دعتو .Qgis2threejs ،يجراخ يفاضإ

 .تاطیطختلا
 .طئارخلا ةحول دادعإب موقنس ،داعبلأا يثلاث ضرعلا يف لمعلا لبق

 .)تاقبطلا( Layers ةحول يف ةیكبشلا جذامنلا ىلعأ ھعض مث  Raster/layers/roads.shy_8 لیمحتب رداب .أ

 .ةطیرخلا ىلع ةلوھسب اھیلع فرعتلا نكمی ثیحب هذھ ةیطخلا ةقبطلل دیدج زیمرت طبضب موقنس
 .)زیمرتلا( Symbology ىلإ لقتناو  roads.shp يف )ةقبطلا صئاصخ( Layer Properties ةحول حتفا .ب

 .زمرلا سفن مادختساب قرطلا عیمج ضرعنس اننأ ثیح ،)دحاو زمر( Single symbol رایخ ددح .ج

 مث .نكاد يدامر طخ ىلع تھاب يدامر طخ لخادت للاخ نم زمرلا اذھ ئشننسو .ةنكاد ةیدامر دودحب تھاب يدامر طخ نّیعنس ،قرطلا لیثمتل

 .دودحلا ریثأت ءاشنلإ نیطخلا لاكل ضرعلا تاسایق فلتخم ددحن
 .زمرلا ةحول يف ةدیدج زمر ةقبط ةفاضلإ   قوف رقنا .د
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 0.4 ىلع )ةطغضلا ضرع( Stroke width طبضاو تھابلا يدامرلا ىلع )نوللا( Color نییعتب رداب مث ،يولعلا طخلا ددح  .ـھ
 .ملم

 .ملم 0.5 ىلع)ةطغضلا ضرع( Stroke width طبضاو تھابلا يدامرلا ىلع )نوللا( Color نییعتب رداب ،يلفسلا طخلل ةبسنلاب .و
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 .داعبلأا يثلاث ضرعلا مادختساب ءدبلا اننكمی ،داعبلأا ةیئانث ةطیرخلا يف حضاو لٍكشب ةطیرخلا تاقبط عیمج لیثمت مت نأ دعبو نلآا

 ةلاسر رھظتس .)داعبلأا ةیثلاث ةدیدج ةطیرخ ضرع > ضرع( View > New 3D Map View ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .أ

 يعجرملا تایثادحلإا ماظن لثم ،ةطقسملا ریغ يعجرملا تایثادحلإا ماظن يف موعدم ریغ داعبلأا يثلاث ضرعلا نأب دیفت أطخ دوجوب

 .QGIS جمانربل ةیضارتفلاا
 نكمملا نم .CRS ةمئاق ددحو )صئاصخ > طاقسإ( Project > Properties ىلإ لقتنا ،يعجرملا تایثادحلإا ماظن رییغتل .ب

 .ةشاشلا نم ىنمیلا ةیلفسلا ةیوازلاب ةنئاكلا  ةنوقیأ قوف رقنلاب ةمئاقلا هذھ ىلإ لوصولا اضًیأ
 :EPSG لمعتس ،بیردتلا اذھل ةبسنلاب .طقسملا يعجرملا ةیثادحلإا ماظن ددح ، )يعجرملا تایثادحلإا ماظن( CRS ةمئاق يف .ج 

 .)قفاوم( OK قوف رقناو اھادحإ رتخا .3857
 3D Map ةذفان رھظتس .ىرخأ ةرم )داعبلأا ةیثلاث ةدیدج ةطیرخ ضرع > ضرع( View > New 3D Map View برّج .د

 .ةدیدج )داعبلأا ةیثلاث ةطیرخ(

 .)داعبلأا ةیثلاث ةئیھتلا( 3D Configuration ةحول حتفل قوف رقنا .ـھ

 مجح لیثمتل تانایب لخدمك DEM جذومن لمعیس .عورشملا يف DEMs جذامن نم نینثا وأ دحاو ددح ،)عافترلاا( Elevation نم .و 

 .داعبلأا يثلاث ضرعلا يف ةرھاظلا سیراضتلا
 .اًیبسن ةریغص اھضرع يف بغرن يتلا ةقطنملا نلأ ارًظن ،لسكب 50 ىلإ لصتل ةمیقلا دیزنس ،)عبرملا ةقد( Tile resolution يف .ز
 OK قوف رقناو )لضفأ ةدوجب ضرعلل( لسكب 200 ىلع ةمیقلا طبضا ،)ةطیرخلا عبرم ةقد( Map tile resolution يف .ح

 .ةیضارتفلاا میقلا ةداعتساب ىصوی ھنإف ،داعبلأا يثلاث ضرعلا میدقتلً لایوط اًتقو قرغتسی رتویبمكلا زاھج نأب تظحلا اذإ .)قفاوم(
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 :يلاتلا وحنلا ىلع داعبلأا يثلاث ضرعلاب مكحتلا رصانع يتأت .ط

 .ةطیرخلا كیرحتل رقنا -

 .ضرعلا ریودتل ةرأفلا ةلجع مادختساب رقنلا وأ رقنلا عم + Shift ىلع رارمتسلاا عم طغضا -

 .ریغصتلا/ریبكتلل ةرأفلا ةلجع ریودتب مق -

 .DEM جذومن قوف يعانصلا رمقلا ةروص بكارت عضو كنكمی ھنإف ،يعقاو يقفأ طخ ءاشنإ يف بغرت تنك اذإ 
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 ةطقنلا ةقبط ىلإ DEM جذومن نم عافترلاا تانایب نییعت 8.4

 ثراوكلاب اھرثأت ةیلباق ثیح نم HH عقاوم ضرع كلذ انل حیتیس .اھعافترلا اًقفو HH نكاسملا عقاومب ةصاخلا تایثادحلإا فّنصنس ،بیردتلا اذھ يف

 DEM جذومن نم عافترلاا تامولعم ىلع لصحنسو .)ریصاعلأاو فصاوعلا بوبھو يمانوست( رحبلا حطس ىوتسم عافتراب ةطبترملا ةلمتحملا ةیعیبطلا

 .تامسلا لودج يف دیدج لقحك ةطقنلا لكش فلم ىلإ اھفیضنو
 .طئارخلا ةحول يف  Raster/layers/HHLoc_4326.shp_8 ةقبطلا لیمحتب رداب .أ

 دكأتو )اھتیبثتو ةیفاضلإا تانوكملا ةرادإ > ةیفاضلإا تانوكملا( Plugins > Manage and Install Plugins ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .ب
 .يفاضلإا نوكملا تیبثت عبات ،كلذ ادع .)طاقنلا تانیع ذخأ ةادأ( Point Sampling tool تیبثت نم

 تانوكملا ةرادإ > تلایلحتلا > ةیفاضلإا تانوكملا( Plugins > Analyses > Manage and Install Pluginsىلإ لقتنا ،ھتیبثت درجمب .ج
 .)طاقنلا تانیع ذخأ ةادأ( Point Sampling Tool ةحول رھظتس  .يفاضلإا نوكملا حتفل   قوف رقنا وأ)اھتیبثتو ةیفاضلإا

 HHLoc_4326 ةقبطلا ددح ،)تانیعلا ذخأ طاقنل ةیواحلا ةقبطلا( Layer containing sampling points ةلدسنملا ةمئاقلا نم .د
 ددح ،)اھنم ةمیقلا ىلع لصحتملا تاقاطنلا/لوقحلا تاذ تاقبطلا( Layers with field/bands to get values from نم .ـھ

HHLoc_4326  و ةطقنلا ةقبط نم ةدراولا لوقحلاب ظافتحلالPRI_AST_DEM_comp، مدختسا( عافترلاا تانایب يوحت يتلا ةقبطلا Ctrl 

+ click تاقبط ةدع دیدحتل(. 

 .يفاضلإا نوكملا ةمئاق يف ةحاتم اھلعجل )تاقبطلا( Layers ةحول يف ةیئرم تاقبطلا نأ نم ققحتلا بجی ھنأب ملعلا عم

 ؛لاثم( اھمساو ةجتانلا ةطقنلا ةقبط عقوم ددح ،)جرخلا ةطقن تاھجتم ةقبط( Output point vector layer نم .و
HHLoc_Elev_4326.shp(. قوف رقنا مث OK )ةیلمعلا ءدبل )قفاوم. 
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 )ةقبطلا صئاصخ( Layer Properties ةحول حتفا .اًیئاقلت طئارخلا ةحول ىلع عافترلاا تانایب يوحت يتلا ةطقنلا ةقبط لیمحت متیس .ز
 .)زیمرتلا( Symbology ىلإ لقتناو

 .)جردتم( Graduated رایخ ددح ،ایلعلا ةلدسنملا ةمئاقلا نم .ح
 .عافترلاا تانایب يوحی يذلا لقحلا ددح ،)دومعلا( Column يف .ط

 ةیعرفلا ةمئاقلا يف نئاكلا ،RdYlGn انرتخا ،لاثملا يف .رثأتلا ةیلباق ضرعل بسانملا جردتلا ددح ،)ينوللا جردتلا( Color ramp نم .ي
All Color Ramps )ةینوللا تاجردتلا لك(. 
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 دودحلا نییعتب ردابو )تائفلا( Classes ددعو بسانملا فینصتلا )عضو( Mode ددح ،)فینصت( Classify قوف رقنا .ك

 .تاقاطنلا فلتخمل تاملاعلاو

 .طاقنلا ھیلع عقت يذلا عافترلاا اھددحی يتلا رثأتلا ةیلباق ةجردل اًقفو ةطیرخلا ىلع ةلثمم طاقنلا نم ةباحس ةجیتنلا نوكتس
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 ةیناكملا تانایبلا دعاوق :اھنیزختو تانایبلا ةرادإ 9
 GEOPACKAGE تانایب قیسنتب -

 
   

 
 اھترادإو تانایبلا تاعومجمو تاعورشملا فلتخم نیزخت ةقیرط ىلع لصفلا اذھ يف فرعتتس
 دمتعی امنیب ،تادلجملاو تاعورشملا مادختسا ىلع لولأا دمتعی .نیفلتخم نیجھنب ةناعتسلااب
 .ةیناكملا تانایبلا دعاوق مادختسا ىلع يناثلا

 

   

 
 

 تادلجملاو تاعورشملا مادختساب اھنیزختو تانایبلا ةرادإ 9.1
 
 

 ھجوب .ةیعرفلا تادلجملاو تادلجملا نم لكیھ يف تانایبلا نزخت اھنوكل ارًظن نیئدتبملا GIS مظن يمدختسمل ةبسنلاب لھسأ ةلیسولا هذھ دعت
 ىربكلا تاعورشملا ذیفنت دنع ةیفاك ریغ نوكت دق ةطیسبلا ةلیسولا هذھ نإف ،كلذ عمو .ةریغصلا تاعورشملا عم ةینقتلا هذھ ىشامتت ،ماع
 .)ةفلتخم ةجلاعم تایوتسمو تاقیسنتب ةعونتم رداصم نم ةریبك دادعأب ةرداصلا تانایبلا تاعومجم ؛لاثم( ةدقعملاو

 .تادلجم يف عورشملا تانایب فینصت يف اھیلع دمتعنس يتلا رییاعملا رایتخا يرورضلا نم ،تادلجملاو تاعورشملا جھن مادختسا دنع
 بسح زرفلا كنكمی ؛لاثملا لیبس ىلع .حیحص دحاو لح كانھ نوكی نأ يرورضلا نم سیلو كلذب مایقلل ةفلتخملا لبسلا نم دیدعلا كانھف
 ،نكاسملا عقاوم ؛لاثم( عوضوملا بسح وأ )ةنسلا ،مئاوقلا ،دادعتلا ؛لاثم( عورشملا بسح وأ )لوادج ،ةیكبش ،ةیھاجتا ؛لاثم( تانایبلا عاونأ
 .)قفارملا ،راھنلأا ،دودحلا

 .بیتكلا اذھ عم قفرملا ةیبیردتلا داوملا دلجم يف ھنیزخت مت ،يولاامل اًیضارتفاً لااثم دجتس
 data_management/MWIProject.qgz_9 حتفا .أ

  data_management_9 دلجم حتفا ،كتصاخ لیغشتلا ماظن يف يضارتفلاا تافلملا ریدم وأ QGIS ضرعتسم مادختساب امإ .ب
 .ةیعرفلا تادلجملاو تادلجملا فلتخم ربع تانایبلا میظنت ةیفیك عجارو
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 نزخت يتلا ةیعرفلا تادلجملا ىلع )تاقبطلا( layers دلجم يوتحی .)تاقبطلا( layers دلجم راوجب دوجوم عورشملا فلم نأب ملعلا عم
 ،عورشملا ةعیبط ،مدختسملا تلایضفت ىلع تانایبلا بیترت اھب متیس يتلا ةقیرطلا دمتعتسو .raster, shapefile :عونلا بسح تانایبلا
 .خلإ

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 تادادعإ ىلع ظافحلا اندرأ اذإ ةیاغلل ةبعص ةیلمع نیمدختسملا نیب تاعورشملا ةكراشم نم لعجی نأ نكمملا نم تادلجملا ىلع دامتعلاا نإ
 رذعتی دقو ةدقعم ةكراشملا ةیلمع حبصت دقف ،GIS جمانربب ةیارد ىلع نومدختسملا نكی مل اذإف .تایمستلاو زیمرتلا ؛لثم ،لمعلا ةحاسم
 .ةعرسب اھترادإ
 حامسلل تاعورشملاو تاقبطلا مزح ،QGIS جمانرب يف رفوتم امھلاك ،QPackageو  QConsolidate نییفاضلإا نینوكملل نكمی
 .ةیلمعلا يف تانایبلا نیزختل لكایھ يأ لیزت اھنكلو ،تادلجملاو تاعورشملا ةكراشمب

 :ةیلاتلا تاوطخلا عبتنس ،نییفاضلإا نینوكملا لاك تیبثتل

 تانوكملا ةرادإ > ةیفاضلإا تانوكملا( Plugins > Manage and Install Plugins ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .أ
 .ةحوللا نم رسیلأا بناجلا ىلع ةنئاكلا )لكلا( All ةمئاق رتخاو ...)اھتیبثتو ةیفاضلإا

 ةیبیرجتلا ةیفاضلإا تانوكملا ضرع( Show also experimental رایخلا ددح مث )تادادعلإا( Settings ىلإ لقتنا .ب
 .)اضًیأ

 نوكملا تیبثت( Install plugin قوف رقناو  Qpackage يفاضلإا نوكملا ددح  .Qpackage بتكا ،ثحبلا طیرش يف .ج
 .)يفاضلإا

 Install plugin قوف رقناو QConsolidate3 يفاضلإا نوكملا ددح ،Qconsolidate3 بتكا ،ثحبلا طیرش يف .د
 .)يفاضلإا نوكملا تیبثت(
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 مدختسنس اننأ لاإ .بسحف امھدحأ مادختسا ةقیرط ملعت يرورضلا نمف ،ةقیرطلا سفنب نلامعی نایفاضلإا نانوكملا لاك نأ امب

QConsolidate3، ةئیب يف اًتابث رثكأ ھنوكل ارًظن QGIS 3. 

 يعانصلا رمقلا ةروص ةفاضإ مت دق ھنأو ةنیعم تایمستو تازیمرت مادختساب تاقبطلا لك ةئیھت ظحلاتس .CookProject.qgz حتفا .أ
 .ةیفلخك

 . qgs دادتما مادختساب عورشملا ظفح انیلع بجی ،دعب ھلح متی مل أطخ دوجو ببسب
   قوف رقنا وأ )مساب ظفح > عورشم( Project > Save as ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .ب
 رایخلا ددح ،)مساب ظفحلا عون( Save as type ةلدسنملا ةمئاقلا يف ،)مساب عورشملا ظفح( Save Project As ةحول نم .ج

QGIS files )تافلم QGIS) (*.qgs ). 

 .اھكراشتو تاقبطلاو عورشملا مزحل يفاضلإا نوكملا مادختسا يف أدبنس ،qgs. دادتماب عورشملا ظفح درجمب
 .QConsolidate3 > )ةیفاضلإا تانوكملا( Plugins ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .د

 .ةرورضلا ةلاح يف ھكراشت ىنستی ىتح عورشملا مسا رییغت اننكمی ،)عورشملا مسا( Project name يف .ـھ

 .ةمزحلل دیدجلا عقوملا نّیع ،)جرخلا لیلد( Output directory يف .و

 تاقبطلا عیمج لیوحتل رایخ كانھ نأب ظحلاتس  .SHP رایخ ددح ،)جرخلا لیلد( Output directory هاندأ ةلدسنملا ةمئاقلا نم .ز
 .يلاتلا مسقلا يف قیسنتلا اذھ فاشكتسا ىلع لمعنس ثیح ،GeoPackage قیسنت ىلإ

 يفو .طوغضم فلم يف تاقبطلاو عورشملا نیزختب )طوغضم فلم يف دیحوتلا( Consolidate in a Zip file رایخ حمسی .ح
 .هراتخن نل ةلاحلا هذھ

 .)قفاوم( OK قوف رقنا .ط
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 نیزخت متیس ثیح )تاقبطلا( Layers مساب اًدلجم ئشنیسو ددحم عقوم يف عورشملا نیزختب يفاضلإا نوكملا موقیس .ي

 نوكملا للاخ نم ھنییعت متیس طسبأ لكیھب ھلادبتسا متیس لبق نم مدختسی ناك تانایبلل لكیھ يأ نأب ينعی اذھو .عورشملا تاقبط عیمج

 .يفاضلإا
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 .QConsolidate3 تافلاتخلاا ضعب امھنیب دجوت نكلو ،ةقیرطلا سفنب QPackage لمعت

 .ةیلمعلا يف اھمزح متیس يتلا تاقبطلا دیدحت نكمملا نم ،QPackage يف •

 .ھمزح مت يذلا عورشملل فدھتسملا CRS دیدحت نكمملا نم ،QPackage يف •

 .فلملا سفن يف عورشملا فلمو تاقبطلا نمً لاك  QPackage ظفحی •

 يف بیتكلا اذھ ریرحت ءانثأ ھلح متی مل أطخلا اذھ( ةیكبشلا جذامنلا مزح دنع  QPackage ھجاوت يتلا لكاشملا ضعب دجوت •
02/2020(. 

 نوكن نأ بجی .دیدجلا عقوملا يف عورشملل ةیلاحلا ةسلجلا ظفحب موقی ھنإف ،عورشملاو تاقبطلا مزحب  QPackage موقی امدنع •

 .ھیف لمعلا يف رارمتسلاا يف انتبغر لاح يف ىرخأ ةرم يلصلأا عورشملا حتفنو نیرذح
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 )GeoPackage( ةیناكملا تانایبلا دعاوق مادختساب اھنیزختو تانایبلا ةرادإ 9.2

 يمدختسم نكمتی ثیحب رارقلا اذھ انذختا دقو .بیتكلا اذھ يف تاھجتملا تاقبطل ESRI shapefile (.shp) مدختسن نأ ماع ھجوب انرتخا دقل
 تائیب يف اعًویش تاقیسنتلا رثكأ يھ shapefile فلم نأ امب .ھمادختسا نم طسوتملا ىوتسملا يوذ نیمدختسملاو نیئدتبملا GIS جمانرب

ESRI وQGIS، لعفلاب اھب ةیارد ىلع نویساسلأا نومدختسملا نوكی نأ حجرملا نمف. 

 عتمتت يتلا ىرخلأا لئادبلا مدقنس ،لصفلا اذھ يف .تاھجتملا تاقبط عم لماعتلا دنع معاد لضفأ shp. قیسنت نم لعجی لا اذھ نإف ،كلذ عمو
 .shapefile قیسنتب ةنراقم ةریبك ایازمب

 GeoPackage قیسنت 9.2.1

"GeoPackage 3".ةیناكملا ةیفارغجلا تامولعملا لقنل طوغضمو فصولا يتاذو لومحمو ةلقتسم ةصنمب رییاعملا ىلع مئاق حوتفم قیسنت وھ 

 ةیواح لاإ وھ ام حوتفملا GeoPackage قیسنت نإ" :QGIS قئاثو يف GeoPackage قیسنتل ةلوھس رثكأ فیرعت ىلع روثعلا نكمی
 4."دحاو فلم يف )تاقبطلا( GIS تانایب نیزخت كل حیتت

 :يلی ام يھ ،تلااحلا ضعب يف ةیكبشلا تانایبلاو ،ةیھاجتلاا تانایبلا ةرادإ دنع قیسنتلا اذھ مادختسا ءارو نم ةیسیئرلا ایازملاف
 .حوتفم ردصم ھنأ

 .يلاثم لٍكشب ىرخلأا تاقیسنتلاو shapefile معدی لازی لا ناك ول ىتح GeoPackage عم اًیضارتفا لمعلل QGIS لیوحت مت

 فلم يف CRS مادختساب )تاعلضم ،طوطخ ،طاقن( ةفلتخم ةیسدنھ لاكشأب تاقبط ةدع نیزخت GeoPackage ناكمإب
 .)3.1 لصفلا رظنا( ةدحاو ةقبط نیزختل لقلأا ىلع تافلم ةثلاث ءاشنإ يرورضلا نم ،shapefiles تافلمب لمعلا دنع .دحاو

 .)ESRI، Python، QGIS، R، GDAL ؛لثم( ىرخلأا ةجمربلا تاغلو GIS جمارب مزح عم قفاوتم GeoPackage نإ

 .shapefile يف امك ھسفن وھ )... زیمرت ،تامسلا لودج ،دیدحت ،ریرحت( GeoPackage لمع ریس
  

 
 /https://www.geopackage.org :يمسرلا GeoPackage عقوم 3
 :QGIS 3.4 قئاثو 4

https://docs.qgis.org/3.4/en/docs/training_manual/basic_map/vector_data.html?highlight=geo
package 
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 يف اھطامنأو ةیكبشلا جذامنلاو )تاعلضمو طوطخو طاقن( shapefiles تافلم نم دیدعلا عیمجتل لمعلا ریس ةیلمع عبتنس ،يلاتلا بیردتلا يف
 .دحاو GeoPackage فلم

 data_management/MWIGeopackage.qgz_9 حتفا .أ

 قبسم زیمرت اھل ةقبط لك .دحاو يكبش جذومن ىلإ ةفاضلإاب shapefile قیسنتب تاھجتملا تاقبط نم تاقبط ينامث دجتس ،عورشملا اذھ يف

 Layers ةحول يف ةعومجم يف اًعم كلت shapefiles تافلم عیمجتب موقنس .عورشملا فلم يف ھنیزخت مت لعفلاب ةئیھتلا
 .GeoPackage يف اًقحلا اھنیزختو اھئاشنإب موقنس يتلا كلتو اًقبسم ةدوجوملا shapefile تاقبط نیب ام ةقرفتلل كلذب موقن نحنف .)تاقبطلا(

 بحساو Shapefile اھمسو .ةدیدج تاقبط ةعومجم ءاشنلإ   قوف رقنا ،)تاقبطلا( Layers ةحول نم يولعلا ءزجلا يف .ب

 .ةعومجملا لخاد ةدوجوملا تاقبطلا عیمج

 :كلذب مایقلل قرط ثلاث دجوت .GeoPackage فلم ئشننس ،كلذ دعب

 > ةقبط ءاشنإ > ةقبط( Layer > Create Layer > New GeoPackage Layer ىلإ لقتنا ،ةیولعلا ةمئاقلا يف .1
 ...)ةدیدج GeoPackage ةقبط

 ةدعاق ءاشنإ( Create Database ددحو  قوف نمیلأا ةرأفلا رزب رقنا ،)ضرعتسملا( Browser ةحول يف .2
 .)تانایب

 .  قوف رقنا ،ةھجاولا نم رسیلأا بناجلا يف نئاكلا ةیبناجلا ةمئاقلا طیرش يف .3

 .)ةدیدج GeoPackage ةقبط( New GeoPackage Layer ةمئاق سفن رھظتس ،اًعیمج ثلاثلا تلااحلل ةبسنلاب 

 ؛لاثم( اھمساو ةدیدجلا تانایبلا ةدعاق عقوم رتخا ،)تانایبلا ةدعاق( Database يف .ج
9_data_management/database/MWI.gpkg.( 

 .يلاحلا صنلا كرتا ،)لودجلا مسا( Table name يف .د
 .)يسدنھ لكش نودب( No Geometry رایخ ددح ،)يسدنھلا لكشلا عون( Geometry Type نم .ـھ

 اذھ ةلازإب موقنسو .ةرم لولأ هءاشنإ دنع لقلأا ىلع دحاو رصنع نیزخت بلطتی GeoPackage فلم نلأ لودجلا اذھ ءاشنإ انیلع بجی
 .تانایبلا ةدعاق نم اًقحلا رصنعلا

 New ددح                          قوف نمیلأا ةرأفلا رزب رقنا ،)ضرعتسملا( Browser ةحول يف .)قفاوم( Ok قوف رقنا .و
Connection )حتفاو )دیدج لاصتا MWI.gpkg ھعقوم نم. 

 ىصوی ،لیدعت يأ ءارجإ دعب . لفسأ MWI.gpkg رھظتس ، )ضرعتسملا( Browser ةحول يف .ز
 .تادلجملا ثیدحتل  قوف رقنلاب

 مایقلل ناتیسیئر ناتقیرط كانھو .اھلخادب يكبشلا جذومنلاو تاھجتملا تاقبط عیمج مزحب موقنس ،GeoPackage فلم انأشنأ نأ دعب نلآا 
 :كلذب
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 ضرعتسملا ةحول .1

 ةحول يف نئاكلا  MWI. gpkg دلجم ىلإ )تاقبطلا( Layers ةحول نم  MWI_HealthFacilities_4326 بحسا .ح
Browser )ضرعتسملا(. 

 فلمل ةیرجشلا ةینبلا يف  MWI_ HealthFacilities_4326 ةقبطلا رھظتسو ةیلاتلا ةحوللا ضرعُتس .ط

GeoPackage. 
 

 
 
 
 
 
 
 
 
 

2. DB Manager 

 تاقیسنت جمدل ةیسیئرلا ةادلأا نوكی نأ ىلإ فدھیو QGIS core جمانرب يف ةیساسلأا ةیفاضلإا تانوكملا نم اًدحاو  DB Manager دعی
 QGIS (PostGIS، SpatiaLite، GeoPackage، Oracle Spatial، Virtual ةطساوب ةموعدملا ةیناكملا تانایبلا ةدعاق

layers) ةدحاو مدختسم ةھجاو يف. 

 .)تانایبلا ةدعاق ریدم > تانایبلا ةدعاق( Database > DB Manager ىلإ لقتنا ،ةیولعلا ةمئاقلا نم .أ
 قوف رقنا ،)تامدخلا ومدقم( Providers ةذفان يف ،)تانایبلا ةدعاق ریدم( DB Manager ةمئاق نم .ب

 مث                         ىلع نمیلأا ةرأفلا رزب رقنا ،احًاتمMWI.gpkg نكی مل اذإ .ةحاتملا تلااصتلاا ضرعل 
 .ھعقوم نم GeoPackage فلم حتفاو )دیدج لاصتا( New Connection  ددح

  .تانایبلا ةدعاق يف لعفلاب ةجردملا رصانعلا ضرعل  MWI.gpkg قوف اجًودزم ارًقن رقنا .ج

 ةقبط داریتسا( Import vector layer ةحول رھظتسو ،)فلملا/ةقبطلا داریتسا( Import Layer/File قوف رقنا .د
 .)تاھجتملا

 MWI_Roads_4326 ددح ،)لخدلا( Input نم .ـھ
 MWI_Roads_4326 ،ةلاحلا هذھ يف ؛)لخدلا( Input يف امك ةقبطلا سفن نم لودجلا ددح ،)لودجلا( table نم .و
 .)قفاوم( OK قوف رقناو )يساسلأا حاتفملا( Primary key رایخ مامأ ةملاع عض .ز
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 وھو رابتعلااب ھعضو بجی دحاو رمأ كانھ نكل .امھیلع فرعتتل نیتلیسولا لاك ىلع نرّمتو  MWI.gpkg ىلإ تاھجتملا تاقبط يقاب فضأ

 اذل .يلاحلا تقولا يف ةیكبشلا تاقبطلا معدی لا يفاضلإا نوكملا اذھ نلأ كلذو ،DB Manager مادختساب ةیكبشلا جذامنلا ةفاضإ نكمی لا ھنأ

 .هاندأ ةنیبملا ةروصلا يف امك GeoPackage فلمل ةیرجشلا ةینبلا ةلكیھ بجی ،ءاھتنلاا درجمب .بحسلا ةلیسو مادختسا ىلإ جاتحتس
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 لودج ىلع نمیلأا ةرأفلا رزب رقنا ، )ضرعتسملا( Browser ةحول يف .لبق نم هؤاشنإ مت يذلا M غرافلا لودجلا فذح اننكمی نلآا .ح
M ددحو Delete Layer 'M'  )ةقبطلا فذح "M"(. 

 .طئارخلا ةحول ىلإ مھفیضنس ،GeoPackage يف تاقبطلا انمزح دقو نلآا

 لك قوف اجًودزم ارًقن رقنت نأ امإو  MWI. Gpkg ددح ، GeoPackage عرف يف ، )ضرعتسملا( Browser ةحول نم .أ
 اھئاشنإ مت يتلا تاقبطلا ةعومجم جراخ اھئاقب نم دكأت Geopackage نم تاقبطلا ةفاضإ دنع .طئارخلا ةحول ىلإ مھبحست وأ ةقبط
 .مسقلا اذھ ةیادب يف

 ،زیمرتلا سفنب تاقبطلا ضرع نمضی اذھف .GeoPackage فلم يف لودجك اھنیزختب موقنو shapefiles نم طامنلأا خسننس يلی امیف
 .رخآ QGIS عورشم يف ةحوتفم تناك نإو ىتح

 Styles > Copyددحو (shapefile ةعومجم لخادب ةدوجوملا(  MWI_HealthFacilities_4326 ةقبطلا قوف رقنا .ب
Style > All Style Categories )طامنلأا تائف لك > طمنلا خسن > طامنلأا(. 

 Styles > Paste ددحو GeoPackage فلم نم  dWI_HealthFacilities_4326 ةقبطلا ىلع نمیلأا ةرأفلا رزب رقنا .ج
Style > All Style Categories )ةدیدجلا ةیمستلاو زیمرتلا تادادعإ فاضتسو .)طامنلأا تائف لك > طمنلا قصل > طامنلأ 

 .ةقبطلا ىلإ
 )طمنلا( Style رز قوف رقنا ، )زیمرتلا( Symbology ةمئاق نم .)ةقبطلا صئاصخ( Layer Properties ةحول ىلإ لقتنا .د

 . )ةقبطلا طمن ظفح( Save Layer Style ةحول رھظتسو )طمنلا ظفح( Save Style رایخ ددح ،)ىرسیلا ةیلفسلا ةیوازلا(
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 . In database (GeoPackage) رایخ ددح ،)طمنلا ظفح( Save style ةلدسنملا ةمئاقلا نم .ـھ

 رقناو ،اًیرورض كلذ تدجو نإ ،اًفصو فضأو ،)HealthFacilities ؛لاثم( طمنلل امًسا نّیع ،)طمنلا مسا( Style name نم .و
 .)قفاوم( OK قوف

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ةدعاق يف طامنلأا ظفحب مق مث GeoPackage تائفِاكم ىلع shapefile فلمل تاھجتملا تاقبط نم طامنلأا خسنل تاوطخلا سفن عبتا
 .)لصفلا ةیاھن يف ببسلا حضونس( يكبشلا جذومنلا ادع تاقبطلا نم ةقبط لكل كلذب مایقلا كنكمی .تانایبلا

ً لاودج دجتس ثیح .  MWI.gpkg تانایب ةدعاق رشناو GeoPackage ددحو )تانایبلا ةدعاق ریدم( DB Manager حتفا .ز
 تایوتحم ةعجارم كنكمی .تانایبلا ةدعاق يف ةدوجوملا تاھجتملا تاقبطل طامنلأا ىلع نلآا يوتحی  layer_styles مساب اًدیدج
 .ةمئاقلا نم نمیلأا بناجلا يف )لودجلا( Table بیوبت ةملاع قوف رقنلاو اھدیدحتب لودجلا
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 تاقبطلا ضرع متیس نلآا .  MWI.gpkg تانایب ةدعاق يف ةدوجوملا تاقبطلا لیمحت لواحو QGIS نم ةدیدج ةسلج حتفا .ح
 .GeoPackage تانایب ةدعاق يف ةنزخملا زیمرتلا تادادعإ عم

 اھعبتنس يتلا ةقیرطلا نأب ينعی اذھو .اھطامنأ نیزخت ھنكمی لا ھنأ لاإ ةیكبشلا جذامنلا نیزخت GeoPackage ناكمإب ھنأ نم مغرلاب
 نكمی يذلا qml. وأ sld. فلم عم ھظفحن وأ عورشملا عم طمنلا نزخن نأ امإ :لبق نم ةعبتملا ةقیرطلا سفن يھ طامنلأا ةرادلإ
 .ةیكبشلا ةقبطلا حتف درجمب ھلیمحت

 ةئیب يف لمعلا ریس نوكی ،GeoPackage تانایب ةدعاق يف ةنزخملا تاھجتملا تاقبط مادختسا دنع ،لصفلا ةیادب يف ركُذ امك
QGIS مدختسن انك ول امك ھسفن وھ shapefiles. مادختسلا ةدیدج تایلمع وأ تاراھم ملعتل ةرورض دجوی لاو GeoPackage 

 .تامولعملل قیسنتلا نیزخت ةقیرطب ةقلعتملا تایساسلأا نع رظنلا ضغب
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 )METADATA( ةیفصولا تانایبلا 10

 
 )قفاوتلاو رییاعملا( ةیفصولا تانایبلا ةئبعت 10.1

 تاصخلملاو فصولاو فلؤملا ؛لثم تانایبلا تاعومجمب ةقلعتملا ةمھملا تامولعملا ةیفصولا تانایبلا لجست .تانایبلا نع تامولعم يھ ةیفصولا تانایبلا
 .خلإ ،ثیدحتلا/ءاشنلإا خیراوتو تاثیدحتلاو ةیسیئرلا تاملكلاو

 QGIS جمانرب يف ةیفصولا تانایبلا ررحم نكی مل ،)7/2019( ةباتكلا تقو يف .QGIS 2.xـب ةنراقم فلتخم لٍكشب ةیفصولا تانایبلا QGIS 3.x مدختست
 .رییاعملا كلتل ةلثامم ةقیرطب لمعی ھلكیھ نإف ،كلذ عمو ،ISO 19139 وأ ISO 19115 رایعم نم اًیأ معدی

 ةیفصولا تانایبلا لمكتسنسو .سرادملا عقاوم ھلخادب مضی يذلا  schools- unicef-2004 ةقبطل ةیفصولا تانایبلا فلم ةئبعتب موقتس ،لاثملا اذھ يف
 ىلإ ھتفاضإ بجی فلم دجتس ./https://data.humdata.org نم تانایبلا ةعومجم صلاختسا مت .اھیكلام وأ هذھ تانایبلا ةعومجم يررحم انك ول امك
 .ةقبطلل ةیفصولا تانایبلا ىلع اھتفاضإ نكمی تامولعم يوحت يتلا ةقبطلا بناج ىلإ  txt.ةیفصولا تانایبلا

 )تاقبطلا صئاصخ( Layers Properties ةحول حتفاو ،metadata/layers/schools-unicef-2004.shp_10 لمّح .أ
 .)ةیفصولا تانایبلا( Metadata ىلإ لقتناو

 .ةقبطلل ةیفصولا تانایبلل اصًخلم ئشنتسو تانایبلا لاخدإ ةیلمع میظنت ىلع ةیفصولا تانایبلا ةمئاق دعاست

 .)ةصلاخلا ،ةغللا ،عونلا ،ناونعلا ،فرّعملا ،يسیئرلا فرّعملا ؛لاثم( تانایبلا ةعومجمل ةیساسلأا ةمسلا فصی )فیرعتلا( Identification .ب
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 رقناو(ISO تائف( ISO categories ةحول نم ةئفلا ددح .ISO تائف ةیفصولا تانایبلا ررحم نمضتی .)تائفلا( Categories .ج

 قوف رقنلاب ةصصخم تائف ةفاضإ كنكمی.)ةراتخملا تائفلا( Chosen categories ةحول ىلإ اھتفاضلإ   قوف

 . 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ،بیردتلا اذھ يف .ةیسایقلا تادرفملاو میھافملا تانایبلا عاجرتسا تایلمع عابتا يف ةدعاسملل )ةیسیئرلا تاملكلا( Keywords  مدختست .د
 .ةلصلا تاذ ةیسیئرلا تاملكلاو رخآ موھفم ةفاضإ عم ينورتكللإا GEMET عقوم ربع تاحلطصملا نم انققحت
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 طبارلا يف .دویقلا نم اھریغو موسرلاو قوقحلاو صیخارتلاب ةلصتملا تامولعملا عیمج جردنس )لوصولا ةیناكمإ( Access مسق يف .ـھ
 :لضفأ لٍكشب مسقلا اذھ لامكتسا ةقیرط مھفل تاداشرإو تامولعم داجیإ نكمی ،يلاتلا

https://theodi.org/article/publishers-guide-to-open-data-licensing/ 

 Set CRS from رقنا .ةینمزو )عافترلاا ،ةطیرخلا قاطن ،CRS( ةیناكم تامولعم ىلع )قاطنلا( Extent بیوبت ةملاع لمتشت .و
layer )نییعت CRS اًیودی ھتباتك امإ كنكمی ،قاطنلل .اًقبسم اھنیوكت مت يتلا ةقبطلا صئاصخل اًقفو تامولعملا نییعت متیسو )ةقبط نم 

 Calculate from Layer وأ )ةقبطلل يلاحلا قاطنلا( Current Layer Extent :ةحاتملا تارایخ ةثلاثلا دحأ مادختساب وأ
 .)طئارخلا ةحول قاطن( Map Canvas Extent وأ )ةقبطلا نم باستحا(

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ةعومجم نع ةلوؤسملا ةلصلا تاذ تاسسؤملا وأ صاخشلأا نم مھریغو نیكلاملا نیمضت كیلع بجی )لاصتلاا ةھج( Contact يف .ز
 .تانایبلا
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 وأ تاجولاتكلا وأ تانایبلا دعاوق ؛لثم ةلصلا تاذ تامولعملاو ةیفاضلإا دراوملا جاردإ كنكمی )طباورلا( Links بیوبت ةملاع نمض .ح
 .تنرتنلإا ربع ةحاتملا قئاثولا

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 .اھتارادصإو اھتلایدعتو تانایبلا ةعومجم تاحیحصت )تاظوفحملا( History مسق قثوی .ط
 
 
 
 
 
 
 
 
 
 
 
 
 



 METADATA ةیفصولا تانایبلا | QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر
 

162 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 دحلا .ةیفصولا تانایبلا رییاعم ةیبلتل ةمزلالا تامولعملا نم ىندلأا دحلا انلخدأ دق اننأ نم دكأتلا ىلع )ققحتلا( Validation لمعی .ي
 .قاطنلاو CRSو صیخرتلاو لاصتلاا تاھجو طباورلاو ةصلاخلاو ناونعلاو عونلاو ةغللاو فرّعملا ؛وھ تابلطتملا نم ىندلأا

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 تانایبلا( Metadata مسق ىلإ ةفاضملا تامولعملا عیمج نأ دجتسو )تامولعملا( Information بیوبت ةحول ىلإ لقتنا .ك
 .اًیودی اھنیمضت مت دق )ةیفصولا
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 يف ةقبطلا هذھ حتف دنع ھیلإ لوصولا متی نل ھنأ ينعی اذھ نإف ،كلذ عمو .يضارتفا لٍكشب عورشملا فلم بناجب ةیفصولا تانایبلا نیزخت متیس
 :ةیلاتلا تاوطخلا عبتنس ،كلذ لحل .فلتخم عورشم

 رتخاو ىرسیلا ةیلفسلا ةیوازلا يف ةنئاكلا )ةیفصولا تانایبلا( Metadata قوف رقنا ،)ةیفصولا تانایبلا( Metadata يف .ل
Save Metadata )ةیفصولا تانایبلا ظفح(. 

 نم .اًیئاقلت  qmd. دادتملاا نییعت متیس .)schools-unicef-2004.qmd( ةقبطلا ناونع سفن فلملا حنما .م
 كلذ حیتی .).خلإ ,shp, .shx, .dbf.( ىرخلأا ةقبطلا تافلم بناج ىلإ روكذملا  qmd. فلم ظفح يرورضلا
 وأ تامسلا لودج يوحت يتلا ىرخلأا تادادتملاا عم اھمدختسی يتلا ةقیرطلا سفنب اًیئاقلت ةقبطلل ةیفصولا تانایبلا دادرتسا جمانربلل
 .لاثملا لیبس ىلع ،طاقسلإا تامولعم

 نوكیس ،رخآ مساب وأ لصفنم لٍكشب ةیفصولا تانایبلا نیزخت وأ )GeoPackage، KML( فلتخم ةقبط قیسنت يأ مادختساب انمایق ةلاح يف
 .ةقبطلا ىلإ اًیودی ةیفصولا تانایبلا ةفاضإ انناكمإب لازی لا

 رتخاو ىرسیلا ةیلفسلا ةیوازلا يف ةنئاكلا )ةیفصولا تانایبلا( Metadata قوف رقنا ،)ةیفصولا تانایبلا( Metadata نم .ن
Load Metadata )فلم ددح .)ةیفصولا تانایبلا لیمحت .qmd  قوف رقناو ةقبطلل ةیفصولا تانایبلا يوحی يذلا OK 

 .)تامولعملا( Information مسق يف ةیفصولا تانایبلا ضرعُتس .)قفاوم(
 



 لیلحت( دادعتلا قطانم :تاعلضملا تاقبط | QGIS جمانرب مادختساب ةیئاصقتسلاا تاساردلاو تادادعتلا يف ةیمقرلا طئارخلا مسر
 )يساسلأا تاھجتملا
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